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In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions before performing 
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The data saved in the hard disk of the machine may be lost if there is any problem in the hard disk. Fuji Xerox is not responsible 
for any direct and indirect damages arising from or caused by such data loss.

Fuji Xerox is not responsible for any breakdown of machines due to infection of computer virus or computer hacking.

IMPORTANT: 

1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied or modified in 
whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized operation can 
cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized operation of the equipment.

An export of this product is strictly controlled in accordance with Laws concerning Foreign Exchange and Foreign Trade of 
Japan and/or the export control regulations of the United States.
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Preface

Thank you for purchasing the DocuPrint M355 df.

This guide is intended for users who use the printer for the first time, and provides all the necessary operating 
information about the print, copy, scan, and fax functions.

Please read this guide to achieve the best performance from this printer.

This guide assumes you are familiar with computers and the basics of network operation and configuration.

After reading this guide, keep it safe and handy for future reference.

WARNING: 

This equipment will be inoperable when mains power fails.
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Types of Manuals

Manuals included with the printer

The following manuals are provided with the DocuPrint M355 df.

Manuals included with an optional accessory

The following manual is provided with the optional accessories (sold separately).

Lifting Your Printer Describes how to lift and hold your printer.

Safety Guide Describes the information you need to know before using the printer and to operate the 
printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer.

Operator Panel Guide Describes the icons assigned to the buttons or indicators on the operator panel.

User Guide (this guide) Describes how to get ready to print and set various features. It also covers the operator 
panel menus, troubleshooting tips, and maintenance information.

This guide is on the Driver CD Kit.

Quick Reference Guide Describes how to operate the printer and the precautions that must be followed during 
operation.

This guide is on the Driver CD Kit.

PostScript User Guide Describes how to set up your printer as a PostScript® printer and the features that can 
be configured on your print driver.

This guide is on the PostScript Driver Library CD.

Installation Guide Optional accessories that require an installation at the customer's site are provided 
with an Installation Guide.
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Using This Guide

This section includes:

� "Organization" on page 14

� "Conventions" on page 14

 Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

 Conventions

1 In this guide, personal computers and workstations are collectively called “computers”.

2 The following terms are used throughout this guide:

IMPORTANT: 

� Important information that must be read and followed.

NOTE: 

� Additional information that merits emphasis.

See also: 

� References within this guide.

3 Orientation of documents or paper is described in this guide as follows:

, , Long Edge Feed (LEF): Loading the document or paper in landscape orientation.

, , Short Edge Feed (SEF): Loading the document or paper in portrait orientation.

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the Power Saver mode, 
and the preparation of the printer to use.

3 Printer Management Software Describes the software available for the printer.

4 Printer Connection and Software 
Installation

Describes the basic information about how to connect the printer to your 
computer via the network or USB and how to install the print driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print data 
using various print features.

6 Copying Describes how to copy documents and the adjustment features.

7 Scanning Describes how to install a scan driver, and how to set and use the Scan 
features.

8 Faxing Describes how to set and use the Fax features.

9 Using the Operator Panel Menus and 
Keypad

Describes the setting items available on the operator panel, their setup 
procedures, and how to use the number pad.

10Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

11 Maintenance Describes how to clean the printer, how to replace consumables, and how 
to see the printer status.

12Contacting Fuji Xerox Describes support information.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
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Safety Notes

Before using this product, read “Safety Notes” carefully for safety use.

This product and recommended supplies have been tested and found to comply with strict safety requirements 
including safety agency approvals and compliance with environmental standards. Follow the following instructions 
for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:

� Any unauthorized alteration including an addition of new functions or connection to external devices may 

not be covered by the product warranty. Contact your local Fuji Xerox representative for more 

information.

Used for item that if not followed strictly, can lead death or severe or fatal 
injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal injuries.

Used for items that if not followed strictly, can cause injuries to user or 
damages to machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid any 
dangerous acts.

: A symbol for items that must be performed. Follow instructions carefully 
to carry out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Static 
Sensitive

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
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 Electrical Safety

 WARNING

This product shall be operated by the power source as indicated on the product's data plate. Consult your local 
power company to check if your power source meets the requirements.

 CAUTION

WARNING:

� Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an earthed 
electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an electrician to 
replace the outlet to avoid risk of electric shock. Never use an earthed adapter plug to connect the 
product to the electrical outlet that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult your 
local Fuji Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated ampere 
and voltage of this product. See the data plate on the rear panel of this product for its rated ampere 
and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not put an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring about 
minute electric current in a connector. It may generate heat and eventually cause a fire accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and eventually 
cause electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk of 
electric shock and a fire accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior may 
cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live connector 
may deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.
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Switch off and unplug the product when it (i.e., fax function) is not used over weekends or long 
holidays. Please note that it cannot receive fax message during switch-off.

Once a month, switch off this product and check if

� the power cord is plugged firmly into an electrical outlet;

� the plug is not excessively heated, rusted or bent;

� the plug and electrical outlet are free of dust; and

� the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your 
local Fuji Xerox representative.
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 Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. Friction or 
excessive pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:

� Near radiators or any other heat sources

� Near volatile flammable materials such as curtains

� In the hot, humid, dusty or poorly ventilated environment

� In the place receiving direct sunlight

� Near cookers or humidifiers

Never put this product close to fire such as candles and cigarettes. Otherwise, it may cause a fire 
accident.

This product weighs 18.1 Kg (the main unit with consumables). When moving it, always carry it by a 
team of two or more persons to avoid mishandling or injury.

When lifting this product, use the handholds on both sides of the product with two people. Never lift 
it by gripping any other areas. It will prevent you from dropping the product and getting back ache or 
injuries.

Locate this product on a level and sturdy surface that can withstand a weight of 20.7 Kg. Otherwise, 
if tilted, the product may fall over and cause injuries.
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Others

Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the product.

Keep the minimum clearance as follows for ventilation and an access to the power plug. Unplug the 
product if an abnormal condition is noted.

Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause 
injuries.

To bundle wires and cables, always use the cable ties and spiral tubes that Fuji Xerox supplies. 
Otherwise, it may cause some defects.

To keep this product in a good performance and condition, always use it in the following 
environment: 

� Temperature: 10 - 32 °C

� Humidity: 10 - 85%

When the product is left in a chilly room and the room is rapidly warmed up by heater, dew 
condensation may form inside the product and cause a partial deletion on printing.

930 mm

903 mm

400 mm

400 mm

100 mm

600 mm 426 mm 400 mm

600 mm 426 mm 400 mm

430 mm

110 mm

110 mm

503 mm

Right Left Right Left

Front Back Front Back

10° 10°

10° 10°
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 Operational Safety

 WARNING

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in the 
documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To prevent 
electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product promptly in 
the following conditions, then contact your local Fuji Xerox representative.

� The product emits smoke or its surface is unusually hot.

� The product emits unusual noise or odor.

� The power cord is cracked or worn down.

� A circuit breaker, fuse or any other safety device becomes activated.

� Any liquid is spilled into the product.

� The product is soaked in water.

� Any part of the product is damaged.

Do not insert any object into slots or openings of this product. 
Do not put any of the followings on the product:

� Liquid container such as flower vases or coffee cups

� Metal parts such as staples or clips

� Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or a fire 
accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 
When paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning 
materials may result in poor performance of the product. Never use aerosol cleaners to avoid 
catching fire and explosion.

If you cannot remove the paper jam by doing the procedures in the manual, do not try to forcibly 
remove the jam. Doing so may cause injuries. Contact your local Fuji Xerox representative.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM 
player. Otherwise, large sound may damage audio players or your ears.

Laser Safety

CAUTION: 

� Any operations or adjustments not stated in the operation manual may cause hazardous 

light exposure and eventually burn injuries or loss of eyesight.

This product has been tested and found to comply with the Class 1 Laser Equipment requirements 
defined by the international standard IEC60825 and has no light exposure hazard. The product has 
no hazardous light emission as it features light protection components and covers to shut in all light 
beam during operation and maintenance.
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 CAUTION

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the "High 
Temperature" or "High Voltage" marks on.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from 
magnetic materials. Magnetic materials may accidentally activate the product and cause injuries or 
electric shock.

Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped 
around the fusing unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the 
product immediately and contact your local Fuji Xerox representative.

Do not apply excessive force to hold thick document on the document glass. It may break the glass 
and cause injuries.

Ventilate well during extended operation or mass copying. It may affect the office air environment 
due to odor such as ozone in a poorly ventilated room. Provide proper ventilation to ensure the 
comfortable and safe environment.
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 Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills. It 
may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 
volume of toner, contact your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire 
and cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

Fusing Unit Safety

Do not remove the Fusing Unit. If you cannot remove the paper jam by doing the procedures in the 
manual, do not try to forcibly remove the jam. Doing so may cause injuries. Contact your local Fuji 
Xerox representative.

Keep a drum cartridge and a toner cartridge out of the reach of children. If a child accidentally 
swallows toner, spit it out, rinse mouth with water, drink water and consult a physician immediately.

When replacing a drum cartridge and a toner cartridge, be careful not to spill the toner. In case of 
any toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.

Fusing Unit Safety

When removing the Fusing Unit, always switch off first and wait for 40 minutes until it cools off.
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 Warning and Caution Labels
Be sure to follow the warning and caution labels placed on the machine. Do not touch areas with labels indicating 
high voltage or temperature. This can cause an electric shock or burn.

CAUTION:

� Always follow all warning instructions marked on or supplied with this product. To avoid the risk of burn 

injuries and electric shock, never touch the area with the "High Temperature" or "High Voltage" marks on.
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Environment

� For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner cartridges and 
drums (photoreceptors) to make recycle parts, recycle materials or energy recovery.

� Proper disposal is required for toner cartridges and drums (photoreceptors) no longer needed. Do not open 
toner cartridges and drums (photoreceptors). Return them to your local Fuji Xerox representative.
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Regulation

 Radio Frequency Emissions (Class B)

 Fax Regulations

General warning

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item 
complies with minimum conditions for connection to its network. It indicates no endorsement of the product by 
Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item will work 
correctly in all respects with another item of Telepermitted equipment of a different make or model, nor does it imply 
that any product is compatible with all of Telecom’s network services Warnings taken from Specification text

Compliance testing (Functional tests)

"This equipment is not capable, under all operating conditions, of correct operation at the higher speeds for which it 
is designed. Telecom will accept no responsibility should difficulties arise in such circumstances"

Off-hook line impedance

"This equipment does not fully meet Telecom's impedance requirements. Performance limitations may occur when 
used in conjunction with some parts of the network. Telecom will accept no responsibility should difficulties arise in 
such circumstances"

General requirements (automatic dialling devices)

User Instructions (automatic call set-up)

"This equipment shall not be set up to make automatic calls to the Telecom ‘111’ Emergency Service"

User instructions

If a charge for local calls is unacceptable, the ‘Dial’ button should NOT be used for local calls. Only the 7-digits of the 
local number should be dialled from your telephone. DO NOT dial the area code digit or the ‘0’ prefix

This product has been tested and found to comply with the limits for a Class B digital device, 
pursuant to the International Standard for Electromagnetic Interference (CISPR Publ. 22) and 
Radiocommunications Act 1992 in Australia/New Zealand. 

These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This product generates, uses and can radiate radio frequency energy and, if 
not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this product does cause harmful interference to radio or television reception, which 
can be determined by turning this product off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

– Reorient or relocate the receiving antenna.

– Increase the separation between this product and the receiver.

– Connect this product into an outlet on a circuit different from that to which the receiver is 
connected.

– Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this product not specifically approved by Fuji Xerox may void the 
user’s authority to operate this product.
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About License

RSA BSAFE

This product includes RSA BSAFE® Cryptographic software from EMC Corporation.

DES

This product includes software developed by Eric Young.

(eay@mincom.oz.au)

AES

Copyright© 2003, Dr BrianGladman, Worcester, UK. All rights reserved. This product uses published AES software 
provided by Dr Brian Gladmanunder BSD licensing terms.

TIFF(libtiff)

LibTIFFCopyright© 1988-1997 SamLeffler

Copyright© 1991-1997 Silicon Graphics, Inc.

ICC Profile (Little cms)

LittlecmsCopyright© 1998-2004 Marti Maria

JPEG

Our printer software uses some of the codes defined by the Independent JPEG Group.
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Illegal Copies and Printouts

Copying or printing certain documents may be illegal in your country. Penalties of fines or imprisonment may be 
imposed on those found guilty. The following are examples of items that may be illegal to copy or print in your 
country. 

� Currency

� Banknotes and checks

� Bank and government bonds and securities

� Passports and identification cards

� Copyright material or trademarks without the consent of the owner

� Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact 
your legal counsel.
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Product Features

This section describes the product features and indicates their links.

USB Direct Print

The Print From USB Memory feature allows you to print 
directly from your USB storage device without requiring 
you to start your computer and an application.

For more information, see "Direct Print Using the USB 
Storage Device" on page 146.

Stored Print

The Stored Print feature allows you to temporarily store 
your print data in the printer memory and output it later. 
You can effectively manage your time when you print 
confidential data or large-volume data at off-peak hours.

For more information, see "Using the Stored Print Feature" 
on page 144.

Multiple-Up Print

The Pages Per Sheet (N-Up) feature allows you to print 
multiple pages on a single sheet of paper. This feature 
helps reduce the paper consumption.

For more information, see the print driver's help.

2-in-1 Copy

You can copy two original pages onto one sheet of paper 
by selecting N-Up on the operator panel when you make a 
copy. This feature helps save paper.

For more information, see "N-Up" on page 176.

ID Card Copy

You can copy both sides of an ID card on one side of a 
single sheet of paper in its original size by selecting ID 
Card Copy on the operator panel. This feature helps to 
show both sides of an ID card in one page in its original 
size.

For more information, see "ID Card Copy" on page 170.

Duplex Copy

You can copy documents on both sides of a sheet of paper 
by selecting 2 Sided on the operator panel when you make 
a copy. This feature helps save paper.

For more information, see "2-Sided" on page 172.
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Scan to E-mail

When you want to send scanned data by e-mail, use the 
E-mail feature. You can directly send the data scanned as 
an e-mail attachment. You can choose destination e-mail 
addresses from the address book on the printer or server. 
Or, you can enter the address from the printer's operator 
panel using the number pad.

For more information, see "Sending an E-Mail with the 
Scanned Image" on page 211.

Scan to SMB/FTP Server

You can transfer data scanned to a computer or a server 
via SMB or FTP without service software. Although prior 
registration of the destination FTP server or computer on 
the address book is required, it helps save your time.

For more information, see "Using a Scanner on the 
Network" on page 187.

Scan to USB Storage Device

You don't need a computer to connect your USB storage 
device to save the scanned data. Insert your USB storage 
device in the port on the printer, and save the scanned 
data directly to your USB storage device.

For more information, see "Scanning to a USB Storage 
Device" on page 209.

Scan From Document Glass

You can scan the pages of a book or a brochure from the 
document glass. When you scan documents using the 
document glass, place them face down.

For more information, see "Making Copies From the 
Document Glass" on page 167.

Scan From DADF

You can scan pieces of unbound paper using the duplex 
automatic document feeder (DADF). When you scan 
documents using the DADF, load them face up.

For more information, see "Making Copies From the 
DADF" on page 169.

Direct Fax from Computer

You can directly send faxes from your computer using the 
fax driver. You can specify the fax settings like the normal 
fax. Also, you can specify the recipient's fax number using 
the number pad, or the address book.

For more information, see "Sending a Fax from the Driver 
(Direct Fax)" on page 232.



30 Product Features

Address Book

Address Book simplifies the recipient specification. You 
can use the address book on the printer as well as on the 
server. Select the desired address or fax number from the 
address book when using the E-mail or Scan to Network 
feature, or sending faxes.

For more information, see "Address Book Editor" on 
page 71.
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may change 
without prior notice.

This chapter includes:

� "Copy Function" on page 32

� "Print Function" on page 34

� "Scan Function" on page 35

� "Fax Function" on page 37

� "Direct Fax Function" on page 38

� "Duplex Automatic Document Feeder" on page 39

� "Duplex Output Unit" on page 40
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Copy Function

Type Desktop

Memory Standard: 256 MB

Optional: 512 MB

Maximum memory capacity: 768 MB (Standard + optional 512MB memory)

IMPORTANT: 

� Depending on the function, the optional 512MB memory is required.

� The above memory capacity does not guarantee print quality depending on the 
type and content of print data.

HDD —

Color Capability Black and White

Printing Resolution 600 × 600 dpi

Tone 256 gray level

Warm-up Time 20 seconds or less*

(16 seconds* for waking up from the Sleep mode)
*: The values are based on a room temperature of 20 °C and on the factory default setting.

IMPORTANT: 

� It may take longer due to the image quality adjustment.

Original Paper Size Books: Maximum 215.9 × 297 mm

Sheets: Maximum 215.9 × 355.6 mm (Legal, when the duplex automatic document 
feeder (DADF) is used)

Output Paper Size Maximum: Legal (8.5 × 14"), 215.9 × 355.6 mm

Minimum: 3 × 5", 76.2 × 127 mm

Output Paper Weight 60 – 216 gsm

IMPORTANT: 

� Use paper recommended by Fuji Xerox. Copying may not be performed correctly 
depending on the conditions.

First Copy Output Time Document glass:

9 seconds or less (for A4 / standard mode)

DADF:

11 seconds or less (for A4  1 sided/ standard mode)

Reduction/Enlargement Size-for-Size: 1:1 ± 1.3%

Preset %: 1:0.50, 1:0.70, 1:0.81, 1:1.00, 1:1.22, 1:1.41, 1:2.00

Variable %: 1:0.25 - 1:4.00 (1% increments)

Continuous Copy Speed*1 1 Sided*2: 35 sheets/minute; 2 Sided*3: 21 pages/minute

IMPORTANT: 
*1 Print speed may decrease due to factors such as paper type, paper size, and printing 

conditions. Print speed may also decrease for image quality adjustment.

*2 When continuously printing a single document of A4  plain paper.

*3 A4  continuous printing

Paper Tray Capacity Standard:

250 sheets (Standard 250 sheet tray) + 50 sheets (Bypass tray)

Optional:

250 sheets (Optional 250 sheet feeder)

Maximum paper capacity:

550 sheets (Standard + Optional 250 sheet feeder)

IMPORTANT: 

� For special paper, there is a limitation of the following.

� From the bottom of the tray, up to 10 mm height (Standard 250 sheet tray)

� From the bottom of the tray, up to 5.5 mm height (Bypass tray)

� When using Fuji Xerox P paper (64 gsm)
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Continuous Copy 99 images

NOTE: 

� The machine may pause temporarily to perform image quality adjustment.

Output Tray Capacity Approximately 150 sheets (A4 ) (face down)

IMPORTANT: 

� When using Fuji Xerox P paper (64 gsm)

Power Supply AC 100 – 127 V ± 10%; 11 A or less; both 50/60 Hz ± 3%

AC 220 – 240 V ± 10%; 6 A or less; both 50/60 Hz ± 3%

IMPORTANT: 

� Maximum machine measured current

Operating Noise

(main unit only)

During operation: 7.13 B; 52.3 dB (A)

During stand-by: 5.3 B; 22.2 dB (A)

IMPORTANT: 

� Measurements based on ISO7779
Unit B: acoustic power level (LwAd)
Unit dB (A): radiated sound pressure (bystander position)

Power Consumption Maximum power consumption:

1200 W

Running mode:

500 W (Average)

Ready:

65 W (Average)

Low Power mode:

11 W or less 

Sleep mode:

4.5 W or less

Dimensions Width 430 × Depth 426 × Height 503 mm

Machine Weight 18.1 kg

IMPORTANT: 

� The weight of paper is not included.

� The weight of the toner cartridge is included.

Space Requirement Width 930 × Depth 1426 mm
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Print Function

Type Built-in

Continuous Print Speed Same as the Copy Function

IMPORTANT: 

� The speed may be reduced due to image quality adjustment.

� The performance may be reduced depending on the paper type.

Print Resolution 600 × 600 dpi, 1,200 × 1,200 dpi (Low Speed)

PDL PCL 5, PCL 6, PostScript® 3™, FX-PDF, TIFF, JPEG, HBPL

Protocol TCP/IP (LPD, Port9100, WSD, HTTP, HTTPS, SMTP, RARP, AutoIP, WINS, FTP, 
Telnet, LDAP, DNS, DDNS, IPP, SMB, SNTP), SNMP, DHCP, BOOTP, Bonjour® 
(mDNS)

NOTE: 

� WSD stands for Web Services on Devices.

� WSD is available only on Windows Vista®, Windows® 7, Windows Server® 2008, 
or Windows Server® 2008 R2.

Operating System Standard: PCL 6 and PostScript® drivers

Microsoft® Windows® XP x86

Microsoft® Windows Server® 2003 x86

Microsoft® Windows Vista® x86

Microsoft® Windows Server® 2008 x86

Microsoft® Windows® 7 x86

Microsoft® Windows® XP x64

Microsoft® Windows Server® 2003 x64

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2008 x64

Microsoft® Windows® 7 x64

Microsoft® Windows Server® 2008 R2 x64

Mac OS® X 10.3.9 PPC

Mac OS® X 10.4 PPC

Mac OS® X 10.5 PPC

Mac OS® X 10.4 x86

Mac OS® X 10.5 x86

Mac OS® X 10.6 x86

Mac OS® X 10.7 x86

Mac OS® X 10.6 x64

Mac OS® X 10.7 x64

Red Hat® Enterprise Linux® 5 Desktop x86

Red Hat® Enterprise Linux® 6 Desktop x86

SUSE® Linux Enterprise Desktop 10 x86

SUSE® Linux Enterprise Desktop 11 x86

IMPORTANT: 

� For information about the latest supported OS, contact your local Fuji Xerox 
representative.

Fonts Built-in fonts

PCL 5 and PCL 6 fonts: 81 fonts and 36 symbol sets

PostScript® 3™: 136 fonts

PDF Font: 14 fonts

Connectivity Standard: Ethernet (1000BASE-T/100BASE-TX/10BASE-T), USB 2.0

Optional: IEEE802.11 b/g/n

IMPORTANT: 

� When the optional wireless printer adapter is installed on the printer, the standard 
Ethernet connection cannot be used.



Specifications 35

Scan Function

Type Color scanner

Original Paper Size Same as the Copy Function

Scanning Resolution Scan to Email, Scan to FTP, Scan to SMB, Scan to USB Memory:

200/300/400/600 dpi

TWAIN:

50 to 9600 dpi

WIA:

75/100/150/200/300/400/600 dpi

WIA (WSD Scan):

200/300/400/600 dpi

NOTE: 

� If you are running on standard memory (less than 512 MB), the scanning 
resolution of color push scan (Scan to Email, Scan to FTP, Scan to SMB, Scan to 
USB Memory) and WSD Scan (any color mode) will be limited to 300 dpi.

Scanning Halftone Color: 16 bit × 3 ch (R/G/B)

Monochrome: 16 bit (Gray)

Scanning Speed DADF Simplex: 21 sheets/minute (Mono) 13 sheets/minute (Color)

DADF Duplex: 7 sheets/minute (Mono) 4 sheets/minute (Color)

IMPORTANT: 

� A4 , 600 dpi

� Scanning speed is the speed of document reading.
The time which transmission and/or storage varies depending on document, and 
is not contained in scanning time.

Connectivity Standard: Ethernet (1000BASE-T/100BASE-TX/10BASE-T), USB 2.0

Optional: IEEE802.11 b/g/n

IMPORTANT: 

� When the optional wireless printer adapter is installed on the printer, the standard 
Ethernet connection cannot be used.
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Scan to PC Protocol: TCP/IP (SMB, FTP)

Operating System:

Microsoft® Windows® XP x86

Microsoft® Windows Vista® x86

Microsoft® Windows Server® 2003 x86

Microsoft® Windows Server® 2008 x86

Microsoft® Windows® 7 x86

Microsoft® Windows® XP x64

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2003 x64

Microsoft® Windows Server® 2008 x64

Microsoft® Windows Server® 2008 R2 x64

Microsoft® Windows® 7 x64

Mac OS® X 10.3.9 PPC

Mac OS® X 10.4 PPC

Mac OS® X 10.5 PPC

Mac OS® X 10.4 x86

Mac OS® X 10.5 x86

Mac OS® X 10.6 x86

Mac OS® X 10.7 x86

Mac OS® X 10.6 x64

Mac OS® X 10.7 x64

IMPORTANT: 

� For information about the latest supported OS, refer to the Fuji Xerox Web site.

File Format:

PDF / JPEG (JFIF format) / TIFF (multi page 1 file) / TIFF (1 page 1 file) / XDW 
(DocuWorks)

Scan to e-mail Protocol: TCP/IP (SMTP, POP3)

File Format:

PDF / JPEG (JFIF format) / TIFF (multi page 1 file) / TIFF (1 page 1 file) / XDW 
(DocuWorks)

Scan to USB File Format:

PDF / JPEG (JFIF format) / TIFF (multi page 1 file) / TIFF (1 page 1 file) / XDW 
(DocuWorks)

IMPORTANT: 

� Operation with all type of USB memories is not guaranteed.
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Fax Function

Send Document Size Maximum: Legal (8.5 × 14"), 215.9 × 355.6 mm

Recording Paper Size Maximum: Legal

Minimum: A5

Transmission Time 2 seconds or less

IMPORTANT: 

� When transmitting an A4 size 700-character document in the standard quality (8 
× 3.85 lines/mm) and high speed mode (33.6 kbps or above: JBIG). This is only 
the transmission speed for image information and does not include the controlling 
time for the communication. Note that the actual transmission time depends on 
the content of documents, the machine that the recipient uses, and the status of 
the communication line.

Transmission Mode ITU-T Super G3, ITU-T G3 ECM, ITU-T G3

Scanning Resolution Standard: 200 × 100 pixel/25.4 mm (R8 × 3.85 line/mm)

Fine/Photo: 200 × 200 pixel/25.4 mm (R8 × 7.7 line/mm)

Super Fine: 400 × 400 pixel/25.4 mm (R16 × 15.4 line/mm) 

Coding Method Color: Not Supported

Monochrome: 1bit, JBIG, MMR, MR, MH encoding

Transmission Speed V.34 (33.6/31.2/28.8/26.4/24/21.6/19.2/16.8/14.4/12/9.6/7.2/4.8/2.4 kbps)

V.17 (14.4/12/9.6/7.2 kbps)

V.29 (9.6/7.2 kbps)

V.27ter (4.8/2.4 kbps)

No. of Fax Lines PSTN, PBX. Leased line (3.4 kHz/2-wire)
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Direct Fax Function

Document Size Same as the Fax Function

Scanning Resolution Same as the Fax Function

Transmission Speed Same as the Fax Function

Applicable Lines Same as the Fax Function

Operating System Microsoft® Windows® XP x86

Microsoft® Windows Server® 2003 x86

Microsoft® Windows Vista® x86

Microsoft® Windows Server® 2008 x86

Microsoft® Windows® 7 x86

Microsoft® Windows® XP x64

Microsoft® Windows Server® 2003 x64

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2008 x64

Microsoft® Windows Server® 2008 R2 x64

Microsoft® Windows® 7 x64

Mac OS® X 10.3.9 PPC

Mac OS® X 10.4 PPC

Mac OS® X 10.5 PPC

Mac OS® X 10.4 x86

Mac OS® X 10.5 x86

Mac OS® X 10.6 x86

Mac OS® X 10.7 x86

Mac OS® X 10.6 x64

Mac OS® X 10.7 x64

IMPORTANT: 

� For information about the latest supported OS, refer to the Fuji Xerox Web site.
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Duplex Automatic Document Feeder

Type Duplex automatic document feeder

Original Paper Size Maximum: Legal (8.5 × 14"), 215.9 × 355.6 mm

Minimum: 5.5 × 5.5", 139.7 × 139.7 mm

Capacity 50 sheets (A4  1sided)

IMPORTANT: 

� When using Fuji Xerox P paper (64 gsm)

Feeding Speed When copying multiple sets of copies of single-sheet document:

35 sheets/minute (A4  1sided)

When copying one set of copies of multiple-sheet document:

1 Sided: 21 sheets/minute; 2 Sided: 7 pages/minute (A4 )
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Duplex Output Unit

Applicable Paper Size Maximum: Legal (8.5 × 14"), 215.9 × 355.6 mm

Minimum: 139.7 × 210 mm

Paper Weight 60 – 163 gsm
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2
Basic Operation

This chapter includes:

� "Main Components" on page 42

� "Installing Optional Accessories" on page 47

� "Turning on the Printer" on page 63

� "Printing a Panel Settings Page" on page 64

� "Power Saver Mode" on page 65
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Main Components

This section provides an overview of your DocuPrint M355 df.

This section includes:

� "Front View" on page 42

� "Rear View" on page 43

� "Duplex Automatic Document Feeder (DADF)" on page 44

� "Operator Panel" on page 45

� "Securing the Printer" on page 46

 Front View

IMPORTANT: 
� To avoid irregular screen image or malfunctioning of your printer, avoid placing the printer in direct sunlight with the bypass 

tray opened.

1 Duplex Automatic Document Feeder 
(DADF)

5 Toner Cartridge

2 Bypass Tray 6 Drum Cartridge

3 Standard 250 Sheet Tray (Tray1) 7 Front Cover

4 Optional 250 Sheet Feeder (Tray2) 8 Operator Panel

18

4 3 26 57
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 Rear View

*: The optional wireless printer adapter is not supplied in some regions.

1 Control Board 8 Wall Jack Connector

2 Control Board Cover 9 Power Connector

3 Power Switch 10 Chute

4 Ethernet Port 11 Duplexer

5 USB Port 12 Transfer Unit

6 Wireless Adapter Socket* 13 Fusing Unit

7 Phone Connector 14 Rear Door

1

2

4

3

5

6

7

89

11

12

13

14

10
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 Duplex Automatic Document Feeder (DADF)

NOTE: 

� Some types of documents cannot be loaded in the DADF. For details, see "Duplex Automatic Document Feeder (DADF) 
Guidelines" on page 124.

1 DADF Cover 5 Document Feeder Tray

2 Document Guides 6 Document Stopper

3 DADF Glass 7 Front USB Port

4 Document Glass 8 DADF Feed Roller

18

2

4

3

5

6

7
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 Operator Panel
The operator panel has a 160 × 64 dots liquid crystal display (LCD), light-emitting diodes (LED), control buttons, one 
touch dial buttons and number pad, which allow you to control the printer.

1 One Touch Dial buttons

� Calls up the stored Fax number registered in the Phone Book. The first eight fax numbers in the Phone Book 
are assigned to the buttons in row order, starting from the left top corner.

2 LCD Panel

� Displays various settings, instructions, and error messages. 

3   buttons

� Moves a cursor or highlight up or down. 

4  (Job Status) button

� Moves to the top level of the Job Status menu.

5   buttons

� Moves a cursor or highlight left or right. 

6  (System) button

� Moves to the top level of the System menu.

7 Number Pad

� Enters characters and numbers.

8 CA (Clear All) button

� Resets the current setting, and returns to the top level of each menu.

9  (Energy Saver) button

� Lights up in the Power Saver mode. Press this button to enter or exit the Power Saver mode.

10  (Stop) button

� Cancels the current processing or pending job.

11  (Start) button

� Starts a job.

12  (Error) LED

� Lights up when the printer has an error.

1 2 3 4 5 6 7 8 9

1011121314151617181920212223
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13  (Data) LED

� Flashes when data for Fax, Scan, Print job, or Stored job is being received.

14  (Speed Dial) button

� Calls up a stored telephone number.

15 C (Clear) button

� Deletes characters and numbers.

16  (Redial / Pause) button

� Re-dials a telephone number.

� Inserts a pause during dialing.

17  (Address Book) button

� Moves to the top level of the Address Book menu.

18  button

� Confirms the entry of values. 

19  (Back) button

� Returns to the previous screen.

20  (Fax) button

� Moves to the top level of the Fax menu.

21  (Printer) button

� Moves to the top level of the Print menu.

22  (Scan) button

� Moves to the top level of the Scan menu. 

23  (Copy) button

� Moves to the top level of the Copy menu.

NOTE: 

� Moving to a different menu or returning to a previous screen cancels the current entry or setting. Make sure to press the  
button to save the current entry or setting. 

� For details on how to use the number pad to enter alphanumeric characters, see "Using the Number Pad to Enter Characters" 
on page 314.

 Securing the Printer
To protect your printer from theft, you can use the optional Kensington lock.

Attach the Kensington lock to the security slot on your printer.

For details, see the operating instructions supplied with the Kensington lock.

Security slot
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Installing Optional Accessories

You can make the printer more functional by installing the optional accessories such as the 512MB Memory, the 250 
Sheet Feeder(MFP), and the Wireless Network Kit b/g/n. This section describes how to install these printer's 
options.

This section includes:

� "Installing the Optional 512MB Memory" on page 47

� "Installing the Optional 250 Sheet Feeder" on page 52

� "Installing the Optional Wireless Printer Adapter" on page 58

 Installing the Optional 512MB Memory

NOTE: 

� Your printer supports additional 512 MB memory module.

1 Turn off the printer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 

� Loosen the screw. You do not need to remove the screw.
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3 Slide the control board cover towards the rear of the printer and remove the cover.

4 Hold the edge of the memory module with the labeled side down and the connector toward the control board, 
and then insert it into the slot.

5 Push the memory module firmly into the slot.

NOTE: 

� Ensure that the memory module is firmly fixed in the slot and does not move easily.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.
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7 Turn the screw clockwise.

8 Turn on the printer.

9 Print the System Settings page to confirm that the newly installed memory module is detected by the printer.

a Press the  (System) button.

b Select Report / List, and then press the  button.

c Select System Settings, and then press the  button.

The System Settings page is printed.

10 Confirm the amount of Memory Capacity listed under General in the System Settings page.

If the memory capacity has not increased, turn off the printer, and re-install the memory module.

11 If you installed the optional 512MB memory after installing the print driver, update your driver by following the 
instructions for the operating system you are using. If the printer is on a network, update the driver for each 
client.
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Updating Your Driver to Detect Optional 512MB Memory

The following procedure uses Microsoft® Windows® and the PCL 6/PS driver.

NOTE: 

� When you use XML Paper Specification (XPS) driver, the following settings are not required.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select RAM Disk in the Items list box.

3 Select Installed in the RAM Disk drop-down menu under Setting for.

4 Select Memory Capacity in the Items list box.

5 Select the total amount of the installed printer memory in the Memory Capacity drop-down menu under 
Setting for.

6 Click OK.

7 Click Apply, and then click OK.

8 Close the Printers and Faxes (, Printers, or Devices and Printers) dialog box.

Windows 7/
Windows 7 x64/
Windows Server® 2008 R2 x64

1 Click Start → Devices and Printers.

2 Right-click the printer icon of the DocuPrint M355 df and select Printer 

properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows Vista®/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon of the DocuPrint M355 df and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows Server 2008/
Windows Server 2008 x64

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon of the DocuPrint M355 df and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows XP/
Windows XP x64/
Windows Server 2003/
Windows Server 2003 x64

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon of the DocuPrint M355 df and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes dialog box.
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The following procedure uses Mac OS® X and the PS driver.

Mac OS X 10.7.x 1 Select the Print & Scan in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup 

Utility).

2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select 
Show Info.

3 Select Installable Options, and select the options that have been installed on the 
printer, and then click Apply Changes.
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 Installing the Optional 250 Sheet Feeder

IMPORTANT: 

� If you install the optional 250 sheet feeder after setting up the printer, be sure to turn off the printer, unplug the power cord, 
and disconnect all cables from the rear of the printer before installing the feeder.

1 Turn off the printer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

2 Disconnect all cables from the rear of the printer.
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3 Remove the tape and the bag holding the screws on the front of the optional 250 sheet feeder, and then 
remove the screws from the bag.

4 Place the optional 250 sheet feeder in the location that the printer is located.

5 Gently pull open the bypass tray cover.

6 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

7 Pull the standard 250 sheet tray out of the printer about 200 mm.
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8 Hold the standard 250 sheet tray with both hands, and remove it from the printer.

9 Lift the printer and align the five guide pins of the optional 250 sheet feeder with the holes at the bottom of the 
printer. Gently lower the printer onto the optional 250 sheet feeder.

IMPORTANT: 

� When lifting the machine, make sure to follow the precautions stated in "Machine Installation" on page 18.

� Be careful not to pinch your fingers when lowering the printer onto the optional 250 sheet feeder.

10 Secure the optional 250 sheet feeder to the printer by tightening the two screws provided with the feeder with a 
coin or similar object.

NOTE: 

� The screw hole is located in 70 mm recess from the front of the printer.
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11 Insert the standard 250 sheet tray into the printer, and push until it stops.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

12 Insert the bypass tray into the printer, push until it stops, and close the cover.

13 Reconnect all cables into the rear of the printer and turn on the printer.

NOTE: 

� The printer will automatically detect the attached tray but will not detect the paper type.

14 Print the System Settings page to confirm the optional 250 sheet feeder is installed correctly.

a  Press the  (System) button.

b Select Report / List, and then press the  button.

c Select System Settings, and then press the  button.

The System Settings page is printed.

15 Confirm Tray 2 (250 Sheet Feeder) is listed under Printer Options in the System Settings page.

If the feeder is not listed, turn off the printer, unplug the power cord, and re-install the optional 250 sheet feeder.

16 After loading paper in the optional 250 sheet feeder, specify the paper type from the printer operator panel.

a Press the  (System) button.

b Select Tray Settings, and then press the  button.

c Select Tray 2, and then press the  button.

d Select Paper Type, and then press the  button.

e Select the paper type for the optional 250 sheet feeder, and then press the  button.

17  If you installed the optional 250 sheet feeder after installing the print driver, update your driver by following the 
instructions for each operating system. If the printer is on a network, update the driver for each client.
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Updating Your Driver to Detect Optional 250 Sheet Feeder

The following procedure uses Windows and the PCL 6/PS driver.

NOTE: 

� When you use XML Paper Specification (XPS) driver, the following settings are not required.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select Paper Tray Configuration in the Items list box.

3 Select 2 Trays in the Paper Tray Configuration drop-down menu under Setting for.

4 Click OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes (, Printers, or Devices and Printers) folder.

Windows 7/
Windows 7 x64/
Windows Server 2008 R2 x64

1 Click Start → Devices and Printers.

2 Right-click the printer icon of the DocuPrint M355 df and select Printer properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows Vista/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon of the DocuPrint M355 df and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows Server 2008/
Windows Server 2008 x64

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon of the DocuPrint M355 df and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows XP/
Windows XP x64/
Windows Server 2003/
Windows Server 2003 x64

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon of the DocuPrint M355 df and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes dialog box.
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The following procedure uses Mac OS X and the PS driver.

Mac OS X 10.7.x 1 Select the Print & Scan in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup 

Utility).

2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select 
Show Info.

3 Select Installable Options, and select the options that have been installed on the 
printer, and then click Apply Changes.
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 Installing the Optional Wireless Printer Adapter
The wireless printer adapter is supplied with the Wireless Network Kit b/g/n.

The wireless printer adapter allows you to use the printer with wireless network connection.

The specifications of the wireless printer adapter are described below.

NOTE: 

� The optional wireless printer adapter is not supplied in some regions.

NOTE: 

� When the wireless printer adapter is installed, you cannot use IEEE 802.1x authentication and/or the Ethernet port for a wired 
connection.

Verifying the Contents of the Box

NOTE: 

� To complete wireless installation, you require the corresponding Driver CD Kit that comes with your printer, which can also be 
downloaded from http://www.fujixerox.com/support/docuprint/.

Item Specification

Connectivity Technology Wireless

Compliant Standards IEEE 802.11b, 802.11g, and 802.11n

Bandwidth 2.4 GHz

Data Transfer Rate IEEE 802.11n: 65 Mbps

IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps

IEEE 802.11b: 11, 5.5, 2, and 1 Mbps

Security 64 (40-bit key)/128 (104-bit key) WEP,

WPA- PSK (TKIP, AES), WPA2-PSK (AES)

Wi-Fi® Protected Setup (WPS) Push-Button Configuration (PBC),

Personal Identification Number (PIN)

Fuji Xerox Co., Ltd.

XXXX XXXXX / DE4942Z4-1

(Edition 1) June 2012

Printed in China

Copyright © 2012 by Fuji Xerox Co., Ltd. XXXX XXXXX

Thank you for purchasing the Wireless Network Kit b/g/n. 

To ensure the safe operation of the printer, be sure to read through the "Safety Guide" before starting 

the installation. For more details such as how to configure the wireless settings for the printer, refer to 

"Configuring Wireless Settings (Windows & Mac OS X)" in "User Guide" available on the Driver CD Kit.

Installing the Wireless Printer Adapter

Important

� Ensure that the printer is turned off before installing the wireless printer adapter.

Align the connector and the three protrusions of the wireless printer adapter with the four holes on the rear of the 

printer, and insert the adapter as shown in the illustration.

�

�

Wireless Network Kit b/g/n Installation Guide

Wireless Printer Adapter

Wireless Network Kit b/g/n 
Installation Guide
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Installing the Optional Wireless Printer Adapter Using Video 

Instructions (Recommended)

To install the wireless printer adapter using the video instructions on the Windows computer, perform the following 
method.

1 Insert the Driver CD Kit in your computer. The Easy Install Navi file launches automatically.

2 Select Optional Accessories Setup on the Easy Install Navi window.
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3 Click Wireless Network Kit b/g/n.
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4 Click the procedure you want to confirm to start the video instruction.

Follow the on-screen instructions to install the wireless printer adapter.

Installing the Optional Wireless Printer Adapter

NOTE: 

� You can also install the wireless printer adapter by following the instructions described in Wireless Network Kit b/g/n 
Installation Guide provided with the wireless printer adapter.

1 Turn off the printer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.
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2 Align the connector and the three protrusions of the wireless printer adapter with the four holes and insert the 
adapter.

NOTE: 

� Ensure that the adapter is fully inserted and secured.

3 Turn on the printer.

If a message displays telling you to make initial setup on the operator panel, always do as instructed.

4 Print the System Settings page to confirm the wireless printer adapter is installed correctly.

a Press the  (System) button.

b Select Report / List, and then press the  button.

c Select System Settings, and then press the  button.

The System Settings page is printed.

5 Confirm that the Network (Wireless) section exists.

NOTE: 

� For more information on configuring the wireless printer adapter, see "Configuring Wireless Settings (Windows & Mac 
OS X)" on page 110.
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Turning on the Printer

IMPORTANT: 

� Do not use extension cords or power strips.

� The printer should not be connected to an uninterrupted power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer.

2 Connect the other end of the power cord to the power source.

3 Turn on the printer.
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Printing a Panel Settings Page

The Panel Settings page shows current settings for the operator panel menus. 

1 Press the  (System) button.

2 Select Report / List, and then press the  button.

3 Select Panel Settings, and then press the  button.

The Panel Settings page is printed.
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Power Saver Mode

The printer has an energy saving feature that reduces power consumption during periods of inactivity. This feature 
operates in two modes: the Low Power mode and Sleep mode. As delivered, the printer switches to the Low Power 
mode three minutes after the last print job is printed. The printer then switches to the Sleep mode after another one 
minute of inactivity. When the printer is in the Low Power mode,  (Energy Saver) button lights up, and the LCD 
backlight turns off. In the Sleep mode, the display also goes blank and displays nothing.

The factory default setting of one minute for each mode is changeable within the range of 1 to 60 minutes (Low 
Power mode and Sleep mode). The printer returns to the ready-to-print state in about 16 seconds when re-activated.

The printer can switch from the ready-to-print state to the Low Power mode without waiting right after pressing  
(Energy Saver) button. Press  (Energy Saver) button to switch to Power Saver mode to save electricity.

NOTE: 

� The functions of Low Power mode and Sleep mode cannot be disabled.

See also: 

� "Setting the Power Saver Timer Option" on page 311

 Exiting the Power Saver Mode
The printer automatically exits the Power Saver mode when it receives a print job from a computer. To manually exit 
the Low Power mode, press the  (Energy Saver) button on the operator panel. To exit the Sleep mode, press the 

 (Energy Saver) button. 

NOTE: 

� Opening and closing a cover will cause the printer to exit the Low Power mode and the Sleep mode.

� Opening and closing the DADF cover will cause the printer to exit the Sleep mode.

� When the printer is in the Sleep mode, all buttons on the operator panel except for the  (Energy Saver) button do not 
function. To use the buttons on the operator panel, press the  (Energy Saver) button to exit the Sleep mode.

See also: 

� "Setting the Power Saver Timer Option" on page 311
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3
Printer Management Software

Use the CD-ROMs shipped with your printer to install a combination of software programs, depending on your 
operating system.

This chapter includes:

� "Print and Scan Drivers" on page 68

� "CentreWare Internet Services" on page 69

� "SimpleMonitor (Windows Only)" on page 70

� "Address Book Editor" on page 71

� "Express Scan Manager" on page 72

� "Setup Disk Creation Tool (Windows Only)" on page 73

� "DocuWorks (Windows Only)" on page 74
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Print and Scan Drivers

To access all of your printer’s features, install the print and scan drivers from the Driver CD Kit or PostScript Driver 

Library CD.

� The print drivers enable your computer and printer to communicate and provide access to your printer features. 

� The scan drivers enable you to scan images directly to your personal computer and place scanned images 
directly into an application via USB or the network.

See also: 

� "Installing the Scan Driver" on page 181
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CentreWare Internet Services

This section provides information on CentreWare Internet Services, a hyper text transfer protocol (HTTP)-based web 
page service that is accessed through your web browser. 

These pages give you instant access to printer status, and printer configuration options. Anyone on your network 
can access the printer using their web browser software. In administrative mode you can change the configuration of 
the printer, set up your fax directories, and manage your printer settings without leaving your computer.

NOTE: 

� Users who are not given passwords by the administrator can still view the configuration settings and options in user mode. 
They will not be able to save or apply any changes to the current configuration.

 Creating an Administrative Password

1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select Administrator Settings.

5 Select Enabled for Administrator Mode. 

6 In the Administrator Login ID field, enter a name for the administrator.

NOTE: 

� The default ID and password are “11111” and “x-admin”, respectively.

7 In the Administrator Password and Re-enter Password fields, enter a password for the administrator.

8 In the Maximum Login Attempts field, enter the number of login attempts allowed.

9 Click Apply.

Your new password has been set and anyone with the administrator name and password can log in and 
change the printer configuration and settings.
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SimpleMonitor (Windows Only)

You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon  on the taskbar 
at the bottom right of the screen. The Select Printer window appears, which displays the printer name, printer 
connection ports, and printer status. Check the Status column to know the current status of your printer. You can 
also check the toner level of your printer.

Status Settings button: Displays the Status Settings dialog box and allows you to modify the SimpleMonitor 
settings.

Click the name of the desired printer listed on the Select Printer window. The Status Monitor window appears.

The Status Monitor window alerts you when there is a warning or when an error occurs, for example, when a paper 
jam occurs or toner is running low.

By default, the Status Monitor window launches when printing and an error occurs. When an error occurs, the error 
message appears on the Status Monitor window. You can specify the conditions for starting the Status Monitor 
window in Auto start setup.

To change the pop-up settings for the Status Monitor window:

The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate SimpleMonitor.

The Select Printer window appears.

2 Click Status Settings.

The Status Settings dialog box appears.

3 Select the Pop-up Settings tab, and then select the type of the pop-up from Auto start setup.

SimpleMonitor can be installed from the Driver CD Kit. It is available only for Windows.
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Address Book Editor 

The Address Book Editor provides a convenient interface for modifying the printer’s address book entries. With it 
you can create:

� Fax entries

� Email entries

� Server entries

When you start the software, if the printer is connected to your computer via USB or to a network, the Address Book 
Editor reads the printer’s address book. You can create, edit, and delete entries. After making changes, you can then 
save the updated address book to the printer or to your computer.

 

To open the Address Book Editor:

The following procedure uses Windows 7 as an example.

Click Start → All Programs → Fuji Xerox → DocuPrint M355 df → Address Book Editor.

The Address Book Editor can be installed from the Driver CD Kit. It is available for Windows and Mac OS® X.
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Express Scan Manager 

The Express Scan Manager handles scan jobs sent from the printer to your computer via USB. When a scan job is 
sent from the printer to the computer, Express Scan Manager automatically manages the scan job.

Before scanning to your computer, start Express Scan Manager and configure the scan settings. You can specify 
settings for output destination.

To open the Express Scan Manager:

The following procedure uses Windows 7 as an example.

Click Start → All Programs → Fuji Xerox → DocuPrint M355 df → Express Scan Manager.

The Express Scan Manager can be installed from the Driver CD Kit. It is available for Windows and Mac OS X.

See also: 

� "Scanning" on page 179
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Setup Disk Creation Tool (Windows Only)

The Setup Disk Creation Tool on the Driver CD Kit and the print drivers on the Driver CD Kit and PostScript Driver 

Library CD are used to create driver installation packages that contain custom driver settings. A driver installation 
package can contain a group of saved print driver settings and other data for things such as:

� Print orientation and Multiple Up (document settings)

� Watermarks

� Font references

If you want to install the print driver with the same settings on multiple computers running the same operating 
system, create a setup disk in a floppy disk or in a server on the network. Using the setup disk that you have created 
will reduce the amount of work required when installing the print driver.

� Install the print driver in the computer on which the setup disk is to be created.

� The setup disk can only be used on the operating system on which the disk was created or computers running 
the same operating system. Create a separate setup disk for each of the operating systems.
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DocuWorks (Windows Only)

When installing DocuWorks, run the appropriate EXE file in the DocuWorks CD.

Windows supports DocuWorks and DocuWorks Viewer Light.

DocuWorks is available only for Windows.

NOTE: 

� For more information on DocuWorks, refer to the readme file on the DocuWorks CD.
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4
Printer Connection and Software 

Installation

This chapter includes:

� "Overview of Network Setup and Configuration" on page 76

� "Connecting Your Printer" on page 77

� "Setting the IP Address" on page 81

� "Installing Print Driver on Computers Running Windows" on page 85

� "Installing Print Driver on Computers Running Mac OS X" on page 103

� "Installing Print Driver on Computers Running Linux (CUPS)" on page 104

� "Configuring Wireless Settings (Windows & Mac OS X)" on page 110
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Overview of Network Setup and Configuration

To set up and configure the network:

1 Connect the printer to the network using the recommended hardware and cables.

2 Turn on the printer and the computer.

3 Print the System Settings page and keep it for referencing network settings. 

4 Install the driver software on the computer from the Driver CD Kit or PostScript Driver Library CD. For 
information on driver installation, see the section in this chapter for the specific operating system you are using.

5 Configure the printer’s TCP/IP address, which is required to identify the printer on the network. 

� Microsoft® Windows® operating systems: Run the IP address setting tool on the Driver CD Kit to set the 
printer’s IP address if the printer is connected to an established TCP/IP network. You can also manually set 
the printer’s IP address on the operator panel.

� Mac OS® X and Linux® systems: Manually set the printer’s TCP/IP address on the operator panel.

See also: 

� "Setting the IP Address" on page 81

6 Print a System Settings page to verify the new settings.

NOTE: 

� If the Driver CD Kit or PostScript Driver Library CD is not available, you can download the latest driver from the Fuji Xerox 
Web Site: http://www.fujixeroxprinters.com/ 

See also: 

� "Printing a System Settings Page" on page 158

http://www.fujixeroxprinters.com/
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Connecting Your Printer

Your printer interconnection cables must meet the following requirements:

Connection Type Connection Specifications

USB USB 2.0

Ethernet 10 Base-T/100 Base-TX/1000 Base-T

Wireless (optional) IEEE 802.11b/802.11g/802.11n

Wall jack connector RJ11

Phone connector RJ11

1 Ethernet port

2 USB port

3 Wireless adapter socket

4 Phone connector

5 Wall jack connector

1

2

4

5

3
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 Connecting Printer to Computer or Network
Connect the printer via USB, Ethernet or wireless (optional). A USB connection is a direct connection and is not 
used for networking. Ethernet and wireless connections are used for networking. Hardware and cabling 
requirements vary for the different connection methods. Ethernet cable and hardware are generally not included with 
your printer and must be purchased separately.

The available features for each connection type are shown in the following table.

Connection Type Available Features

USB When connected via USB you can:

� Instruct print jobs from a computer.

� Scan and print an image into an application.

� Scan and print an image to a folder on the computer.

� Use the Address Book Editor to manage address book entries.

� Use the SimpleMonitor to check the printer status.

� Use the Express Scan Manager to handle scan jobs sent from the printer to your 
computer.

Ethernet When connected via Ethernet you can:

� Instruct print jobs from a computer on the network.

� Scan and print an image into an application.

� Scan and print an image to a folder on the computer on the network.

� Scan to a computer on the network.

� Scan to an FTP server.

� Scan to email.

� Use CentreWare Internet Services to configure the printer status or settings.

� Use the Address Book Editor to manage address book entries.

� Use the SimpleMonitor to check the printer status.

Wireless (optional) When connected via wireless you can:

� Instruct print jobs from a computer on the network.

� Scan and print an image into an application.

� Scan and print an image to a folder on the computer on the network.

� Scan to a computer on the network.

� Scan to an FTP server.

� Scan to email.

� Use CentreWare Internet Services to configure the printer status or settings.

� Use the Address Book Editor to manage address book entries.

� Use the SimpleMonitor to check the printer status.
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USB Connection

A local printer is directly connected to your computer using the USB cable. If your printer is connected to a network 
instead of your computer, skip this section and go to "Wired Network Connection" on page 79.

To connect the printer to a computer:

1 Connect the smaller USB connector into the USB port on the rear of the printer, and the other end of the cable 
into a USB port of the computer.

NOTE: 

� Ensure that you match the USB symbol on the cable to the USB symbol on the printer.

� Do not connect the printer USB cable to the USB port available on the keyboard.

Wired Network Connection

To connect the printer to a network:

1 Connect one end of the Ethernet cable into the Ethernet port on the rear of the printer, and the other end to a 
LAN drop or hub.
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Wireless Network Connection

To set up a wireless connection, insert the optional wireless printer adapter into the wireless adapter socket on the 
rear of the printer. For details about wireless connection, see "Installing the Optional Wireless Printer Adapter" on 
page 58.

NOTE: 

� To use the wireless printer adapter, be sure to disconnect the Ethernet cable.
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Setting the IP Address

This section includes:

� "TCP/IP and IP Addresses" on page 81

� "Setting the Printer’s IP Address through the Driver CD Kit" on page 81

� "Dynamic Methods of Setting the Printer’s IP Address" on page 82

� "Assigning an IP Address (for IPv4 Mode)" on page 83

� "Verifying the IP Settings" on page 84

� "Printing and Checking the System Settings Page" on page 84

 TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate TCP/IP addresses and 
additional system settings information. 

If you are creating your own small Local Area Network or connecting the printer directly to your computer using 
Ethernet, follow the procedure for automatically setting the printer’s IP address. 

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. With TCP/IP 
protocols, each printer and computer must have a unique IP address. It is important that the addresses are similar, 
but not the same; only the last digit needs to be different. For example, your printer can have the address 
192.168.1.2 while your computer has the address 192.168.1.3. Another device can have the address 192.168.1.4.

Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically 
programs an IP address into every computer and printer on the network that is configured to use DHCP. A DHCP 
server is built into most cable and Digital Subscriber Line (DSL) routers. If you use a cable or DSL router, see your 
router’s documentation for information on IP addressing.

 Setting the Printer’s IP Address through the Driver CD Kit
If the printer is connected to a small established TCP/IP network without a DHCP server, use the IP address setting 
tool on the Driver CD Kit to detect or assign an IP address to your printer. For further instructions, insert the Driver 

CD Kit into your computer’s CD-ROM drive. After the IP address setting tool launches, click Install Driver and 

Software. Start IP address setting tool on the Admin Tools tab, and follow the displayed instructions.

NOTE: 

� For the IP address setting tool to function, the printer must be connected to an established TCP/IP network.
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 Dynamic Methods of Setting the Printer’s IP Address
There are two protocols available for dynamically setting the printer’s IP address: 

� DHCP (enabled by default)

� AutoIP

You can turn on/off both protocols using the operator panel or CentreWare Internet Services.

NOTE: 

� You can print a report that includes the printer’s IP address. On the operator panel, press the  (System) button, select 
Report / List, press the  button, select System Settings, and then press the  button. The IP address is listed on 
the System Settings page.

Using the Operator Panel

To turn on/off either the DHCP or AutoIP protocol:

1 On the operator panel, press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select TCP/IP, and then press the  button.

5 Select IPv4, and then press the  button.

6 Select Get IP Address, and then press the  button.

7 Select DHCP / AutoIP, and then press the  button.

Using CentreWare Internet Services

To turn on/off either the DHCP or AutoIP protocol:

1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.

3 Select Properties.

4 Select the Protocol Settings folder on the left navigation panel.

5 Select TCP/IP.

6 In the Get IP Address field, select the DHCP / Autonet option.

7 Click the Apply button.
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 Assigning an IP Address (for IPv4 Mode)

NOTE: 

� When you assign an IP address manually in IPv6 mode, use the CentreWare Internet Services. To display the CentreWare 
Internet Services, use the link local address. To check a link local address, see "Printing and Checking the System Settings 
Page" on page 84.

� Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

� Depending on the address class, the range of the IP address assigned may be different. On Class A, for example, an IP 
address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment of IP addresses, contact 
your system administrator. 

You can assign the IP address by using the operator panel.

1 Turn on the printer.

2 Ensure that Ready message appears on the LCD panel.

3 On the operator panel, press the  (System) button.

4 Select Admin Menu, and then press the  button.

5 Select Network Setup, and then press the  button.

6 Select TCP/IP, and then press the  button.

7 Select IPv4, and then press the  button.

8 Select Get IP Address, and then press the  button.

9 Select Panel, and then press the  button.

10 Ensure that the message This Setting Becomes Effective after Restart appears, and then press 
the  (Back) button.

11 Select IP Address, and then press the  button.

The cursor is located at the first octet of the IP address.

12 Enter the value of the IP address using the number pad.

13 Press the  button.

The cursor moves to the next octet.

14 Repeat steps 12 to 13 to set all of the digits in the IP address, and then press the  button.

15 Ensure that the message This Setting Becomes Effective after Restart appears, and then press 
the  (Back) button.

16 Select Subnet Mask, and then press the  button.

The cursor is located at the first octet of the subnet mask.

17 Enter the value of the subnet mask using the number pad.

18 Press the  button.

The cursor moves to the next octet.

19 Repeat steps 17 to 18 to set the subnet mask, and then press the  button.

20 Ensure that the message This Setting Becomes Effective after Restart appears, and then press 
the  (Back) button.

21 Select Gateway Address, and then press the  button.

The cursor is located at the first octet of the gateway address.
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22 Enter the value of the gateway address using the number pad.

23 Press the  button.

The cursor moves to the next octet.

24 Repeat steps 22 to 23 to set the gateway address, and then press the  button.

25 Ensure that the message This Setting Becomes Effective after Restart appears, and then press 
the  (Back) button.

26 Turn off and turn on the printer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

See also: 

� "Operator Panel" on page 45

 Verifying the IP Settings
You can confirm the settings by printing the system settings report or using the ping command.

The following procedure uses Windows 7 as an example.

1 Print the System Settings page.

2 Look under the IPv4 heading on the System Settings page to ensure that the IP address, subnet mask, and 
gateway address are appropriate.

To verify if the printer is active on the network, run the ping command in your computer:

1 Click Start → All Programs → Accessories → Run.

2 Enter cmd, and then click OK.

A black window is displayed.

3 Enter ping xx.xx.xx.xx (where xx.xx.xx.xx is the IP address of your printer), and then press the Enter key.

Reply from the IP address denotes printer is active on the network.

See also: 

� "Printing and Checking the System Settings Page" on page 84

 Printing and Checking the System Settings Page
Print the System Settings page and check your printer's IP address by using the operator panel.

1 On the operator panel, press the  (System) button.

2 Select Report / List, and then press the  button.

3 Select System Settings, and then press the  button.

The System Settings page is printed.

4 Confirm the IP address next to IP Address under Network Setup on the System Settings page. If the IP 
address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the System 
Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on page 83.
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Installing Print Driver on Computers Running 
Windows

This section includes:

� "Identifying Print Driver Pre-install Status (For Network Connection Setup)" on page 85

� "Inserting the CD-ROM" on page 86

� "USB Connection Setup" on page 87

� "Network Connection Setup" on page 89

� "Setting Up for Shared Printing" on page 94

NOTE: 

� The fax driver is installed with the PCL 6 driver.

 Identifying Print Driver Pre-install Status (For Network 

Connection Setup)
Before installing the print driver on your computer, print the System Settings page to check the IP address of your 
printer.

This section includes:

� "The Operator Panel" on page 85

� "Changing the Firewall Settings Before Installing Your Printer" on page 86

The Operator Panel

1 Press the  (System) button.

2 Select Report / List, and then press the  button.

3 Select System Settings, and then press the  button.

The System Settings page is printed.

4 Find the IP address next to IP Address under Network Setup on the System Settings page.

If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the 
System Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on page 83.
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Changing the Firewall Settings Before Installing Your Printer

If you are running one of the following operating systems, you must change the firewall settings before installing the 
Fuji Xerox printer software:

� Windows 7

� Windows Vista®

� Windows Server® 2008 R2

� Windows Server 2008

� Windows XP

NOTE: 

� For Windows XP, Service Pack 2 or 3 must be installed.

The following procedure uses Windows 7 as an example.

1 Insert the Driver CD Kit into your computer.

2 Click Start → Control Panel.

3 Click System and Security.

4 Click Windows Firewall.

5 Click Allow a program or feature through Windows Firewall.

6 Click Change settings.

7 Click Allow another program.

8 Click Browse.

9 Click D:\setup.exe (where D is the drive letter of your CD) in the File name text box, and then click Open.

10 Click Add.

11 Click OK.

 Inserting the CD-ROM

� For Installing PCL 6 and Fax Driver

1 Insert the Driver CD Kit into your computer to start Easy Install Navi.

NOTE: 

� If the CD does not automatically launch, click Start (start for Windows XP) → All Programs (for Windows Vista and 
Windows 7) → Accessories (for Windows Vista and Windows 7) → Run, and then enter D:\setup.exe (where D is the 
drive letter of your CD), and then click OK.

� For Installing PS Driver

1 Insert the PostScript Driver Library CD into your computer.

� For Installing XML Paper Specification (XPS) Print Driver

1 Extract the zip file in the following path to your desired location.

D:\Eng\XPS (where D is the CD drive letter)
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 USB Connection Setup

NOTE: 

� A personal printer is a printer attached to your computer or a print server using a USB. If your printer is attached to a network 
and not your computer, see "Network Connection Setup" on page 89.

� For Installing PCL 6 and Fax Driver

1 On the top screen of Easy Install Navi, click Installing Driver and Software.

2 Click Print/Fax Driver. 

3 Click Connect via USB.

4 Follow the procedures described in the Help to install the print driver.

� For Installing PS Driver
For information on how to install the PS driver, refer to the PostScript User Guide.

� For Installing XML Paper Specification (XPS) Print Driver

NOTE: 

� XML Paper Specification (XPS) driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit 
Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 
64-bit Edition.

Windows Vista or Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 86.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box displayed under the 
Printer name.

11 Click Next.

Installation starts.

If the User Account Control dialog box appears, click Continue.

NOTE: 

� If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

12 As the driver installation is completed, click Print a test page to print a test page.

13 Click Finish.
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Windows Server 2008 or Windows Server 2008 64-bit Edition

NOTE: 

� You must log in as an administrator.

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 86.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

11 Click Next.

Installation starts.

12 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find and use it.

13 Click Next.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer.

If the User Account Control dialog box appears, click Yes.

NOTE: 

� If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 86.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.
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10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

11 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.

 Network Connection Setup

NOTE: 

� To use this printer in a Linux environment, you need to install a Linux driver. For more information on how to install and use 
these, see also "Installing Print Driver on Computers Running Linux (CUPS)" on page 104.

� For Installing PCL 6 and Fax Driver

1 On the top screen of Easy Install Navi, click Installing Driver and Software.

2 Click Print/Fax Driver. 

3 Select Standard or Custom setup.

4 Follow the on-screen instructions to install the print driver.

� For Installing PS Driver

For information on how to install the PS driver, refer to the PostScript User Guide.
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� For Installing XML Paper Specification (XPS) Print Driver

NOTE: 

� XML Paper Specification (XPS) driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit 
Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 
64-bit Edition.

Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Continue.

NOTE: 

� If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 86.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.

Installation starts.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.
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Windows Server 2008 and Windows Server 2008 64-bit Edition

NOTE: 

� You must log in as an administrator.

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Continue.

NOTE: 

� If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 86.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.

Installation starts.

14 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 

printer so that others on your network can find and use it.

15 Click Next.

16 As the driver installation is completed, click Print a test page to print a test page.

17 Click Finish.
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Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

NOTE: 

� When you click The printer that I want isn't listed, Find a printer by name or TCP/IP address screen appears. Find 
your printer on the screen.

If the User Account Control dialog box appears, click Continue.

NOTE: 

� If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 86.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 

printer so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.
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Windows 7 and Windows 7 64-bit Edition

1 Click Start → Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Yes.

NOTE: 

� If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 86.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

13 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 

printer so that others on your network can find and use it.

14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box.

16 As the driver installation is completed, click Print a test page to print a test page.

17 Click Finish.

Use CentreWare Internet Services to monitor the status of your network printer without leaving your desk. You can 
view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering replacement 
consumables. You can click our web site link for ordering supplies.

NOTE: 

� CentreWare Internet Services is not available when the printer is directly connected to a computer or a print server.

To launch CentreWare Internet Services, type the printer's IP address in your web browser. The printer configuration 
appears on the screen.
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 Setting Up for Shared Printing
You can share your new printer on the network using the Driver CD Kit that comes with your printer, or using 
Microsoft peer-to-peer method. However, if you use the Microsoft method, some features, such as the 
SimpleMonitor and other printer utilities, installed with the Driver CD Kit, may not be available.

If you want to use the printer on a network, share the printer and install its drivers on all the computers on the 
network.

� For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 

and Windows Server 2003 64-bit Edition

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon and select Properties.

3 On the Sharing tab, select the Share this printer radio button, and then enter a name in Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

If you are missing files, you are prompted to insert the server operating system CD.

6 Click Apply, and then click OK.

� For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change sharing options.

The message Windows needs your permission to continue appears.

4 Click Continue.

5 Select the Share this printer check box, and then enter a name in Share name.

6 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

7 Click OK.

8 Click Apply, and then click OK.

� For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon and select Sharing.

3 Select the Share this printer check box, and then enter a name in Share name.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

6 Click Apply, and then click OK.
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� For Windows 7, Windows 7 64-bit Edition, and 

Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

6 Click Apply, and then click OK.

To confirm that the printer is properly shared:

� Ensure that the printer object in the Printers, Printers and Faxes or Devices and Printers folder is shared. 
The shared icon is shown under the printer icon.

� Browse Network or My Network Places. Find the host name of the server and the shared name you assigned 
to the printer.

Now that the printer is shared, you can install the printer on network clients using the peer-to-peer method.
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 Point and Print 
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This feature 
automatically downloads and installs the print driver.

� For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 

and Windows Server 2003 64-bit Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers and Faxes folder. The copy time varies, based on network traffic and 
other factors.

4 Close My Network Places.

5 Print a test page to verify installation.

a Click start (Start for Windows Server 2003 and Windows Server 2003 64-bit Edition) → Printers and 

Faxes.

b Select the printer you just created.

c Click File → Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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� For Windows Vista and Windows Vista 64-bit Edition

1 On the Windows desktop of the client computer, click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in the User Account Control dialog box.

6 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers folder. The time this takes varies, based on network traffic and other 
factors.

7 Print a test page to verify installation.

a Click Start → Control Panel → Hardware and Sound.

b Select Printers.

c Right-click the printer you just created and click Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

� For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 On the Windows desktop of the client computer, click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers folder. The time this takes varies, based on network traffic and other 
factors.

6 Print a test page to verify installation.

a Click Start → Control Panel.

b Select Printers.

c Right-click the printer you just created and select Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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� For Windows 7, Windows 7 64-bit Edition, and Windows 

Server 2008 R2

1 On the Windows desktop of the client computer, click Start → your user name → Network (Start → Network 
for Windows Server 2008 R2).

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Devices and Printers folder. The time this takes varies, based on network 
traffic and other factors.

6 Print a test page to verify installation.

a Click Start → Devices and Printers.

b Right-click the printer you just created and select Printer properties.

c On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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 Peer-to-Peer 
If you use the peer-to-peer method, the print driver is fully installed on each client computer. Network clients retain 
control of driver modifications. The client computer handles the print job processing.

� For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 

and Windows Server 2003 64-bit Edition

1 Click start (Start for Windows Server 2003 / Windows Server 2003 64-bit Edition) → Printers and Faxes.

2 Click Add a printer (Add Printer for Windows Server 2003 / Windows Server 2003 64-bit Edition) to launch 
the Add Printer Wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Connect to this printer (or to browse for a printer, select this option and click Next).

b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it on the network. 

The shared printer name is the name assigned during the server installation process.

5 Click Browse for a printer, and then click Next.

6 Select the printer, and then click Next.

If this is a new printer, you may be prompted to install a print driver. 

If no system driver is available, you need to specify the path to available drivers.

7 Specify the following settings if you want, and then click Next.

If you want to verify installation, click Yes to print a test page.

� Click Yes to set this printer as the default printer.

� Click Yes to print a test page for verifying installation.

8 Click Finish.

When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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� For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it on the network. 

The shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you need to 
specify the path to available drivers.

4 Specify the following settings if you want, and then click Next.

� Click Yes to set this printer as the default printer.

� Click Print a test page to print a test page for verifying installation.

5 Click Finish.

When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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� For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path of the printer in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The shared 
printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you will 
need to provide a path to available drivers.

4 Specify the following settings if you want, and then click Next.

� Click Yes to set this printer as the default printer.

� Click Print a test page to print a test page for verifying installation.

5 Click Finish.

When a test page prints successfully, installation is complete.
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� For Windows 7, Windows 7 64-bit Edition, and 

Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name

b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it to the network. The shared printer 
name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you will 
need to provide the path to the available driver.

4 Confirm the printer name, and then click Next.

5 Specify the following settings if you want, and then click Finish.

� Click Set as the default printer to set this printer as the default printer.

� Click Print a test page to print a test page for verifying installation.

When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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Installing Print Driver on Computers Running 
Mac OS X

For information on how to install the print driver, refer to the PostScript User Guide.



104 Printer Connection and Software Installation

Installing Print Driver on Computers Running Linux 
(CUPS)

This section provides information for installing or setting up the print driver with CUPS (Common UNIX Printing 
System) on Red Hat® Enterprise Linux® 5/6 Desktop (x86) or SUSE® Linux Enterprise Desktop 10/11 (x86).

NOTE: 

� When using a CD drive in a Linux environment, you need to mount the CD according to your system environment. The 
command strings are mount/media/CD-ROM.

This section includes:

� "Installing the Print Driver" on page 104

� "Setting Up the Queue" on page 105

� "Setting the Default Queue" on page 106

� "Specifying the Printing Options" on page 107

� "Setting the Password for Authority as the Printer Administrator" on page 108

� "Uninstalling the Print Driver" on page 108

 Installing the Print Driver
This section includes:

� "For Red Hat Enterprise Linux 5/6 Desktop(x86)" on page 104

� "For SUSE Linux Enterprise Desktop 10/11 (x86)" on page 104

NOTE: 

� The print driver Fuji_Xerox-DocuPrint_M355-x.x-x.noarch.rpm is included in the linux folder in the Eng folder on the Driver 

CD Kit.

� For Red Hat Enterprise Linux 5/6 Desktop(x86)

The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Copy the .rpm file in the following path to your desired location.

D:\Eng\linux (where D is the CD drive letter)

2 Double-click the .rpm file.

3 Click Install.

4 Enter the administrator password, and click Authenticate.

Installation starts. When the installation is complete, the window is automatically closed.

� For SUSE Linux Enterprise Desktop 10/11 (x86)

The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Copy the .rpm file in the following path to your desired location.

D:\Eng\linux (where D is the CD drive letter)

2 Double-click the .rpm file.

3 Click Install.

4 Enter the administrator password, and click Authenticate.

Installation starts. When the installation is complete, the window is automatically closed.
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 Setting Up the Queue
To execute printing, you must set up the print queue on your workstation.

NOTE: 

� When you have finished setting up the queue, you can print jobs from the applications. Start the print job from the application, 
and specify the queue in the print dialog box. 
However, you may be able to print only from the default queue depending on the application. In these cases, before you start 
printing, set queue you want to print to as the default queue. For information on specifying the default queue, see also "Setting 
the Default Queue" on page 106.

� For Red Hat Enterprise Linux 5/6 Desktop (x86)

The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Add Printer.

4 Enter root as the user name, and then enter the administrator password.

5 Click OK.

6 Select either of the following according to the type of your printer connection.

For network connections:

a Select LPD/LPR Host or Printer from the Other Network Printers menu, and then click Continue.

b Enter the IP address of the printer in Connection. 

Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)

c Click Continue.

d Enter the name of the printer in Name in the Add Printer window, and then click Continue.

You can optionally specify the location and description of the printer for further information.

If you want to share the printer, select the Share This Printer check box.

For USB connections:

a Select FUJI XEROX DocuPrint XXX from the Local Printers menu, and then click Continue.

b Enter the name of the printer in Name in the Add Printer window, and then click Continue.

You can optionally specify the location and description of the printer for further information.

If you want to share the printer, select the Share This Printer check box.

7 Select FX from the Make menu, and then click Continue.

8 Select FX DocuPrint XXX from the Model menu, and then click Add Printer.

The setup is complete.

You can optionally specify the default options settings of the printer.

� For SUSE Linux Enterprise Desktop 10/11 (x86)

The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications..., and select YaST on Application Browser.

2 Enter the administrator password.

YaST Control Center is activated.
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3 Select Hardware on YaST Control Center, and select Printer.

The Printer Configurations dialog box opens.

For network connections:

a Click Add.

The Add New Printer Configuration dialog box opens.

b Click Connection Wizard.

The Connection Wizard dialog box opens.

c Select Line Printer Daemon (LPD) Protocol from Access Network Printer or Printserver Box via.

d Enter the IP address of the printer in IP Address or Host Name:.

e Select Fuji Xerox in Select the printer manufacturer:.

f Click OK.

The Add New Printer Configuration dialog box appears.

g Select DocuPrint XXX vx.x [FujiXerox/Fuji_Xerox_DocuPrint_XXX.ppd.gz] from the Assign Driver list.

NOTE: 

� You can specify the printer name in Set Name:.

For USB connections:

a Click Add.

The Add New Printer Configuration dialog box opens.

The printer name is displayed in the Determine Connection list.

b Select DocuPrint XXX vx.x. [FujiXerox/Fuji_Xerox_DocuPrint.ppd.gz] from the Assign Driver list.

NOTE: 

� You can specify the printer name in Set Name:.

4 Confirm the settings, and then click OK.

 Setting the Default Queue

� For Red Hat Enterprise Linux 5/6 Desktop (x86)

The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window.

� For SUSE Linux Enterprise Desktop 10/11 (x86)

The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications..., and select YaST on Application Browser.

2 Enter the administrator password.

YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.

The Printer Configurations dialog box opens.

su

(Enter the administrator password)

lpadmin -d (Enter the queue name)
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4 Click Edit.

A dialog box to modify the specified queue opens.

5 Confirm that the printer you want to set is selected in the Connection list.

6 Select the Default Printer check box.

7 Confirm the settings, and click OK.

 Specifying the Printing Options
You can specify the printing options such as the 2-sided printing.

� For Red Hat Enterprise Linux 5/6 Desktop (x86)

The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click the queue name for which you want to specify the printing options.

5 Enter root as the user name, and enter the administrator password.

6 Click the Administration drop-down list box, and then select Modify Printer.

7 Specify the required settings, and click Continue or Modify Printer.

The message Printer xxx has been modified successfully. appears.

The setting is complete. 

� For SUSE Linux Enterprise Desktop 10/11 (x86)

The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Open a web browser.

2 Enter http://localhost:631/admin in the address bar, and press the Enter key.

3 Enter root as the user name, and enter the administrator password.

The CUPS window appears.

NOTE: 

� Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to 
"Setting the Password for Authority as the Printer Administrator" on page 108.

4 Click Manage Printers.

5 Click Modify Printer on the printer.

6 Specify the required settings, and click Continue.

7 Enter root as the user name, enter administrator password and click OK.

The message Printer xxx has been modified successfully. appears.

The setting is complete. Execute printing from the application.
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 Setting the Password for Authority as the Printer 

Administrator
For SUSE Linux Enterprise Desktop 10 and 11, you must set the password for authority as the printer administrator 
to do operations as the printer administrator.

� For SUSE Linux Enterprise Desktop 10/11 (x86)

The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications... and select GNOME Terminal on Application Browser.

2 Enter the following command in the terminal window.

 Uninstalling the Print Driver

� For Red Hat Enterprise Linux 5/6 Desktop (x86)

The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

su

(Enter the administrator password)

lppasswd -g sys -a root

(Enter the password for authority as the printer 

administrator after the Enter password prompt.)

(Reenter the password for authority as the printer 

administrator after the Enter password again prompt.)

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

rpm -e Fuji_Xerox-DocuPrint_M355-x.x-x.noarch
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� For SUSE Linux Enterprise Desktop 10/11 (x86)

The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications... and select GNOME Terminal on Application Browser.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

rpm -e Fuji_Xerox-DocuPrint_M355-x.x-x
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Configuring Wireless Settings (Windows & Mac OS X)

This section includes:

� "Determining the Wireless Network Settings" on page 110

� "Configuring the Optional Wireless Printer Adapter" on page 111

� "Reconfiguring the Wireless Settings" on page 120

Determining the Wireless Network Settings

You need to know the settings for the wireless network to set up the wireless printer. For details of the settings, 
contact your network administrator.

Wireless Settings SSID Specifies the name that identifies the wireless network with up to 32 
alphanumeric characters.

Network Mode Specifies the network mode from Ad-hoc or Infrastructure.

Security Settings Security Selects the encryption method from No Security, Mixed mode PSK*, 
WPA-PSK-TKIP, WPA2-PSK-AES, and WEP.

Transmit Key Specifies the transmit WEP key from the list.

WEP Key Specifies the WEP key used through the wireless network only when 
WEP is selected as the encryption method.

Pass Phrase Specifies the pass phrase of alphanumeric characters from 8 to 63 
bytes long only when Mixed mode PSK*, WPA-PSK-TKIP, or 
WPA2-PSK-AES is selected as the encryption method.

* Mixed mode PSK automatically selects an available encryption method from WPA-PSK-TKIP, WPA-PSK-AES, or 
WPA2-PSK-AES.
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Configuring the Optional Wireless Printer Adapter

This section describes how to configure a wireless printer adapter through Easy Install Navi, operator panel and 
CentreWare Internet Services.

You can select a method to configure a wireless printer adapter from the following:

IMPORTANT: 

� Ensure that the Ethernet cable has been disconnected from the printer before you configure the wireless settings other than 
through Ethernet cable and CentreWare Internet Services.

NOTE: 

� Before you configure the wireless settings on the operator panel, you need to set up the wireless network settings on your 
computer. For details, refer to the manuals provided with the wireless LAN access point or if your computer provides a 
wireless adapter tool, configure the wireless settings using that tool.

� If the Panel Lock Set is set to Enable, you need to enter the four digit password to enter the Admin Menu menu.

Wizard Setup through
(Windows Only)

USB cable (recommended)

WPS-PBC*1

WPS-PIN*2

Operator Panel

Ethernet Cable

CentreWare Internet Services

Non-Wizard Setup through WPS-PBC*1

WPS-PIN*2

Operator Panel

CentreWare Internet Services

*1 WPS-PBC (Wi-Fi® Protected Setup-Push Button Configuration) is a method to authenticate and register devices 
required for wireless configuration, by pressing the button provided on the access point via wireless routers, and 
then performing WPS-PBC setting on the operator panel. This setting is available only when the access point 
supports WPS.

*2 WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register 
devices required for wireless configuration, by entering PIN assignments in the printer and computer. This setting, 
performed through access point, is available only when the access points of your wireless router supports WPS.
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� Using Wizard Setup to Configure a Wireless Printer Adapter (Windows 

Only)

You can configure the wireless printer adapter with the following connection methods:

� USB cable

� WPS-PBC

� WPS-PIN

� Operator Panel

� Ethernet Cable

� CentreWare Internet Services

The following procedure uses USB cable for connection method as an example.

1 Insert the Driver CD Kit provided with the printer in your computer. Easy Install Navi launches automatically.

2 Click Optional Accessories Setup.
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3 Click Wireless Network Kit b/g/n.

4 Click Start wireless settings.
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5 Click Wireless Configuration.

6 Select Wizard, and then click Next.
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7 Click Connect the wireless printer adapter.

The instruction video starts.

Follow the on-screen instructions to configure wireless settings.

� Using Non-Wizard Setup to Configure a Wireless Printer Adapter

For Mac OS X, you can configure a wireless settings only through non-wizard setup.

NOTE: 

� The optional wireless printer adapter must be installed on the printer. For details about installing a wireless printer adapter, 
see "Installing the Optional Wireless Printer Adapter" on page 58.

You can configure the wireless printer adapter with the following connection methods:

� WPS-PBC

� WPS-PIN

� Operator Panel

� CentreWare Internet Services



116 Printer Connection and Software Installation

WPS-PBC

You can start Push Button Control only from the operator panel.

NOTE: 

� WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for 
wireless configuration by pressing the button provided on the access point via wireless routers, and then performing 
WPS-PBC setting on the operator panel. This setting is available only when the access point supports WPS.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select WPS Setup, and then press the  button.

5 Select Push Button Control, and then press the  button.

6 Select Start, and then press the  button.

7 Ensure that the message Please wait Wireless Setting is displayed, and start pressing the button on 
the wireless LAN access point, within two minutes of the step 7 operation.

NOTE: 

� For details about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN 
access point.

When the WPS operation is successful and the printer is rebooted, wireless settings are correctly configured.

WPS-PIN

The PIN code of WPS-PIN can only be configured from the operator panel.

NOTE: 

� WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required 
for wireless configuration by entering PIN assignments to a printer and computer. This setting, performed through an access 
point, is available only when the access points of your wireless router supports WPS.

� Before WPS-PIN starts, you will need to enter your PIN code at the web page of the wireless LAN access point. For details, 
refer to the manuals provided with the wireless LAN access point.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select WPS Setup, and then press the  button.

5 Select PIN Code, and then press the  button.

6 Write down the displayed 8-digit PIN code or select Print PIN Code, and then press the  button. The PIN 
code is printed.

7 Select Start Configuration, and then press the  button.

8 Ensure that the message Please wait Wireless Setting is displayed, and enter the PIN code displayed 
on step 7 into the web page of the wireless LAN access point.

NOTE: 

� For details about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN 
access point.

When the WPS operation is successful and the printer is rebooted, wireless settings are correctly configured.
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Operator Panel

Auto SSID Setup

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select Wireless Setup, and then press the  button.

The printer automatically searches the access points on wireless network.

5 Select the desired access point, and then press the  button.

If the desired access point does not appear, go to "Manual SSID Setup" on page 117.

NOTE: 

� Some hidden SSID may not be displayed. If the SSID is not detected, turn on SSID broadcast from the router.

6 Enter the WEP key or pass phrase, and then press the  button.

The This Setting Becomes Effective after Restart message appears.

7 Turn off the printer, and turn it on again to apply the settings.

Wireless settings are correctly configured.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

Manual SSID Setup

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select Wireless Setup, and then press the  button.

5 Select Manual Setup, and then press the  button.

6 Enter the SSID, and then press the  button.

7 Select the network mode from Infrastructure or Ad-hoc depending on your environment, and then press 
the  button.

When you select Infrastructure, proceed to step 8.

When you select Ad-hoc, proceed to step 9.

8 Select the encryption method from Mixed mode PSK, WPA-PSK-TKIP, WPA2-PSK-AES, or WEP, and then 
press the  button.

IMPORTANT: 

� Be sure to use one of the supported encryption methods to protect your network traffic.

To use Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES encryption:

a Select the desired encryption method.

b Enter the pass phrase, and then press the  button.

The This Setting Becomes Effective after Restart message appears.

To use WEP encryption:

a Select WEP for the encryption method, and then press the  button.
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b Enter the WEP key, and then press the  button.

c Select the desired transmit key from Auto or WEP Key 1 to WEP Key 4, and then press the  button.

The This Setting Becomes Effective after Restart message appears.

Proceed to step 12.

9 Select WEP for the encryption method, and then press the  button.

IMPORTANT: 

� Be sure to use one of the supported encryption methods to protect your network traffic.

10 Enter the WEP key, and then press the  button.

11 Select the desired transmit key from WEP Key 1 to WEP Key 4, and then press the  button.

The This Setting Becomes Effective after Restart message appears.

12 Turn off the printer, and turn it on again to apply the settings.

Wireless settings are correctly configured.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.
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CentreWare Internet Services

1 Ensure that the printer is turned off and the wireless printer adapter is connected to the printer.

2 Connect the printer to the network with an Ethernet cable.

For details about connecting the Ethernet cable, see "Connecting Printer to Computer or Network" on page 78.

3 Turn on the printer.

4 Launch the CentreWare Internet Services by entering the IP address of the printer in your web browser.

5 Click the Properties tab.

6 Click Wireless.

7 Enter the SSID in the SSID text box.

8 Select Ad hoc or Infrastructure in the Network Type drop-down menu.

9 Select the encryption method from WEP 128-bit HEX (26 Bytes), WEP 128-bit ASCII (13 Bytes), WEP 64-bit 

HEX (10 Bytes), WEP 64-bit ASCII (5 Bytes), WPA-PSK AES/WPA2-PSK AES, WPA-PSK TKIP, and Mixed 

Mode PSK in the Encryption drop-down menu, and then set each item for the encryption method selected.

IMPORTANT: 

� Be sure to use one of the supported encryption methods to protect your network traffic.

NOTE: 

� For details on each item, see the Help on CentreWare Internet Services.

10 Click Apply to apply the settings.

11 Turn off the printer, disconnect the Ethernet cable and turn it on again.

Wireless LAN connection setting is complete.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.
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Reconfiguring the Wireless Settings

To change the wireless setting through the wireless connection from your computer, perform the following.

NOTE: 

� Ensure that the wireless connection setting is completed in "Configuring the Optional Wireless Printer Adapter" on page 111.

� The following settings are available when the network mode is set to infrastructure in "Configuring the Optional Wireless 
Printer Adapter" on page 111.

1 Check the IP address of the printer.

a On the operator panel, press the  (System) button.

b Select Report / List, and then press the  button.

c Select System Settings, and then press the  button.

The System Settings page is printed.

d Confirm the IP address next to IP Address under Network (Wireless) on the System Settings page.

2 Launch the CentreWare Internet Services by entering the IP address of the printer in your web browser.

3 Click the Properties tab.

4 Click Wireless.

5 Change the wireless settings of the printer.

6 Click Apply to apply the settings.

7 Reboot the printer.

8 Change the wireless settings on your computer or access point accordingly.

NOTE: 

� To change the wireless settings on your computer, refer to the manuals provided with the wireless LAN access point or if your 
computer provides a wireless adapter tool, change the wireless settings using that tool.
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5
Printing Basics

This chapter includes:

� "About Print Media" on page 122

� "Supported Print Media" on page 125

� "Loading Print Media" on page 131

� "Setting Paper Sizes and Types" on page 141

� "Printing" on page 142

� "Printing With Web Services on Devices (WSD)" on page 160
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About Print Media

This section includes:

� "Print Media Usage Guidelines" on page 122

� "Print Media That Can Damage Your Printer" on page 123

� "Print Media Storage Guidelines" on page 123

� "Duplex Automatic Document Feeder (DADF) Guidelines" on page 124

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or printer failure. 
To achieve the best performance from your printer, we recommend you to use only the paper described in this 
section.

When using paper other than that recommended, contact the Fuji Xerox local representative office or an authorised 
dealer.

 Print Media Usage Guidelines
The printer tray accommodates various sizes and types of paper and other specialty media. Follow these guidelines 
when loading paper and media in the tray:

� Envelopes can be printed from the bypass tray and standard 250 sheet tray.

� Fan paper or other specialty media before loading in the paper tray.

� Do not print on label stock once a label has been removed from a sheet.

� Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with release strips.

� Print all envelopes single-sided only. 

� Some wrinkling and embossing may occur when printing envelopes.

� Do not overload the paper tray. Do not load print media above the fill line on the inside of the width guides.

� Adjust the width guides to fit the paper size.

� If excessive jams or wrinkles occur, use paper or other media from a new package.

See also: 

� "Loading Print Media in the Standard 250 Sheet Tray and the Optional 250 Sheet Feeder" on page 132

� "Loading Print Media in the Bypass Tray" on page 135

� "Loading Envelope in the Bypass Tray" on page 139

� "Printing on Custom Size Paper" on page 156

WARNING:

� Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam 

occurs, it may cause short-circuit and eventually a fire accident.
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 Print Media That Can Damage Your Printer
The following paper types are not recommended for use with the printer:

� Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, 
carbonless copy paper (CCP), or no carbon required (NCR) paper.

� Preprinted paper with chemicals that may contaminate the printer.

� Preprinted paper that can be affected by the temperature in the fusing unit.

� Preprinted paper that requires a registration (the precise print location on the page) greater than ±0.09 inches, 
such as optical character recognition (OCR) forms.
In some cases, you can adjust registration with your software program to successfully print on these forms.

� Coated paper (erasable bond), synthetic paper, thermal paper, and short grain paper.

� Rough-edged, rough or heavily textured surface paper, or curled paper.

� Recycled paper containing more than 25% post-consumer waste that does not meet DIN 19 309.

� Multiple-part forms or documents.

� Print quality may deteriorate (blank spaces or blotches may appear in the text) when you print on talc or acid 
paper.

 Print Media Storage Guidelines
For proper print media storage, the following guidelines will help to avoid media feeding problems and uneven print 
quality.

� Store print media in an environment where the temperature is approximately 70 °F/21 °C and the relative 
humidity is 40%.

� Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to damage from 
ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and fluorescent bulbs, is particularly 
damaging to paper items. The intensity and length of exposure to visible light on paper items should be 
reduced as much as possible.

� Maintain constant temperatures and relative humidity.

� Avoid attics, kitchens, garages, and basements for storing print media. 

� Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.

� Avoid having food or drinks in the area where print media is stored or handled.

� Do not open sealed packages of paper until you are ready to load them into the printer. Leave paper in the 
original packaging. For most commercial cut-size grades, the ream wrapper contains an inner lining that 
protects the paper from moisture loss or gain.

� Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag and reseal it for 
protection. Some specialty media is packaged inside resealable plastic bags.

� Do not place anything on top of the print media packages.

WARNING:

� Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam 

occurs, it may cause short-circuit and eventually a fire accident.
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 Duplex Automatic Document Feeder (DADF) Guidelines
The DADF accommodates the following original sizes:

� Width: 139.7–215.9 mm (5.5–8.5 inches)

� Length: 139.7–355.6 mm (5.5–14 inches)

The weight range includes:

� Simplex: 50–125 gsm

� Duplex: 60–125 gsm

Follow these guidelines when loading original documents into the DADF:

� Load documents face up so that the top of the document enters the printer first.

� Place only loose sheets of paper in the DADF.

� Adjust the document guides so that they fit against the documents.

� Insert paper in the document feeder tray only when the ink on the paper is completely dry.

� Do not load documents above the MAX fill line. You can load up to 50 sheets of 64 gsm documents.

NOTE: 

� You cannot load the following documents in the DADF. Be sure to place them on the document glass.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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Supported Print Media

Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to your printer. To 
use the features of this printer effectively, use the suggested print media that is recommended here.

IMPORTANT: 

� The toner may come off the print media, if it gets wet by water, rain, steam and so on. For details, contact the Fuji Xerox local 
representative office or an authorised dealer.

 Usable Print Media
The types of print media that can be used on this printer are as follows:

Bypass Tray

*:XML Paper Specification (XPS) driver does not support custom size paper.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Com 10 Envelope SEF (4.125 × 9.5 inches)

Monarch Envelope SEF (3.875 × 7.5 inches)

DL Envelope SEF (110 × 220 mm)

C5 Envelope SEF (162 × 229 mm)

Custom size*:

Width: 76.2–215.9 mm (3–8.5 inches)

Length: 127–355.6 mm (5 –14 inches)

Custom size (duplex print)*:

Width: 139.7–215.9 mm (5.5–8.5 inches)

Length: 210–355.6 mm (8.27–14 inches)

Paper Type Plain Thick

Plain

Lightweight Cardstock

Heavyweight Cardstock

Hole Punched

Labels

Envelope

Letterhead

Colored

Other Type

Loading Capacity 50 sheets of standard paper
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Standard 250 Sheet Tray

*:XML Paper Specification (XPS) driver does not support custom size paper.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Custom size*:

Width: 139.7–215.9 mm (5.5–8.5 inches)

Length: 210–355.6 mm (8.27–14 inches)

Paper Type Plain Thick

Plain

Lightweight Cardstock

Heavyweight Cardstock

Hole Punched

Labels

Letterhead

Colored

Other Type

Loading Capacity 250 sheets of standard paper
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Optional 250 Sheet Feeder

*:XML Paper Specification (XPS) driver does not support custom size paper.

NOTE: 

� SEF and LEF indicate the paper feed direction; SEF stands for short-edge feed. LEF stands for long-edge feed.

� For Plain paper, you can set the paper density by selecting Adjust PaperType (Lightweight or Heavyweight) 
under Maintenance from the operator panel. Once you set the Adjust PaperType settings, the printer uses the 
settings for Plain paper.

See also: 

� "Loading Print Media in the Standard 250 Sheet Tray and the Optional 250 Sheet Feeder" on page 132

� "Loading Letterhead in the Standard 250 Sheet Tray and the Optional 250 Sheet Feeder" on page 134

� "Loading Print Media in the Bypass Tray" on page 135

� "Loading Small Print Media in the Bypass Tray" on page 137

� "Loading Envelope in the Bypass Tray" on page 139

� "Loading Letterhead in the Bypass Tray" on page 140

Printing on print media that differs from the paper size or paper type selected on the print driver, or loading print 
media into an unsuitable paper tray for printing, may lead to paper jams. To ensure that printing is correctly done, 
select the correct paper size, paper type, and paper tray.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Custom size*:

Width: 139.7–215.9 mm (5.5–8.5 inches)

Length: 210–355.6 mm (8.27–14 inches)

Paper Type Plain Thick

Plain

Lightweight Cardstock

Heavyweight Cardstock

Hole Punched

Labels

Letterhead

Colored

Other Type

Loading Capacity 250 sheets of standard paper
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 Standard Paper and Tested Paper
The following paper and media are standard or usable for the printer.

When you print a generally used paper (which called general paper), please use a paper that suits the standard. To 
print clearly, Fuji Xerox recommends the standard paper shown in the following table. For information about the 
other paper and media, contact Fuji Xerox Customer Support Center.

Paper Name Size Weight Paper Type Notes

Standard 
Paper

Fuji Xerox P A4 64 gsm Plain (Lightweight) Medium-thickness paper 
for in-house documents 
and general office use.

Xerox Premier 80 A4 80 gsm Plain (Heavyweight) Paper for general office 
use with minimum 
see-through.

XeroxBusiness4200 Letter 20 lb Plain (Heavyweight)

Supported 
Paper

XeroxBusiness4200 Legal 20 lb Plain (Heavyweight)

Boise X-9 Letter Plain (Heavyweight)

Hammermill Tidal MP Letter Plain (Heavyweight)

Cascade X-9000 Folio Plain (Heavyweight)

Cascade X-9000 Statement Plain (Heavyweight)

Xerox Color Xpressions 
Select

Legal 24 lb Plain (Heavyweight)

XeroxBusiness4200 Letter Plain (Heavyweight)

Hammermill Writing 
Bond

Letter Plain (Heavyweight)

Hammermill Laser Print Letter Plain (Heavyweight)

GP Laser1000 Executive Plain (Heavyweight)

Xerox Color Xpressions 
Elite

Letter 28 lb Plain (Heavyweight)

XeroxBusiness4200 Letter Plain (Heavyweight)

Fuji Xerox P B5 64 gsm Plain (Lightweight) Medium-thickness paper 
for in-house documents 
and general office use.

Fuji Xerox FR A4 64 gsm Plain (Lightweight) Environmentally-consciou
s paper (50% of pulp 
sourced from 
plantation-grown trees + 
50% of recycled pulp).

Fuji Xerox G70 A4 67 gsm Plain (Lightweight) Recycled copy/printer 
paper compounded 70% 
of recycled pulp.

Fuji Xerox GR100 Plain (Lightweight)

V-Paper Plain (Lightweight)

V-Paper MG Plain (Lightweight)

SG Plain (Lightweight)

Fuji Xerox C2 A4 70 gsm Plain (Lightweight)

Fuji Xerox C2r Plain (Lightweight) 70% recycled pulp paper.

Performer Plain (Heavyweight)

Express Plain (Heavyweight)

Business+ Plain (Heavyweight)

Fuji Xerox C2r B5 Plain (Lightweight)

Fuji Xerox C2 A5 Plain (Lightweight)



Printing Basics 129

Supported 
Paper

Performer+ A4 75 gsm Plain (Heavyweight)

A-paper Plain (Heavyweight)

A-paper Letter Plain (Heavyweight)

A-paper B5 Plain (Heavyweight)

Xerox Business 80 A4 80 gsm Plain (Heavyweight)

Business Plain (Heavyweight)

Business+ Plain (Heavyweight)

Data copy Plain (Heavyweight)

Steinbeis Recycling 
Copy

Plain (Heavyweight)

Yes Bronze Plain (Heavyweight)

Laserprint Plain (Heavyweight)

Performer Plain (Heavyweight)

Quality Plain (Heavyweight)

Performer+ Plain (Heavyweight)

H-paper Plain (Heavyweight)

H-paper B5 Plain (Heavyweight)

Xerox Premier 80 A5 Plain (Heavyweight)

Fuji Xerox J A4 82 gsm Plain (Heavyweight) Hi-quality paper suitable 
for a variety of uses, 
including project 
proposals and color 
samples.

Fuji Xerox J B5 Plain (Heavyweight)

Xerox Premier 90 A4 90 gsm Plain (Heavyweight)

Xerox-90 Colotech A4 Plain (Heavyweight)

Fuji Xerox JD A4 98 gsm Plain (Heavyweight) Double-sided paper 
suitable for a variety of 
uses, including brochures 
and booklet.

Fuji Xerox JD B5 Plain (Heavyweight)

Special 
Paper

(Label) A4 Label Labels

Labels(24/Page) A4 Labels

Labels A4 Labels

(Label) A4 Labels

Avery Labels 5165 Letter Labels

Colombia Brand Com-10 Envelope Envelope

PrintMaster White

Wove 24#

#Monarch

Monarch 
(98.4 × 
190.5)

Envelope

River Series DL (110 × 
220)

Envelope

River Series C5 (162 × 
229)

Envelope

Colotech+ A4 90 gsm Plain (Heavyweight)

Colotech+ (Mondi) A4 100 gsm Plain (Heavyweight)

Colotech+ Plain (Heavyweight)

Colotech+ (Mondi) A4 120 gsm Lightweight 
Cardstock

Colotech+ Lightweight 
Cardstock

Colotech+ (Mondi) A4 160 gsm Lightweight 
Cardstock

Paper Name Size Weight Paper Type Notes
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Special 
Paper

Color Copy200 A4 200 gsm Heavyweight 
Cardtstock

Xerox Color Xpressions 
Planet 20 80lb

Letter 216 gsm Heavyweight 
Cardtstock

Paper Name Size Weight Paper Type Notes
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Loading Print Media

Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading any print media, identify the recommended print side of the print media. This information is usually 
indicated on the print media package.

 Capacity
The standard 250 sheet tray and the optional 250 sheet feeder can hold:

� 250 sheets of the standard paper.

The bypass tray can hold:

� 50 sheets of the standard paper.

For special paper, there is a limitation of the following.

� From the bottom of the tray, up to 10 mm height (standard 250 sheet tray)

� From the bottom of the tray, up to 5.5 mm height (bypass tray)

 Print Media Dimensions
The maximum dimensions of print media that the standard 250 sheet tray and the optional 250 sheet feeder can 
handle are:

� Width: 139.7 mm (5.5 inches) to 215.9 mm (8.5 inches)

� Length: 210 mm (8.27 inches) to 355.6 mm (14 inches)

The maximum dimensions of print media that the bypass tray can handle are:

� Width: 76.2 mm (3 inches) to 215.9 mm (8.5 inches)

� Length: 127 mm (5 inches) to 355.6 mm (14 inches)
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 Loading Print Media in the Standard 250 Sheet Tray and 

the Optional 250 Sheet Feeder

NOTE: 

� To avoid paper jams, do not remove the tray while printing is in progress.

� Use only laser print media. Do not use ink jet print media in your printer.

1 Pull the tray out of the printer about 200 mm.

2 Hold the tray with both hands, and remove it from the printer.

3 Adjust the paper guides.

NOTE: 

� When loading Legal size or user-specified print media, slide the extendable part of the tray while pinching the lever.
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4 Before loading the print media, flex the sheets and fan them. Straighten the edges of the stack on a level 
surface.

5 Load the print media into the tray with the recommended print side facing up.

NOTE: 

� Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6 Align the width guides and length guide against the edges of the print media.

7 After confirming that the guides are securely adjusted, insert the tray into the printer.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or inside of the printer.

NOTE: 

� If the front side of the tray is extended, the tray protrudes when it is inserted into the printer.

8 On the operator panel, select the appropriate paper size, and then press the  button.

9 Select the appropriate paper type, and then press the  button.
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Loading Letterhead in the Standard 250 Sheet Tray and the 

Optional 250 Sheet Feeder

When you use the standard 250 sheet tray and the optional 250 sheet feeder, letterhead and hole punched paper 
must be inserted top edge first with the print side facing up.
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 Loading Print Media in the Bypass Tray

1 Gently pull open the bypass tray cover.

2 Slide the width guides to the edge of the tray. The width guides should be fully extended.

3 Insert all media face up and top edge first into the bypass tray.

NOTE: 

� Do not force the print media into the bypass tray.
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4 Slide both width guides until they rest lightly against the edge of the print media stack.

NOTE: 

� Do not force the print media into the bypass tray.

5 On the operator panel, select the appropriate paper size, and then press the  button.

NOTE: 

� If you use the driver setting, select Use Driver Settings.

6 Select the appropriate paper type, and then press the  button.
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Loading Small Print Media in the Bypass Tray

When loading small print media such as monarch envelope or the user-specified print media whose feed direction 
length is 191.6 mm or less in the bypass tray, remove the bypass tray from the printer.

1 Gently pull open the bypass tray cover.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Slide the width guides to the edge of the tray. The width guides should be fully extended.

4 Pull up the length guide and slide it toward the bypass tray cover until it stops.
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5 Load the print media into the bypass tray with the recommended print side facing up so that the top edge of the 
print media enters the printer first.

6 Align the paper guides against the edges of the print media.

7 Insert the bypass tray into the printer.

8 On the operator panel, select the appropriate paper size, and then press the  button.

NOTE: 

� If you use the driver setting, select Use Driver Settings.

9 Select the appropriate paper type, and then press the  button.
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Loading Envelope in the Bypass Tray

Use the following guidelines to load each size of envelopes in the bypass tray:

IMPORTANT: 

� Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can cause damage 
to the printer.

NOTE: 

� When five envelopes are set on the bypass tray, a misfeed may occur. If this happens, reduce the number of envelopes.

� If you do not load envelopes in the bypass tray right after they have been removed from the packaging, they may bulge. To 
avoid jams, flatten them as shown below before loading the envelopes in the bypass tray.

� Com 10/DL

Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps come at the 
right when you face towards the printer.

� Monarch

You need to pull up and slide the length guide. Load the envelopes short edge feed with the flaps closed and the 
print side up. Ensure that the flaps come at the right when you face towards the printer.

� C5

Load the envelopes short edge feed with the flaps open or closed and the print side up.

Ensure that the flaps come at the bottom with the flaps open or at the top with the flaps closed when you face 
towards the printer.

When you print with the orientation of the 1, position of the envelopes may be distorted on the output tray. In this 
case, set the orientation of the 2.

1 2
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Loading Letterhead in the Bypass Tray

When you use the bypass tray, letterhead and hole punched paper must be inserted top edge first with the print side 
facing up.

Using the Bypass Tray

� Load only one size and type of print media during a single print job.

� To achieve the best possible print quality, use only high-quality print media that is designed for use in laser 
printer. For more guidelines on print media, see "Print Media Usage Guidelines" on page 122.

� Do not add or remove print media when there is still print media in the bypass tray or when the printer is printing 
from the bypass tray. This may result in a paper jam.

� Print media should be loaded with the recommended print side up and the top of the print media going into the 
bypass tray first.

� Do not place objects on the bypass tray. Also, avoid pressing down or applying excessive force on it.

� The icons on the bypass tray show how to load the bypass tray with print media, and how to turn an envelope 
for printing.
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Setting Paper Sizes and Types

When loading print media in the tray, set the paper size and type on the operator panel before printing.

See also: 

� "Understanding the Printer Menus" on page 252

This section includes:

� "Setting Paper Sizes" on page 141

� "Setting Paper Types" on page 141

 Setting Paper Sizes

1 On the operator panel, press the  (System) button.

2 Select Tray Settings, and then press the  button.

3 Select the desired tray, and then press the  button.

NOTE: 

� When you select Bypass Tray, MPT Mode is set to Driver Specified by default. Select Panel Specified for 
MPT Mode to specify the paper size and type on the operator panel.

4 Select Paper Size, and then press the  button.

5 Select the correct paper size for the print media loaded, and then press the  button.

 Setting Paper Types

IMPORTANT: 

� Paper type settings must match those of the actual print media loaded in the tray or the feeder. Otherwise, print-quality 
problems can occur.

1 On the operator panel, press the  (System) button.

2 Select Tray Settings, and then press the  button.

3 Select the desired tray, and then press the  button.

NOTE: 

� When you select Bypass Tray, MPT Mode is set to Driver Specified by default. Select Panel Specified for 
MPT Mode to specify the paper size and type on the operator panel.

4 Select Paper Type, and then press the  button.

5 Select the correct paper type for the print media loaded, and then press the  button.
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Printing

This section covers how to print certain information from your printer and how to cancel a job.

This section includes:

� "Sending a Job to Print" on page 142

� "Canceling a Print Job" on page 143

� "Using the Stored Print Feature" on page 144

� "Direct Print Using the USB Storage Device" on page 146

� "Printing PDF Files Using PDF Bridge (Windows Only)" on page 147

� "Selecting Printing Options" on page 151

� "Printing Custom Size Paper" on page 154

� "Auditron" on page 157

� "Checking Status of Print Data" on page 158

� "Printing a Report Page" on page 158

� "Printer Settings" on page 159

 Sending a Job to Print
To support all of the printer features, use the print driver. When you choose Print from a software program, a window 
representing the print driver opens. Select the appropriate settings for the specific job that you are sending to print. 
Print settings selected from the driver override the default menu settings selected from the operator panel.

You may need to click Preferences from the initial Print box to see all of the available system settings you can 
change. If you are not familiar with a feature in the print driver window, open the Help for more information.

To print a job from a typical Microsoft® Windows® application:

1 Open the file you want to print.

2 From the application menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as appropriate (such as 
the pages you want to print or the number of copies).

4 Click Preferences to adjust system settings that are not available from the first screen, and then click OK. 

5 Click Print to send the job to the selected printer.
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 Canceling a Print Job
There are several methods for canceling a job.

This section includes:

� "Canceling a Job From the Operator Panel" on page 143

� "Canceling a Job From a Computer Running Windows" on page 143

Canceling a Job From the Operator Panel

To cancel a job after it has started printing:

1 Press the  (Stop) button.

OR

From Active Jobs, select Print, and then press the  (Stop) button.

Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From a Computer Running Windows

� Canceling a Job From the Taskbar

When you send a job to print, a small printer icon appears in the bottom right corner of the taskbar.

1 Double-click the printer icon. 

A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press Delete key on the keyboard.

4 Click Yes on the Printers dialog box to cancel a print job.

� Canceling a Job From the Desktop

1 Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server® 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista®).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears.

2 Double-click the printer that you selected when you sent the job for print.

A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press Delete key on the keyboard.

5 Click Yes on the Printers dialog box to cancel a print job.
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 Using the Stored Print Feature
When you send a job to the printer, you can specify in the print driver to store the job in the memory. When you are 
ready to print the job, go to the printer and use the operator panel menus to identify which job in the memory you 
want to print.

NOTE: 

� The stored print feature is available when:

- The optional 512MB memory is installed.

- The RAM disk is enabled in the operator panel menu.

- RAM Disk is set to Installed in the print driver.

� The data in memory is cleared when the printer is turned off.

The stored print feature includes the following job types:

� "Secure Print" on page 144

� "Sample Print" on page 144

Secure Print

You can store print jobs secured with a passcode in the memory. Users with the passcode can print them from the 
operator panel. This feature can be used to print confidential documents. You can select whether to delete the stored 
job after printing. Otherwise, the stored jobs remain in the memory until you delete them from the operator panel or 
turn off the printer.

NOTE: 

� Secure Print is available when you use the PCL 6 or PS driver.

Sample Print

The collated print job is stored in the memory, but a single copy is printed automatically so you can check the print 
result. If you do not have problems with the print result, you can choose to print more copies. This prevents large 
number of misprinted copies from being printed at one time.

NOTE: 

� Sample Print is available when you use the PCL 6 or PS driver.

Send confidential data.

Enter the passcode from 
the operator panel.

Print data.

Confidential

Send data.

One set is 
printed.

Check if the print result 
is OK.

Print the rest of sets 
from the operator panel.
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Procedures for Printing Stored Print

The following are procedures for storing and printing jobs.

� Storing Print Jobs
For Secure Print, select Secure Print for Job Type and specify the user ID, passcode and job name by clicking 
Setup in the Paper/Output tab of the print driver. When you send the job to the printer, the job will be stored in the 
memory until you request to print it from the operator panel or turn off the printer.

For Sample Print, select Sample Set for Job Type and specify the user ID and job name by clicking Setup in the 
Paper/Output tab of the print driver. When you send the job to the printer, the first set is printed. The remaining 
copies will be stored in the memory until you select to print them on the operator panel or turn off the printer.

NOTE: 

� If a print job is too large for the memory available, the printer may display error messages.

� If a document name is not assigned to your print job in the print driver, the job's name will be identified using the printer's time 
and date of submission to distinguish it from other jobs you have stored under your name.

� Printing the Stored Jobs
Once jobs are stored, you can use the operator panel to specify printing. Select the job type you are using from 
Secure Print and Sample Print. Then, select your user ID from a list. Secure Print requires the passcode you 
specified in the driver when you sent the job. 

To print the stored documents, use the procedure below.

1 Press the  (Printer) button.

2 Select Secure Print or Sample Print, and then press the  button.

3 Select your user ID, and then press the  button.

If you select Secure Print, go to step 4.

If you select Sample Print, go to step 5.

4 Enter the passcode you specified in the print driver, and then press the  button.

For details about specifying the passcode, see "Specifying Your Passcode on the Operator Panel (Secure 
Print)" on page 145.

5 Select the document you want to print, and then press the  button.

6 Select Print and Delete or Print and Save, and then press the  button.

7 Specify the number of copies to be printed using the number pad or the  and  buttons, and then press the 
 button.

The stored document will be printed.

� Specifying Your Passcode on the Operator Panel (Secure Print)
When you select your user ID for Secure Print, a screen to enter the passcode appears.

Use the buttons on the operator panel to enter the numeric passcode you specified in the print driver. The passcode 
you entered will be displayed as asterisks (*******) to ensure confidentiality.

If you enter an invalid passcode, the message Wrong password Re-enter appears. Wait three seconds, or press 
the  button to return to the screen to enter the passcode.

When you enter a valid passcode, you have access to all print jobs matching the user name and passcode you 
entered. The print jobs matching the passcode you entered appear on the screen. You can then choose to print or to 
delete jobs matching the passcode you entered. 

See also: 

� "Printing the Stored Jobs" on page 145

� Deleting Stored Jobs
A job that has been stored will be deleted after printing if selected to do so on the operator panel. Otherwise, the job 
remains stored until you delete them on the operator panel or turn off the printer.
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 Direct Print Using the USB Storage Device
The Print from USB Memory feature allows you to print files stored in a USB storage device by operating from the 
operator panel.

IMPORTANT: 

� To prevent damage to your printer, DO NOT connect any device other than USB storage device to the front USB port of the 
printer.

� DO NOT remove the USB storage device from the front USB port until the printer has finished printing.

NOTE: 

� If the Service Lock setting for USB Direct Print is set to Password Locked, you need to enter the four digit 
password to use the Print from USB Memory feature. If the Service Lock setting for USB Direct Print is set to Locked, 
the Print from USB Memory feature is disabled. For details, see "Service Lock" on page 289.

The front USB port of the printer is designed for USB 2.0 devices. You must use only an authorised USB storage 
device with an A plug type connector. Use only a metal shielded USB storage device.

To print a file in a USB storage device:

1 Insert a USB storage device to the front USB port of the printer.

2 Select Print from USB Memory, and then press the  button.

3 Select the desired file, and then press the  button.

NOTE: 

� Only the following characters are displayed on the operator panel:
a b c d e f g h i j k l m n o p q r s t u v w x y z A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
 0 1 2 3 4 5 6 7 8 9 $ % ’ ‘ - @ {} ~ ! # ( ) & _ ^

4 Select printing options as required.

5 Press the  (Start) button to begin printing.

NOTE: 

� You can print files scanned and stored using the Scan to USB Memory feature. Files saved without using the feature 
such as files created by user may not be printed properly.

IMPORTANT: 

� Before removing the USB storage device, ensure that the printer is not accessing the USB storage device. If you remove the 
USB storage device while the printer is accessing, the data in the USB storage device or the USB storage device itself may be 
destroyed.

Supported File Formats
Files in the following file formats can be printed directly from a USB storage device. (About what you saved in Scan 
to USB function of this printer. Other than that is not guaranteed.)

� PDF

� TIFF

� JPEG

A plug type
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 Printing PDF Files Using PDF Bridge (Windows Only)
The printer has the PDF Bridge feature, which enables you to print PDF files directly without a print driver. Printing 
PDF files without a print driver is much easier and faster when compared to printing with a print driver. This section 
describes how to print PDF files using PDF Bridge.

This section includes:

� "Supported PDF Files" on page 147

� "Using the ContentsBridge Utility" on page 147

� "Using the Commands" on page 147

Supported PDF Files

PDF files created on the following versions of Adobe® Acrobat® can be printed using PDF Bridge.

� Adobe Acrobat 5.X (excluding some of the features added to PDF1.4)

� Adobe Acrobat 6.X (excluding some of the features added to PDF1.5)

� Adobe Acrobat 7.X (excluding some of the features added to PDF1.6)

NOTE: 

� Some PDF files cannot be printed depending on how they are created. In such case, open the files and print them using a 
print driver.

Using the ContentsBridge Utility

The ContentsBridge Utility is software that enables direct printing of PDF files by simply dragging and dropping files 
onto the icon. To use the ContentsBridge Utility, refer to the manual included on the Driver CD Kit.

Using the Commands

You can also print PDF files using the lpr or ftp command. When you print using these commands, the following PDF 
settings on the operator panel become effective.

� Quantity

� 2-Sided Print

� Print Mode

� PDF Password

� Collated

� Output Size

� Layout

NOTE: 

� When you print using the lpr command, the print quantity must be set also using lpr command. In such case, the Quantity 
setting on the operator panel becomes invalid. If you do not specify the quantity using the lpr command, the printer recognizes 
the quantity as "1 set".

� To print PDF files using the lpr or ftp command, you must enable the printer's LPD or FTP port using the operator panel or 
CentreWare Internet Services (default: Enable).
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Using the lpr command

NOTE: 

� For Windows Vista or later, enable the lpr command first. The following procedure uses Windows 7 as an example.

a Click Start → Control Panel → Programs → Turn Windows features on or off.

b In the Windows Features dialog box, select the LPR Port Monitor check box under Print and Document 

Services.

In the command prompt, enter the lpr command as described in the following example:

Example: Printing "event.pdf" when the printer's IP address is 192.168.1.100.

Using the ftp command

In the command prompt, enter the ftp command as described in the following example:

Example: Printing "event.pdf" when the printer's IP address is 192.168.1.100.

C:\> lpr -S 192.168.1.100 -P lp event.pdf

C:\> ftp 192.168.1.100

Connected to 192.168.1.100.

220 FUJI XEROX DocuPrint XXXX

User (192.168.1.100:(none)):

331 Password required

Password:

230 Logged in

ftp> bin

200 Command successful

ftp> put event.pdf

200 Command successful

150 Opening data connection

226 Transfer complete

ftp: xxxxx bytes sent in xxxSeconds xxxxxkbytes/sec.

ftp>
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 Duplex Printing
Duplex printing (or 2-sided printing) allows you to print on both sides of a sheet of paper. A4, A5, B5, Letter, Folio, 
Legal and Executive paper sizes are acceptable.

This section includes:

� "Using 2-Sided Print" on page 149

� "Using Booklet Print" on page 150

Using 2-Sided Print

The following procedure uses the PCL 6 driver as an example.

1 Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the printer and select Printing preferences.

The Paper/Output tab appears.

3 From the drop-down menu of Paper, select Select By Tray and then select Automatically Select, Tray 1, 
Tray 2, or Bypass Tray.
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4 From 2-Sided Print, select 2-Sided Print or 2-Sided Print, Flip on Short Edge.

5 Click OK.

Using Booklet Print

To use the Booklet Print feature, select the Booklet Layout check box in the Layout/Watermark tab of the printer's 
Printing Preferences dialog box. Click Booklet Creation for detailed settings. The binding position is automatically 
set to 2-Sided Print for 2-Sided Print in the Paper/Output tab.

NOTE: 

� When the XML Paper Specification (XPS) driver or the PS driver is used, the Booklet Print feature is not available.

� For details on the 2-Sided Print option, see "2-Sided Print" on page 150.

2-Sided Print Assumes binding along the long edge of the page (left edge for portrait orientation and top edge for 
landscape orientation). The following illustration shows long-edge binding for portrait and landscape 
pages:

2-Sided Print, 

Flip on Short 

Edge

Assumes binding along the short edge of the page (top edge for portrait orientation and left edge for 
landscape orientation). The following illustration shows short-edge binding for portrait and landscape 
pages:

Portrait Landscape

Portrait Landscape
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 Selecting Printing Options
This section includes:

� "Selecting Printing Preferences (Windows)" on page 151

� "Selecting Options for an Individual Job (Windows)" on page 151

� "Selecting Options for an Individual Job (Mac OS X)" on page 153

Selecting Printing Preferences (Windows)

Printer Preferences control all of your print jobs, unless you override them specifically for a job. For example, if you 
want to use duplex printing for most jobs, set this option in Printing Preferences.

To select Printing Preferences:

1 Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing preferences.

The printer's Printing Preferences screen appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 

� For more information about Windows print driver options, click Help on the print driver tab to view the help.

Selecting Options for an Individual Job (Windows)

If you want to use special printing options for a particular job, change the driver settings before sending the job to the 
printer. For example, if you want to use Photo print-quality mode for a particular graphic, select this setting in the 
driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select your printer and click Preferences to open the print driver.

3 Make selections on the driver tabs.

NOTE: 

� When using the PCL 6 or PS driver, you can save current printing options with a distinctive name and apply them to other 
print jobs. Select either the Paper/Output, Image Options, Layout/Watermark, or Advanced tab, and then click 
Save under Saved Settings on the Paper/Output tab. Click Help for more information.

4 Click OK to save your selections.

5 Print the job.
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See the following table for specific printing options:

The table shown below uses the PCL 6 driver as an example.

Printing Options for Windows

Driver Tab Printing Options

Paper/Output tab � Job Type

� 2-Sided Print

� Paper

– Size

– Type

– Select By Tray

– Advanced Paper Selection

– Covers/Separators

� Output

� Saved Settings

� Envelope/Paper Setup Wizard

� Status

� Defaults

� Default All

Image Options tab � Image Quality

� Image Settings

� Application Reduce/Enlarge

� Toner Saver

� Margins

� Screen

� Image Shift Summary

� Tone Balance

� Defaults

Layout/Watermark tab � Page Layout

– Pages Per Sheet (N-Up)

– Poster

– Booklet Layout

� Page Layout Options

� Background Form

� Watermark

� Annotation

� Defaults

Advanced tab � Advanced Settings

� Document Options

– Specify Font

– Paper/Output

– Image Options

– Layout/Watermark

– Others

� About

� Defaults
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Selecting Options for an Individual Job (Mac OS X)

To select print settings for a particular job, change the driver settings before sending the job to the printer.

1 With the document open in your application, click File, and then click Print.

2 Select your printer from Printer.

3 Select the desired printing options from the menus and drop-down list boxes that are displayed.

NOTE: 

� In Mac OS® X, click Save As on the Presets menu to save the current printer settings. You can create multiple presets 
and save each with its own distinctive name and printer settings. To print jobs using specific printer settings, click the 
applicable saved preset in the Presets menu.

4 Click Print to print the job.

Mac OS X Print Driver Printing Options:

The table shown below uses Mac OS X 10.6 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options

� Copies

� Collated

� Two-Sided

� Pages

� Paper Size

� Orientation

Layout � Pages per Sheet

� Layout Direction

� Border

� Two-Sided

� Reverse page orientation

� Flip horizontally

Paper Handling � Pages to Print

� Page Order

� Scale to fit paper size

� Destination Paper Size

� Scale down only

Paper Feed � All pages From

� First Page From

� Remaining From

Cover Page � Print Cover Page

� Cover Page Type

� Billing Info

Scheduler � Print Document

� Priority

Job Accounting � Account Mode

� User Details Setup

Job Type � Job Type

� Setup

� Defaults
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 Printing Custom Size Paper
This section explains how to print on custom size paper using the print driver.

The way to load custom size paper is the same as the one to load standard size paper.

NOTE: 

� You can use custom size paper between the following ranges:

� For the standard 250 sheet tray, the optional 250 sheet feeder, and the bypass tray (duplex print)

- Width: 139.7 mm (5.5 inches) to 215.9 mm (8.5 inches)

- Length: 210 mm (8.27 inches) to 355.6 mm (14 inches)

� For the bypass tray

- Width: 76.2 mm (3 inches) to 215.9 mm (8.5 inches)

- Length: 127 mm (5 inches) to 355.6 mm (14 inches)

� XML Paper Specification (XPS) driver does not support custom size paper.

See also: 

� "Loading Print Media in the Standard 250 Sheet Tray and the Optional 250 Sheet Feeder" on page 132

� "Loading Print Media in the Bypass Tray" on page 135

� "Setting Paper Sizes and Types" on page 141

Watermark � Watermark

– Edit

– Delete

– New

� Print on Page 1 only

� Defaults

Printer Features � Feature Sets: General

– Feed Orientation

– Paper Type

– Substitute Tray

– Custom Paper Auto Orientation

– Draft Mode

– Skip Blank Pages

– Halftone Screen Lock

– Image Quality

– Halftone

– Letterhead Duplex Mode

� Feature Sets: Color Balance K

– Low Density (K)

– Medium Density (K)

– High Density (K)

Summary

Item Printing Options
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Defining Custom Paper Sizes

Before printing, set the custom size on the print driver.

NOTE: 

� When setting the paper size on the print driver and the operator panel, be sure to specify the same size as the actual print 
media used. Setting the wrong size for printing can cause printer failure. This is especially true if you configure a bigger size 
when using a narrow width paper.

� Using the Windows Print Driver

On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section explains the 
procedure using Windows 7 and the PCL 6 driver as an example.

An administrator’s password only allows users with administrator rights to change the settings. Users without the 
rights of administrator can only view the contents.

1 Click Start → Devices and Printers.

2 Right-click the printer, and then select Printer properties.

3 Select the Device Settings tab.

4 Select Custom Paper Size and click Setup.

5 Select the Create a New Form check box.

6 Enter a name for the custom paper size in Name. Up to 31 characters can be used for the paper name.

7 Specify the values for Width and Length either by entering the number directly or using the up arrow and down 
arrow buttons.

The value for Width cannot be greater than that of Length, even if it is within the specified range.

NOTE: 

� You can switch the units by selecting either Millimeters or Inches under Units.

� If you do not want to share the custom paper size with other users, clear the Share it with Other Users check box.

8 Click Save.

9 If necessary, repeat steps 5 to 8 to define another custom size.

10 Click Close.

11 Click OK.
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Printing on Custom Size Paper

Use the following procedures to print using either the Windows or Mac OS X print drivers.

� Using the Windows Print Driver

To print on custom size paper using the PCL 6 driver as an example:

NOTE: 

� The way to display the printer Properties/Printing Preferences dialog box differs according to the application software. 
Refer to the manual of each application software.

1 From the application menu, select Print.

2 Select your printer and click Preferences.

3 Select the Paper/Output tab.

4 From the drop-down menu of Paper, select Advanced Paper Selection.

5 Select the desired paper tray from Paper Tray.

NOTE: 

� If you select Bypass Tray, Bypass Feed Orientation appears. Specify the orientation of the paper set on the bypass 
tray. 

6 Select the size of the original document from Original Document Size.

7 Specify Scale Options.

If you select the custom paper size from Original Document Size in step 6, select No Scaling and go to step 
9.

If you select the standard paper size from Original Document Size in step 6, select Automatically Scale and 
go to step 8.

8 Select the custom paper size from Output Paper Size.

9 Select the appropriate paper type from Paper Type.

10 Click OK twice.

11 Click Print in the Print dialog box to start printing.

� Using the Mac OS X Print Driver

This section explains the procedure using Mac OS X 10.6 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select your printer from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Paper Sizes window, click +.

A newly created setting “Untitled” is displayed in the list.



Printing Basics 157

5 Double-click "Untitled" and enter the name for the setting.

6 Enter the size of the original document in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 Make sure that the newly created paper size is chosen in Paper Size, and then click OK.

10 From the File menu, select Print.

11 Make sure that your printer is selected in Printer.

12 Click Print to start printing.

 Auditron
Auditron contains an authentication function that can set limits on what processes can be used, as well as an 
account management that can be used to control usage based on authentication.

The following illustration shows how the printer works with Auditron. 

NOTE: 

� You can configure the printer's Auditron settings with CentreWare Internet Services. For more information, refer to the online 
Help of CentreWare Internet Services.

� To print using Auditron, you need to set the print driver. For more information, refer to the Help of the driver.

Registered user A
Registered user B

Can print up to 
10,000 pages

Print account report

Normal user D System administrator C

Can print up to 9,000 
pages

Cannot print if not a 
registered user, or if the 
printed pages exceeds the 
limit

Reference account report 
for each registered user
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 Checking Status of Print Data
This section includes:

� "Checking Status (Windows Only)" on page 158

� "Checking Status in CentreWare Internet Services (Windows & Mac OS X)" on page 158

Checking Status (Windows Only)

Printer information and status can be checked with SimpleMonitor. By default, the Status Monitor window launches 
when printing and an error occurs. To display the Status Monitor window manually, double-click the SimpleMonitor 
printer icon  on the taskbar at the bottom right of the screen. From the displayed window, click the name of the 
desired printer listed.

For more information about SimpleMonitor, see Help: The following procedure uses Windows 7 as an example:

1 Click Start → All Programs.

2 Select Fuji Xerox.

3 Select SimpleMonitor for Asia-Pacific.

4 Select SimpleMonitor Help.

See also: 

� "SimpleMonitor (Windows Only)" on page 70

Checking Status in CentreWare Internet Services (Windows & Mac 

OS X)

You can check the status of the print job sent to the printer at the Jobs tab of CentreWare Internet Services.

See also: 

� "Printer Management Software" on page 67

 Printing a Report Page
You can print a various types of reports and lists. For details on each report and list, see "Report / List" on page 252.

Taking the System Settings page as an example, this section describes how to print a report page.

Printing a System Settings Page

To verify detailed printer settings, print a System Settings page. A printed System Settings page also allows you to 
verify whether or not options have been installed properly. 

See also: 

� "Understanding the Printer Menus" on page 252

1 Press the  (System) button.

2 Select Report / List, and then press the  button.

3 Select System Settings, and then press the  button.

The System Settings page is printed.
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 Printer Settings
You can select menu items and corresponding values from the operator panel.

When you first browse through the menus from the operator panel, you see a list of menu items.

The values displayed on the right of each menu item are the factory default and original system settings.

NOTE: 

� Factory defaults may vary for different regions.

When you select a new value from the operator panel, the value selected is highlighted and is displayed on the right 
of the menu item in the previous screen to identify it as the current user setting.

These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1 Press the  (System) button.

2 Select the desired menu, and then press the  button.

3 Select the desired menu or menu item, and then press the  button.

� If the selection is a menu, the menu is opened and the list of menu items appears.

� If the selection is a menu item, the list of setting values appears. (The current user default menu setting is 
highlighted.)

A value can be:

� A phrase or word to describe a setting

� A numerical value that can be changed

� An On or Off setting

4 Select the desired value, and then press the  button.

NOTE: 

� Some menu items require you to use the number pad to enter the value.

5 Press the  (Back) or  button to return to the previous menu.

To continue setting other items, select the desired menu. To quit setting new values, press the  (Back) 
button.

Driver settings may have precedence over the settings made on the operator panel.
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Printing With Web Services on Devices (WSD)

This section provides information for network printing with WSD, the new Microsoft protocol for Windows Vista, 
Windows Server 2008, Windows Server 2008 R2, and Windows 7.

NOTE: 

� WSD stands for Web Services on Devices.

This section includes:

� "Adding Roles of Print Services" on page 160

� "Printer Setup" on page 161

 Adding Roles of Print Services
When you use Windows Server 2008 or Windows Server 2008 R2, you need to add the roles of print services to the 
Windows Server 2008 or Windows Server 2008 R2 client.

� For Windows Server 2008:

1 Click Start → Administrative Tools → Server Manager.

2 Select Add Roles from the Action menu.

3 Select the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click 
Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

� For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Server Manager.

2 Select Add Roles from the Action menu.

3 Select the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, 
and then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.
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 Printer Setup
You can install your new printer on the network using the Driver CD Kit that shipped with your printer, or using 
Microsoft Windows’ Add Printer wizard. The following procedure uses the PCL 6 driver as an example.

Installing a Print Driver Using the Add Printer Wizard

1 Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for 
Windows Vista and Windows Server 2008).

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

NOTE: 

� In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/.

� If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. To enter the 
printer's IP address manually, follow the instructions below.
For Windows Server 2008 R2, to create a WSD printer, you must be a member of Administrators group.

1 Click The printer that I want isn't listed. 

2 Select Add a printer using a TCP/IP address or hostname and click Next. 

3 Select Web Services Device from Device type.

4 Enter the printer's IP address in Hostname or IP address and click Next.

� Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, perform one of the 
following:

- Establish the Internet connection so that Windows Update can scan your computer.

- Add the print driver to your computer.

5 If prompted, install the print driver on your computer. If you are prompted for an administrator password or 
confirmation, enter the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Configure the option settings and print a test page to verify print installation.

a Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for 
Windows Vista and Windows Server 2008).

b Right-click the printer you just created, and then click Printer properties (Properties for Windows Vista 
and Windows Server 2008).

On the Configuration tab, click Installable Options to configure the option settings, and then click Apply.

c On the General tab, click Print Test Page. When a test page prints successfully, installation is complete.
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6
Copying

NOTE: 

� If the Service Lock setting for Copy is set to Password Locked, you need to enter the four digit password to use the 
copy function. If the Service Lock setting for Copy is set to Locked, the copy function is disabled. For details, see "Service 
Lock" on page 289.

This chapter includes:

� "Loading Print Media for Copying" on page 164

� "Selecting Paper Tray" on page 165

� "Preparing a Document" on page 166

� "Making Copies From the Document Glass" on page 167

� "Making Copies From the DADF" on page 169

� "Setting Copy Options" on page 170

� "Changing the Default Settings" on page 178
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Loading Print Media for Copying

The instructions for loading print media are the same whether you are printing, faxing, or copying.

See also: 

� "Loading Print Media" on page 131
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Selecting Paper Tray

After loading the print media for copy output, select the desired paper tray to be used for the copy job.

To select the tray:

1 Press the (Copy) button.

2 Select Select Tray.

3 Select the desired tray, and then Press the  button.

You can select Bypass Tray, Tray1, or Tray2*.

* Tray2 is only available when the optional 250 sheet feeder is installed.
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Preparing a Document

You can use the document glass or the Duplex Automatic Document Feeder (DADF) to load an original document 
for copying, scanning, and sending a fax. You can load up to 50 sheets of 64 gsm documents for one job using the 
DADF or one sheet at a time using the document glass.

IMPORTANT: 

� Avoid loading documents that are smaller than 139.7 mm by 139.7 mm (5.5 in. by 5.5 in.) or larger than 215.9 mm by 355.6 
mm (8.5 in. by 14 in.), different sizes or weights together, or booklets, pamphlets, transparencies, or documents having other 
unusual characteristics in the DADF.

� Carbon-paper or carbon-backed paper, coated paper, onion skin or thin paper, wrinkled or creased paper, curled or rolled 
paper, torn paper, photographs, or transparencies cannot be used in the DADF.

� Do not use the documents with staples, paper clips or exposed to adhesives or solvent based materials such as glue, ink and 
correcting fluid in the DADF.

NOTE: 

� To get the best scan quality, especially for gray scale images, use the document glass instead of the DADF.
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Making Copies From the Document Glass

NOTE: 

� A computer connection is not required for copying.

� Remove any documents from the DADF before copying from the document glass.

� Contaminants on the document glass may cause black spots on the copy output. For best results, clean the document glass 
before use. For more information, see also "Cleaning the Scanner" on page 376.

To make a copy from the document glass:

1 Lift and open the document cover. 

2 Place the document face down on the document glass and align it with the registration guide on the top left 
corner of the glass.

CAUTION:

� Do not apply excessive force to hold thick document on the document glass. It may break the glass and 

cause injuries.
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3 Close the document cover. To simply make a copy without changing the default copy settings, proceed to step 
6.

IMPORTANT: 

� Leaving the document cover open while copying may affect the copy quality and increase the toner consumption.

NOTE: 

� If you are copying a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close 
the cover. If the book or magazine is thicker than 30 mm, start copying with the document cover open.

4 Customize the copy settings including copy size, contrast, and image quality.

See also: 

� "Setting Copy Options" on page 170

To clear the option settings, press the CA (Clear All) button.

NOTE: 

� The copy options automatically return to their default status after the auto clear timer is expired.

5 Enter the number of copies from 1 to 99 using the number pad.

6 Press the (Start) button to begin copying.

NOTE: 

� Press the (Stop) button to cancel a copy job at any time while scanning and printing a document.
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Making Copies From the DADF

IMPORTANT: 

� Do not load more than 50 sheets into the DADF or allow more than 50 sheets to be fed to the document output tray. The 
document output tray should be emptied before it exceeds 50 sheets or your original documents may be damaged. 

NOTE: 

� To get the best scan quality, especially for gray scale images, use the document glass instead of the DADF.

� A computer connection is not required for copying.

� You cannot load the following documents in the DADF. Be sure to place them on the document glass.

To make a copy from the DADF:

1 Load the documents face up on the DADF with top edge of the documents in first. Then adjust the document 
guides to the correct document size. To simply make a copy without changing the default copy settings, 
proceed to step 4.

NOTE: 

� Ensure that you use the document guides before copying a legal-size document.

2 Customize the copy settings including the copy size, contrast, and image quality. 

See also: 

� "Setting Copy Options" on page 170

To clear the settings, use the CA (Clear All) button.

NOTE: 

� The copy options automatically return to their default status after the auto clear timer is expired.

3 Enter the number of copies from 1 to 99 using the number pad.

4 Press the (Start) button to begin copying.

NOTE: 

� Press the (Stop) button to cancel a copy job at any time while scanning and printing a document.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper



170 Copying

Setting Copy Options

Set the following options for the current copy job before pressing the (Start) button to begin copying.

For details about making copies, see "Making Copies From the Document Glass" on page 167 and "Making Copies 
From the DADF" on page 169.

NOTE: 

� The copy options automatically return to their default status after the next copy is performed or the auto clear timer is expired.

This section includes:

� "ID Card Copy" on page 170

� "Select Tray" on page 171

� "Lighten/Darken" on page 171

� "2-Sided" on page 172

� "Auto Exposure" on page 172

� "Collated" on page 173

� "Sharpness" on page 173

� "Reduce/Enlarge" on page 174

� "Document Size" on page 175

� "Document Type" on page 175

� "N-Up" on page 176

� "Margin Top/Bottom" on page 177

� "Margin Left/Right" on page 177

� "Margin Middle" on page 177

 ID Card Copy
You can copy both sides of an ID card on one side of a single sheet of paper in its original size by selecting ID Card 
Copy on the operator panel. This feature helps to show both sides of an ID card in one page in its original size.

NOTE: 

� ID Card Copy is available only for the document glass.

1 Place an ID card face down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the Document Glass" on page 167.

2 Select ID Card Copy.

3 Select On.

4 Specify the copy settings below as required.

� Select Tray

� Lighten/Darken

� Auto Exposure

� Sharpness

For details, see "Setting Copy Options" on page 170.

5 Press the (Start) button to begin copying.

After the front side of the ID card is scanned, the display prompts you to turn over the card.

a To scan the back side of the ID card, select Yes and turn the ID card over.

Select Continue, and then press the  button.

b To finish copying, select No.
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 Select Tray
To select a tray.

1 Select Select Tray, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

NOTE: 

� Tray 2 is only available when the optional 250 sheet feeder is installed.

 Lighten/Darken
To adjust the contrast to make the copy lighter or darker than the original.

1 Select Lighten/Darken, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

Bypass Tray The paper is fed from the bypass tray.

Tray 1* The paper is fed from standard 250 sheet tray.

Tray 2 The paper is fed from optional 250 sheet feeder.

Lighter3 Works well with dark documents.

Lighter2

Lighter1

Normal* Works well with normal typed or printed documents.

Darker1 Works well with light documents or faint pencil markings.

Darker2

Darker3
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 2-Sided
To make duplex copies with the specified binding position.

1 Select 2-Sided, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

When you are using the document glass and it is set to 1->2-Sided or 2->2-Sided, the display prompts you 
for another page after pressing the (Start) button.

a If you want to place a new document, press the  button to select Yes, and then press the  button.

Another display prompts you for placing next page.

Replace the document with a new document.

Select Continue, and then press the  button.

b If you finish copying, select No.

NOTE: 

� When you use the DADF to copy both sides of a document, the printed position of the front and back of the document 
may differ if the size in the document size setting and the size of the document do not match. In this case, set Document 
Size to the same size as the document.

 Auto Exposure
To suppress the background of the original to enhance text on the copy.

1 Select Auto Exposure, and then press the  button.

2 Select On, and then press the  button.

1->1-Sided* Select 1-sided or 2-sided and specify binding position for the 2 sided copy.

1->2-Sided

2->1-Sided

2->2-Sided

1->2 Short Edge

2->1 Short Edge

2->2 Short Edge
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 Collated
To sort the copy output: For example, if you make two copies of three page documents, one complete three page 
document will be printed followed by the second complete document.

NOTE: 

� You can collate more pages when optional 512MB memory is installed.

1 Select Collated, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

When you are using the document glass and it is set to On, the display prompts you for another page. 

a If you want to place a new document, press the  button to select Yes, and then press the  button. 
Another display prompts you for placing next page.

Replace the document with a new document.
Select Continue, and then press the  button.

b If you finish copying, select No.

 Sharpness
To adjust the sharpness to make the copy image sharper or softer than the original.

1 Select Sharpness, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

Off Does not copy in collated order.

On Copies in collated order.

Auto* Only the documents loaded from DADF are copied in collated order.

Sharper Makes the copy image sharper than the original.

Normal* The clarity of the image is the same as the original.

Softer Makes the copy image softer than the original.
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 Reduce/Enlarge
To reduce or enlarge the size of a copied image from 25 to 400% when you copy original documents from the 
document glass or the DADF.

NOTE: 

� When you make a reduced copy, black lines may appear at the bottom of your copy.

1 Select Reduce/Enlarge, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

�mm series

�inch series

NOTE: 

� You can also specify the value in increments of 1% from 25 to 400 by pressing the  or  button or entering a value 
using the number pad. See the following table for specific zoom ratios.

The methods to load print media vary depending on the size and orientation of the print media. For details, see 
"Loading Print Media in the Standard 250 Sheet Tray and the Optional 250 Sheet Feeder" on page 132 or 
"Loading Print Media in the Bypass Tray" on page 135.

For print media that can be loaded, see "About Print Media" on page 122.

200%

141% A5 → A4

122% A5 → B5

100%*

81% B5 → A5

70% A4 → A5

50%

200%

154%

129% 8.5 x 11" → 8.5 x 14"

100%*

78% 8.5 x 14" → 8.5 x 11"

64%

50%

Copy

Original

A5 B5 A4

A5 100% 122% 141%

B5 81% 100% 115%

A4 70% 86% 100%
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 Document Size
To select the default document size.

1 Select Document Size, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

�mm series

�inch series

 Document Type
To select the copy image quality.

1 Select Document Type, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

Auto*

A4 (210 x 297 mm)

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")

Auto*

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

A4 (210 x 297 mm)

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Executive (7.25 x 10.5")

Text Used for documents with text.

Mixed* Used for documents with both text and photos.

Photo Used for documents with photos.
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 N-Up
To print two original images to fit onto one sheet of paper.

1 Select N-Up, and then press the  button.

2 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

When you are using the document glass and it is set to Auto or Manual, the display prompts you for another 
page.

a If you want to place a new document, press the  button to select Yes, and then press the  button.

Another display prompts you for placing next page.

Replace the document with a new document.
Select Continue, and then press the  button.

b If you finish copying, select No.

Off* Does not perform N-up printing.

Auto Automatically reduces the original pages to fit onto one sheet of paper.

Manual Prints the original pages onto the one sheet of paper in the size specified in 
Reduce/Enlarge.

Auto:
Automatically 
reduces the 
pages to fit in 
one page.

Manual:
Reduces the pages in 
the custom size 
depending on the 
setting of the 
Reduce/Enlarge menu.
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 Margin Top/Bottom
To specify the top and bottom margins of the copy.

1 Select Margin Top/Bottom, and then press the  button.

2 Press the  or  button or use the number pad to set the desired value, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

 Margin Left/Right
To specify the left and right margins of the copy.

1 Select Margin Left/Right, and then press the  button.

2 Press the  or  button or use the number pad to set the desired value, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

 Margin Middle
To specify the middle margin of the copy.

1 Select Margin Middle, and then press the  button.

2 Press the  or  button or use the number pad to set the desired value, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

4 mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50 mm/0.0-2.0 inch

4 mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50 mm/0.0-2.0 inch

0 mm*/0.0 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50 mm/0.0-2.0 inch
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Changing the Default Settings

The default settings of the Copy menu options including contrast and image quality can be set to the most frequently 
used modes. When you copy a document, the specified default settings are used unless they are changed by using 
the corresponding buttons on the operator panel.

To create your own default settings:

1 Press the (System) button.

2 Select Defaults Settings, and then press the  button.

3 Select Copy Defaults, and then press the  button.

4 Select the desired menu item, and then press the  button.

5 Select the desired setting or enter the value using the number pad, and then press the  button.

6 Repeat steps 4 and 5 as needed.

To return to the previous screen, press the  (Back) button.
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7
Scanning

NOTE: 

� If the Service Lock setting for a scan function (Scan to PC (USB), PC Scan, E-mail, Scan to Network, Scan to 
USB) is set to Password Locked, you need to enter the four digit password to use that scan function. If the Service Lock 
setting for a scan function is set to Locked, that scan function is disabled. For details, see "Service Lock" on page 289.

This chapter includes:

� "Scanning Overview" on page 180

� "Installing the Scan Driver" on page 181

� "Scanning to a Computer" on page 182

� "Using a Scanner on the Network" on page 187

� "Scanning to a USB Storage Device" on page 209

� "Sending an E-Mail with the Scanned Image" on page 211

� "Adjusting Scanning Options" on page 214

� "Scanner Connection Tool" on page 217
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Scanning Overview

You can use your printer to turn pictures and text into editable images on your computer. 

The printer provides several ways to scan your document. There are two main scanning types. One is operated on 
the printer side without using the scan driver, and the other is operated on the computer side using a software and 
the scan driver. 

 Scanning - With scan driver
� Scan and send the scanned document to computer connected via USB cable

(Supporting USB connection for both Microsoft® Windows® and Mac OS® X using bundled software tool of 
Express Scan Manager)

Using the feature of "Scan to Application" on the operator panel of your printer, the scanned image is saved in 
the location of your computer specified with the Express Scan Manager.

See "Scanning From the Operator Panel - Scan to Application" on page 182.

� Scan into a graphic software such as Adobe® Photoshop® using a TWAIN driver

(Supporting USB and Network connections for both Windows and Mac OS X using a graphic software)

See "Scanning Using the TWAIN Driver" on page 184.

� Scan into a Microsoft’s default program such as Windows Photo Gallery and Microsoft Paint, using a Windows 
Image Acquisition (WIA) driver

(Supporting USB and Network (including WSD) connections on Windows only)

See "Scanning Using the WIA Driver" on page 185.

NOTE: 

� WSD stands for Web Services on Devices.

 Scanning - Without scan driver
� Scan and send the scanned document to a computer connected to a network using WSD

See "Scanning From the Operator Panel - WSD Scan" on page 183.

� Scan and send the scanned document to computer or server connected to network

See "Using a Scanner on the Network" on page 187.

� Scan and save the scanned document in a USB storage device

See "Scanning to a USB Storage Device" on page 209.

� Scan and send the scanned document by e-mail

See "Sending an E-Mail with the Scanned Image" on page 211.

The resolution setting to use when you scan an item depends on the item type and how you plan to use the image or 
document after you scan it into your computer. For the best results, use these recommended settings. 

Scanning beyond these recommended resolutions may exceed the capabilities of the application. If you require a 
resolution above those recommended in the above table, you should reduce the size of the image by previewing (or 
pre-scan) and cropping before scanning the image.

Type Resolution

Documents 300 dpi black-and-white or 200 dpi grayscale or color

Documents of poor quality or that contain small text 400 dpi black-and-white or 300 dpi grayscale

Photographs and pictures 100–200 dpi color or 200 dpi grayscale

Images for an inkjet printer 150–300 dpi

Images for a high-resolution printer 300–600 dpi
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Installing the Scan Driver

If you plan to import scanned images directly into an application (such as Adobe Photoshop or Microsoft Clip 
Organizer), or scan images directly to your computer, you must install a scan driver.

This section includes:

� "For Windows" on page 181

� "For Mac OS X" on page 181

 For Windows
To install the scan driver from the Driver CD Kit: 

1 Turn off the printer and the computer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

2 Connect the computer and your printer with a USB cable.

OR

Connect your printer to a network.

3 Insert the Driver CD Kit into your computer to start Easy Install Navi.

4 Click Installing Driver and Software.

5 Click the Main tab, and then select Scan Driver. 

6 Follow the on-screen instructions to install the scan driver.

For more information about scanning using USB connection, see "Express Scan Manager" on page 72.

 For Mac OS X
To install the scan driver from the Driver CD Kit: 

1 Run the Driver CD Kit on the Mac OS X.

2 Open the MacOSX folder under the Contents folder.

3 Double-click FX DocuPrint M355 df.dmg.

4 Follow the on-screen instructions to install the scan driver.

For more information about scanning using USB connection, see "Express Scan Manager" on page 72.
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Scanning to a Computer

This section includes:

� "Scanning From the Operator Panel - Scan to Application" on page 182

� "Scanning From the Operator Panel - WSD Scan" on page 183

� "Scanning Using the TWAIN Driver" on page 184

� "Scanning Using the WIA Driver" on page 185

 Scanning From the Operator Panel - Scan to Application
The following procedure uses Windows 7 as an example.

NOTE: 

� This feature cannot be used when the printer is connected to a network.

� Ensure that the printer is connected to the computer via the USB cable.

� This feature is supported on both Windows and Mac OS X.

1 Load the document(s) face up with top edge in first into the duplex automatic document feeder (DADF).

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Making Copies From the DADF" on page 169

� "Making Copies From the Document Glass" on page 167

2 Press the  (Scan) button.

3 Select Scan to Computer (USB), and then press the  button.

4 Configure the scanning settings as necessary.

5 Press the  (Start) button.

The selected application window opens on your computer.

NOTE: 

� If the following dialog box appears on your computer, select DocuPrint M355 df Express Scan Manager, and then click 
OK.

NOTE: 

� Once you select the Always use this program for this action check box when selecting DocuPrint M355 df Express Scan 

Manager, the selected application is automatically used without displaying the program selection window.

� You must use Express Scan Manager on your computer to change the settings for scanning. For details, see "Express Scan 
Manager" on page 72.

� For Mac OS X, the dialog box for selecting a program is not displayed.
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 Scanning From the Operator Panel - WSD Scan
If the printer is connected to a computer via network using WSD (Web Services on Devices), you can use the WSD 
Scan function to send scanned images to a computer.

The following procedure uses Windows 7 as an example.

NOTE: 

� To use WSD Scan, you need to set up connection using WSD.

� WSD is supported only on Windows Vista® and Windows 7.

Printer Setup for WSD Scan

Set up the printer and computer for connection using WSD.

� Checking the Printer Setting

To use the WSD Scan function, WSD Scan needs to be set to Enable. For details, see "Protocols" on page 266.

� Setting Up the Computer

For Windows 7:

1 Click Start → Computer → Network.

2 Right-click the icon for the printer, and then click Install. 

The printer is connected using WSD.

For Windows Vista:

1 Click Start → Network.

2 Right-click the icon for the printer, and then click Install.

3 Click Continue. 

The printer is connected using WSD.

Procedures for WSD Scan

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Making Copies From the DADF" on page 169

� "Making Copies From the Document Glass" on page 167

2 Press the  (Scan) button.

3 Select Scan to WSD, and then press the  button.

4 Specify the destination.

5 Press the  (Start) button to begin sending the scanned file.
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 Scanning Using the TWAIN Driver
Your printer supports the TWAIN driver for scanning images. The following procedure uses Windows 7 as an 
example.

NOTE: 

� Ensure that the printer is connected to the computer via the USB cable or to a network.

The following procedure to scan an image uses Microsoft  Clip Organizer as an example.

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Making Copies From the DADF" on page 169

� "Making Copies From the Document Glass" on page 167

2 Click Start → All Programs → Microsoft Office → Microsoft Office 2010 Tools → Microsoft Clip Organizer.

3 Click File → Add Clips to Organizer → From Scanner or Camera.

4 In the Insert Picture from Scanner or Camera dialog box, under Device, select your device.

5 Click Custom Insert.

6 Select your scanning preferences and click Preview to display the preview image.

NOTE: 

� Preview is grayed out and disabled when you select Document Feeder from Scan from.

� The illustration may vary for different operating systems.

7 Select the desired properties from the Image Quality and Image Options tabs.

8 Click Scan to start scanning.

The scanned image file is generated.



Scanning 185

 Scanning Using the WIA Driver
Your printer also supports the Windows Image Acquisition (WIA) driver for scanning images. WIA is one of the 
standard components provided by Windows XP and later operating systems and works with digital cameras and 
scanners. Unlike the TWAIN driver, the WIA driver allows you to scan an image and easily manipulate those images 
without using additional software.

NOTE: 

� Ensure that the printer is connected to the computer via the USB cable or to a network.

� The Windows Image Acquisition (WIA) driver is supported only on Windows.

To Scan an Image From the Drawing Software

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Making Copies From the DADF" on page 169

� "Making Copies From the Document Glass" on page 167

2 Start the drawing software, such as Paint for Windows.

NOTE: 

� When you use Windows Vista, use Windows Photo Gallery instead of Paint.

� When using applications that utilize WIA 2.0, such as Windows Fax and Scan on Windows Vista and Windows 7, the 
Feeder (Scan both sides) option can be selected for duplex (two-sided) scanning.

3 Click Paint button → From scanner or camera (Click File → From Scanner or Camera for Windows XP, 
Windows Server 2003, Windows Server 2008 and Windows Vista).

The Scan using FX DP M355 df (WIA - USB) window appears.

NOTE: 

� The illustration may vary for different operating systems.

4 Select Document Feeder or Flatbed in Paper source.

NOTE: 

� Select Document Feeder when you want to scan the document loaded in the DADF. Select Flatbed when you want to 
scan the document loaded on the document glass.
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5 Select your scanning preferences and click Adjust the quality of the scanned picture to display the 
Advanced Properties dialog box.

6 Select the desired properties including brightness and contrast, and then click OK.

7 Click Scan to start scanning.

8 Click Save from the Paint menu.

9 Enter a picture name, and select a file format and destination to save the picture.

To Scan an Image From Control Panel

NOTE: 

� This feature is supported on Windows Server 2003 and Windows XP only.

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Making Copies From the DADF" on page 169

� "Making Copies From the Document Glass" on page 167

2 Click start → Control Panel → Printers and Other Hardware → Scanners and Cameras.

3 Double-click the scanner icon. 

The Scanner and Camera Wizard launches.

4 Click Next to display the Choose Scanning Preferences page.

NOTE: 

� The screen image may vary depending on the operating system.

5 Select your desired type of picture, paper source, and paper size, and click Next.

6 Enter a picture name, select a file format, and specify the desired location to save the scanned document.

7 Click Next to start scanning.

8 Follow the on-screen instructions to edit the picture after it is copied to your computer.
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Using a Scanner on the Network

This section includes:

� "Overview" on page 188

� "Setting a Login Name and a Password (SMB Only)" on page 190

� "Creating a Shared Folder (SMB Only)" on page 192

� "Setting a Destination Using an Address Book" on page 201

� "Sending the Scanned File on the Network" on page 208

NOTE: 

� This feature does not require a network scan driver.
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 Overview
The Scan to Server/Computer feature allows you to scan documents and send the scanned document to a network 
computer via the FTP or SMB protocol. 

You can select the kind of server and specify a destination to store the scanned document with the CentreWare 
Internet Services or Address Book Editor.

The following items are required to use the Scan to Server/Computer feature.

� Using SMB

To transfer data via SMB, your computer must run on one of the following operating systems that includes 
folder sharing.

NOTE: 

� Windows Server 2003, Windows XP, Mac OS X 10.3/10.4/10.5 support IPv4 only.

� For Mac OS X, a shared user account is required.

� Windows Server 2003

� Windows Server 2008

� Windows Server 2008 R2

� Windows XP

� Windows Vista

� Windows 7

� Mac OS X 10.3/10.4/10.5/10.6

� Using FTP

To transfer data via FTP, one of the following FTP servers and an account to the FTP server (login name and 
password) are required.

NOTE: 

� Windows Server 2003, Windows XP, Windows Vista, Mac OS X 10.3/10.4/10.5 support IPv4 only.

� Windows XP

FTP service of Microsoft Internet Information Services 5.1

� Windows Server 2003

FTP service of Microsoft Internet Information Services 6.0

� Windows Vista, Windows Server 2008

FTP service of Microsoft Internet Information Services 7.0

� Windows 7, Windows Server 2008 R2

FTP service of Microsoft Internet Information Services 7.5

Scan

Using FTP

Using SMB

FTP Server

Computer

Computer
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� Mac OS X 10.3/10.4/10.5/10.6/10.7

FTP service of Mac OS X

For information on how to configure the FTP service, contact your system administrator.

Follow the procedure below to use the Scan to Server/Computer feature.

� For SMB:

� For FTP:

"Setting a Login Name and a Password (SMB Only)" on page 190

"Creating a Shared Folder (SMB Only)" on page 192

"Setting a Destination Using an Address Book" on page 201

"Sending the Scanned File on the Network" on page 208

"Setting a Destination Using an Address Book" on page 201

"Sending the Scanned File on the Network" on page 208
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 Setting a Login Name and a Password (SMB Only)
The Scan to Computer/Server feature requires a user login account with a valid and non-empty password for 
authentication. Confirm a login user name and password.

If you do not use a password for your user login, you need to create a password on your User Login Account with the 
following procedure.

� For Windows XP:

1 Click start → Control Panel → User Accounts.

2 Click Change an account.

3 Select your account.

4 Click Create a password and add in a password for your user login account.

� For Windows Server 2003:

1 Click Start → Administrative Tools → Computer Management.

2 Click Local Users and Groups.

3 Double-click Users.

4 Right-click your account, and then select Set Password.

NOTE: 

� When an alert message appears, confirm the message and then click Proceed.

5 Add in a password for your user login account.

� For Windows Vista and Windows 7:

1 Click Start → Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.
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� For Windows Server 2008:

1 Click Start → Administrative Tools → Computer Management.

2 Click Local Users and Groups.

3 Double-click Users.

4 Right-click your account, and then select Set Password.

NOTE: 

� When an alert message appears, confirm the message and then click Proceed.

5 Add in a password for your user login account.

� For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Computer Management.

2 Click Local Users and Groups.

3 Double-click Users.

4 Right-click your account, and then select Set Password.

NOTE: 

� When an alert message appears, confirm the message and then click Proceed.

5 Add in a password for your user login account.

� For Mac OS X 10.3:

1 Click System Preferences → Accounts.

2 Select your account.

3 Enter a password for your user login account in Password.

4 Re-enter the password in Verify.

� For Mac OS X 10.4/10.5/10.6:

1 Click System Preferences → Accounts.

2 Select your account.

3 Select Change Password.

4 Enter a password for your user login account in New Password (New password for Mac OS X 10.6).

5 Re-enter the password in Verify.

6 Click Change Password.

After you confirmed a login user name and password, go to "Creating a Shared Folder (SMB Only)" on page 192.
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 Creating a Shared Folder (SMB Only)
Share a folder to store the scanned document using the following procedure.

� For Windows XP Home Edition:

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Share this folder on the network.

4 Enter a shared name in the Share name box.

NOTE: 

� Write down this shared name because you will use this name in the next setting procedure.

NOTE: 

� When the following screen appears, click If you understand the security risks but want to share files without 

running the wizard, click here, then select Just enable file sharing, and then click OK.
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5 Select Allow network users to change my files.

6 Click Apply, and then click OK.

NOTE: 

� To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John

You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Setting a Destination Using an Address Book" on page 201.

� For Windows XP Professional Edition:

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare) and double-click 
the folder.

2 Select Folder Options from Tools.

3 Click the View tab, and then deselect the Use simple file sharing (Recommended) check box.
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4 Click OK, and then close the window.

5 Right-click the folder, and then select Properties.

6 Click the Sharing tab, and then select Share this folder.

7 Enter a shared name in the Share name box.

NOTE: 

� Write down this shared name because you will use this name in the next setting procedure.

8 Click Permissions to create a write permission for this folder.

9 Click Add.

10 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 

select box and click Check Names to confirm (Example of user login name: MySelf).
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11 Click OK.

12 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document into this folder.

NOTE: 

� Do not use Everyone as the user login name.

13 Click OK.

14 Click Apply, and then click OK.

NOTE: 

� To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John

You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Setting a Destination Using an Address Book" on page 201.
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� For Windows Server 2003

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Share this folder.

4 Enter a shared name in the Share name box.

NOTE: 

� Write down this shared name because you will use this name in the next setting procedure.

5 Click Permissions to create a write permission for this folder.

6 Click Add.

7 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 

select box and click Check Names to confirm (Example of user login name: MySelf).
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8 Click OK.

9 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document into this folder.

NOTE: 

� Do not use Everyone as the user login name.

10 Click OK.

11 Configure other settings as necessary, and then click Apply and click OK.

NOTE: 

� To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John

You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Setting a Destination Using an Address Book" on page 201.
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� For Windows Vista, Windows 7, Windows Server 2008, Windows 

Server 2008 R2

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then click Advanced Sharing.

For Windows Vista, when User Account Control dialog box appears, click Continue.

4 Select the Share this folder check box.

5 Enter a shared name in the Share name box.

NOTE: 

� Write down this shared name because you will use this name in the next setting procedure.
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6 Click Permissions to create a write permission for this folder.

7 Click Add.

8 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 

select box and click Check Names to confirm (Example of user login name: MySelf).

9 Click OK.

10 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document into this folder.

NOTE: 

� Do not use Everyone as the user login name.

11 Click OK.

12 Click OK to exit the Advanced Sharing dialog box.

13 Click Close.

NOTE: 

� To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John

You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Setting a Destination Using an Address Book" on page 201.
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� For Mac OS X 10.3/10.4:

1 Select Home from the Go menu.

2 Double-click Public.

3 Create a folder (Example of folder name: MyShare).

NOTE: 

� Write down this shared name because you will use this name in the next setting procedure.

4 Open System Preferences, and then click Sharing.

5 Select the Personal File Sharing check box and the Windows Sharing check box.

� For Mac OS X 10.5/10.6:

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

NOTE: 

� Write down this shared name because you will use this name in the next setting procedure.

2 Select the created folder, and then select Get Info from the File menu.

3 Select the Shared Folder (Shared folder for Mac OS X 10.6) check box, and then close the window.

4 Open System Preferences, and then click Sharing.

5 Select the File Sharing check box, and then click Options.

6 Select the Share Files and folders using SMB (Share files and folders using SMB (Windows) for Mac OS 
X 10.6) check box and your account name.

7 Enter your account password, and then click OK.

8 Click Done.
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 Setting a Destination Using an Address Book
You can configure the printer settings to use the Scan to Server/Computer feature with the CentreWare Internet 
Services or Address Book Editor.

The following procedure uses Windows 7 as an example.

Before beginning to setup a destination, make sure you have the IP addresses you need such as printer and 
computer.

Verifying the IP Address Setting of the Printer

To set up the server address book through the network, you will first need to locate the IP address of the printer. To 
find your printer's IP address, see "Verifying the IP Settings" on page 84.

Locating the IP Address Setting of Your Computer

You can locate the IP address of your computer by the following operations.

1 Click Start → All Programs → Accessories → Run. (for Windows Vista/Windows 7)

Click start → Run. (for Windows XP)

Click Start → Run. (for Windows Server 2003/Windows Server 2008/Windows Server 2008 R2)

2 Type cmd in the text field and click OK. A command prompt window will open.

3 Type ipconfig and press Enter.

4 Write down the IP Address xxx.xxx.xxx.xxx.

Using CentreWare Internet Services

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The printer's web page appears.

NOTE: 

� For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 84.
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3 Click the Address Book tab.

If user name and password are required, enter the correct user name and password.

NOTE: 

� The default user name is "11111", and the default password is "x-admin".

4 Under Network Scan (Comp./Serv.), click Computer/Server Address Book.

5 Select any unused number and click Add. 
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The Add Network Scan Address page appears.

To fill in the fields, enter the information as follows: 

1 Name Enter a friendly name that you want to appear on the Computer/Server Address 

Book.

2 Server Type Select Computer (SMB) if you store the document in a shared folder of your 
computer.

Select Server (FTP) if you use an FTP server.

3 Server Address Enter a server name or IP address of your computer or the FTP server that you 
have shared out.

The following are examples:

� For Computer (SMB):

Server name: myhost

IP address: 192.168.1.100

� For Server (FTP):

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address: 192.168.1.100

4 Server Port Number Enter the port number. If you are unsure, you can enter the default value of 139 for 
SMB and 21 for FTP.

5 Login Name Enter the user account name that has access to the shared folder on your computer 
or FTP server.

6 Login Password Enter the password corresponding to the above login name.

NOTE: 

� Empty password is not valid in the Scan to Computer feature. Ensure that you 
have a valid password for the user login account. (See "Setting a Login Name 
and a Password (SMB Only)" on page 190 for details on how to add a password 
in your user login account.)

7 Re-enter Password Re-enter your password.

1

2

3

4

5

6

7

8

9
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After you configured settings, go to "Sending the Scanned File on the Network" on page 208.

8 Share Name For Computer (SMB) only.

On the Windows operating system, enter the share name of the folder to store the 
scanned document on the recipient computer.

On the Mac OS X, enter the folder name to store the scanned document on the 
recipient computer.

9 Server Path For Computer (SMB)

To store the scanned document in the shared folder directly without creating any 
subfolder, leave the space blank.

To store the scanned document in the folder you created under the shared folder, 
enter the path as following.

Example: Share Folder name: MyShare, Second-level folder name: MyPic, 
Third-level folder name: John

You should now see MyShare\Mypic\John in your directory.

In this case, enter the following item.

Server Path: \MyPic\John

For Server (FTP)

Enter the server path to store the scanned document.

MyShare (Share folder)

MyPic

John
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Using Address Book Editor

The following procedure uses Windows 7 as an example.

1 Click Start → All Programs → Fuji Xerox → DocuPrint M355 df → Address Book Editor.

The Select Device window appears.

NOTE: 

� If the Address Book Editor window appears, go to step 4.

2 Select your printer from the list.

3 Click OK.

4 Click Tool → New (Printer Address Book) → Server.
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The Server Address dialog box appears.

To fill in the fields, enter the information as follows: 

1 Name Enter a friendly name that you want to appear on the address book.

2 Server Type Select Computer (SMB) if you store the document in a shared folder of your 
computer. 

Select Server (FTP) if you use an FTP server.

3 Computer Settings 

wizard

Clicking this button opens the wizard screen which guides you through several 
steps.

When you complete the steps in the wizard, the settings for Server Address are 
automatically configured. For details, click the Help button.

4 Server Name / IP 

Address

Enter a server name or IP address of your computer or the FTP server that you 
have shared out.

The following are examples:

� For Computer (SMB):

Server name: myhost

IP address: 192.168.1.100

� For Server (FTP):

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address: 192.168.1.100

5 Share Name Enter the name of the shared folder on the recipient computer. For SMB only.

3

9

10

8

7

6

5

4

2

1
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After you configured settings, go to "Sending the Scanned File on the Network" on page 208.

6 Path For Computer (SMB)

To store the scanned document in the shared folder directly without creating any 
subfolder, leave the space blank.

To store the scanned document in the folder you created under the shared folder, 
enter the path as following.

Example: Share Folder name: MyShare, Second-level folder name: MyPic, 
Third-level folder name: John

You should now see MyShare\MyPic\John in your directory.

In this case, enter the following item.

Path: \MyPic\John

For Server (FTP)

Enter the path to store the scanned document.

7 Login Name Enter the user account name that has access to the shared folder on your computer 
or FTP server.

8 Login Password Enter the password corresponding to the above login name.

NOTE: 

� Empty password is not valid in the Scan to Computer feature. Ensure that you 
have a valid password for the user login account. (See "Setting a Login Name 
and a Password (SMB Only)" on page 190 for details on how to add a password 
in your user login account).

9 Confirm Login 

Password

Re-enter your password.

10 Port Number Enter the port number. If you are unsure, you can enter the default value of 139 for 
SMB and 21 for FTP.

MyShare (Share folder)

MyPic

John
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 Sending the Scanned File on the Network

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Making Copies From the DADF" on page 169

� "Making Copies From the Document Glass" on page 167

2 Press the  (Scan) button.

3 Select Scan to Network, and then press the  button.

4 Select Scan to, and then press the  button.

5 Select Computer (Network) or Server (FTP), or Search Address Book, and then press the  
button.

� Computer (Network): Stores the scanned image on the computer by using the SMB protocol.

� Server (FTP): Stores the scanned image on the server by using the FTP protocol.

� Search Address Book: Select the server address registered in Address Book.

6 Select the destination to store the scanned file in, and then press the  button.

7 Configure the scanning settings as necessary.

8 Press the  (Start) button to send the scanned files.
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Scanning to a USB Storage Device

 Types of a USB Storage Device
You can use a USB storage device with the following interfaces:

� USB 1.1

� USB 2.0

The USB storage device must be formatted in FAT file systems (FAT16, FAT32, or VFAT) before inserting the 
memory device into the front USB port of the printer.

NOTE: 

� If the USB storage device is formatted in a file system other than above, the printer may not recognize that the USB storage 
device is attached.

� A USB storage device with authentication feature and some brands of USB storage devices cannot be used with this printer.

 Procedures
To store the scanned images to a USB storage device:

NOTE: 

� If you insert a USB storage device to the front USB port first, the USB Memory screen may appear. In this case, select Scan 
to USB Memory, and proceed to step 5.

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Making Copies From the DADF" on page 169

� "Making Copies From the Document Glass" on page 167

2 Press the  (Scan) button.

3 Insert a USB storage device into the front USB port of the printer.

4 Select Scan to USBMemory, and then press the  button.

5 If you want to save the scanned data to a folder on the USB storage device, select the desired folder to save 
the scanned data, and then press the  button. 

NOTE: 

� The default saving location is the root directory of the USB storage device.

� You can select any folder in the USB storage device but cannot create a new folder in this step. You should always 
create a new folder before connecting the memory to the printer.
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6 Configure the scanning settings as necessary.

7 Press the  (Start) button to begin scanning the document.

8 Remove the USB storage device from the printer. 

IMPORTANT: 

� Before removing the USB storage device, ensure that the printer is not accessing the USB storage device. If you remove 
the USB storage device while the printer is accessing, the data in the USB storage device or the USB storage device 
itself may be destroyed.



Scanning 211

Sending an E-Mail with the Scanned Image

To send an e-mail attached with the scanned image from your printer, follow the steps below:

� Set up the E-mail address book through the CentreWare Internet Services. See "Registering a New E-Mail 
Address" on page 211 for more details.

 E-Mail Settings

1 From the CentreWare Internet Services, click Properties.

2 Click E-mail.

3 Specify the settings for E-mail as follows:

SMTP Server Address: Enter the IP address of the e-mail server.

E-Mail Send Authentication: Specify Invalid to enable the e-mail server.

NOTE: 

� If an error message including 016-506 or 016-764 is displayed, contact your server administrator for the settings for 
E-Mail Send Authentication.

4 Click the Apply button.

 Registering a New E-Mail Address
The following procedure uses Windows 7 as an example.

1 Launch your web browser. 

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The printer's web page appears.

NOTE: 

� For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 84.
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3 Click the Address Book tab.

If user name and password are required, enter the correct user name and password.

NOTE: 

� The default user name is "11111", and the default password is "x-admin".

4 Click Email Address Book.

5 Select any unused number and click Add.

The Add Email Address page appears.

6 Enter a name in the Name field and e-mail address in the E-mail Address field.

7 Click the Apply button.
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 Sending an E-mail with the Scanned File

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Making Copies From the DADF" on page 169

� "Making Copies From the Document Glass" on page 167

2 Press the  (Scan) button.

3 Select Scan to E-mail, and then press the  button.

4 Select Email to, and then press the  button.

5 Select the setting listed below, and then press the  button.

� Keypad: Enter the e-mail address directly and then press the  button.

� Address Book: Select the e-mail address registered in the E-mail address book, and then press the  
button.

� Email Group: Select the e-mail group registered in the E-mail Groups, and then press the  button.

� Search Local Address Book: Searches for an e-mail address from the local Address Book.

� Search Server Address Book: Searches for an e-mail address on the LDAP server. This item is 
displayed when Server Address Book in the System Settings menu is set to On.

NOTE: 

� Users need to be registered in the E-mail address book before you can select Address Book on the operator panel.

6 Configure the scanning settings as necessary.

7 Press the  (Start) button to send e-mail.
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Adjusting Scanning Options

This section includes:

� "Adjusting the Default Scan Settings" on page 214

� "Changing the Scan Settings for an Individual Job" on page 216

 Adjusting the Default Scan Settings
This section includes:

� "Setting the Scanned Image File Type" on page 214

� "Setting the Color Mode" on page 214

� "Setting the Scan Resolution" on page 215

� "Setting the Document Size" on page 215

� "Automatically Suppressing Background Variations" on page 215

For a complete list of all of the defaults settings, see "Defaults Settings" on page 291.

Setting the Scanned Image File Type

To specify the file type of the scanned image:

1 Press the  (System) button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select File Format, and then press the  button.

5 Select the type, and then press the  button.

Available types:

� PDF (factory default)

� MultiPageTIFF

� TIFF

� JPEG

� XDW

Setting the Color Mode

You can scan an image in color or in black and white. Selecting black and white significantly reduces the file size of 
the scanned images. An image scanned in color will have a larger file size than the same image scanned in black 
and white.

1 Press the  (System) button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select Color, and then press the  button.

5 Change the color setting to Black & White, Grayscale or Color, and then press the  button.
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Setting the Scan Resolution

You may want to change the scan resolution depending on the way you plan to use the scanned image. Scan 
resolution affects both the size and image quality of the scanned image file. The higher the scan resolution, the 
larger the file size.

To select the scan resolution:

1 Press the  (System) button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select Resolution, and then press the  button.

5 Select one of the following options, and then press the  button:

� 200 x 200 dpi: Produces the lowest resolution and smallest file size. (factory default)

� 300 x 300 dpi: Produces medium resolution and a medium file size.

� 400 x 400 dpi: Produces high resolution and a large file size.

� 600 x 600 dpi: Produces the highest resolution and largest file size.

NOTE: 

� If you are running on standard memory (less than 512 MB), the scanning resolution of color push scan (Scan to Email, 
Scan to FTP, Scan to SMB, Scan to USB Memory) and WSD Scan (any color mode) will be limited to 300 dpi.

Setting the Document Size

To specify the size of the original:

1 Press the  (System) button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select Document Size, and then press the  button.

5 Select a specific paper size to determine the area to be scanned, and then press the  button. 

The factory default setting is A4 (210 x 297 mm).

Automatically Suppressing Background Variations

When scanning documents with a dark background such as newspapers, the printer automatically can detect the 
background and whiten it when outputting the image.

To turn on/off automatic suppression:

1 Press the  (System) button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select Auto Exposure, and then press the  button.

5 Select either On or Off, and then press the  button.

The factory default setting is On.
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 Changing the Scan Settings for an Individual Job
To temporarily change a scan setting when emailing the scanned image:

1 Press the  (Scan) button.

2 Select Scan to E-mail, and then press the  button.

3 Press the  or  button to scroll through the menu of settings.

4 Change the selected setting, and then press the  button.

5 Press the  (Start) button to begin the scan.

To temporarily change a scan setting when scanning to a computer:

1 Press the  (Scan) button.

2 Select the scan destination, and then press the  button.

3 Press the  or  button to scroll through the menu of settings.

4 Change the selected setting, and then press the  button.

5 Press the  (Start) button to begin the scan.
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Scanner Connection Tool

You can check the IP address of the printer or set the password using the Scanner Connection Tool. The following 
procedure uses Windows 7 as an example.

To open the Scanner Connection Tool:

Click Start → All Programs → Fuji Xerox → DocuPrint M355 df → Scanner Connection Tool.

 IP Address Settings
In the IP Address Settings tab, you can check the IP address that is set for your scanner or change the scanner 
selection.

� IP Address

Enter the IP address.

� Search for all scanners on the network (Windows only)

Searches scanners in your network.

� Scanner List

Displays a list of scanners that are detected.

� Search again

Searches the scanners in your network. 

� Search Criteria (Windows only)

Displays the Search Criteria dialog box for setting the search condition.
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Search Criteria Dialog Box (Windows only)

� Broadcast address

Enter the subnet address.

� IPv4: Broadcast Address such as 192.168.1.255

� IPv6: Multicast Address such as ff02::1

� Search Time

Specify a time period for searching a scanner.

� Community Name

Enter the SNMPv1/v2 community name. The default community name is public.

 Password Settings
In the Password Settings tab, you can enter the password that is set for your scanner to access from your 
computer to the printer.

� Password for Scanner

Enter the password.



Faxing 219

8
Faxing

NOTE: 

� If the Service Lock setting for Fax is set to Password Locked, you need to enter the four digit password to use the fax 
function. If the Service Lock setting for Fax is set to Locked, the fax function is disabled. For details, see "Service Lock" 
on page 289.

� If the Panel Lock Set is set to Enable, you need to enter the four digit password to enter the Admin Menu menu.

This chapter includes:

� "Connecting the Telephone Line" on page 220

� "Configuring Fax Initial Settings" on page 221

� "Sending a Fax" on page 225

� "Sending a Delayed Fax" on page 231

� "Sending a Fax from the Driver (Direct Fax)" on page 232

� "Receiving a Fax" on page 235

� "Automatic Dialing" on page 238

� "Address Book" on page 242

� "Other Ways to Fax" on page 243

� "Setting Sounds" on page 245

� "Specifying the Fax Settings Options" on page 246

� "Changing Setting Options" on page 249

� "Printing a Report Page" on page 250
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Connecting the Telephone Line

NOTE: 

� Do not connect your printer directly to a DSL (digital subscriber line). This may damage the printer. To use a DSL, you will 
need to use an appropriate DSL filter. Contact your service provider for the DSL filter.

1 Plug one end of a telephone line cord into the wall jack connector and the other end into an active wall jack.

2 To connect a telephone and/or answering machine to your printer, plug the telephone or answering machine 
line cord into the phone connector ( ).

Wall jack connector

To the wall jack

Phone connector

To an external telephone or 
answering machine
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Configuring Fax Initial Settings

This section includes:

� "Specifying the Fax Initial Settings Using the Easy Install Navi (Windows Only)" on page 221

� "Specifying the Fax Initial Settings From the Operator Panel" on page 222

 Specifying the Fax Initial Settings Using the Easy Install 

Navi (Windows Only)
You can specify the region, line type, tone/pulse, receive mode, DRPD pattern, fax header name, and fax number.

1 Insert the Driver CD Kit provided with the printer in your computer. The Easy Install Navi file launches 
automatically.

2 Click Advanced Tools on the Easy Install Navi window. The Advanced Tools window appears.
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3 Click Fax Configuration.

4 Follow the instructions displayed on the screen.

Available settings are:

� Region

� Line Type

� Dial Type

� Receive Mode

� DRPD Pattern

(This setting is available only when a distinctive ring service is installed on your telephone line by your 
telephone company.)

� Company Name

� FAX Number

NOTE: 

� To make initial settings from the printer operator panel, see "Specifying the Fax Initial Settings From the Operator Panel" 
on page 222.

 Specifying the Fax Initial Settings From the Operator 

Panel

Setting Your Region

You need to set the region where your printer is used for using the fax service on the printer.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Region, and then press the  button.

5 Select the region where the printer is used, and then press the  button.

6 Select Start, and then press the  button.

The printer restarts automatically to apply the settings.

NOTE: 

� When you configure the region setting, the information registered to the device is initialized.
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Setting the Printer ID

In most countries, you are required by law to indicate your fax number on any fax you send. The printer ID, 
containing your telephone number and name or company name, will be printed at the top of each page sent from 
your printer.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Your Fax Number, and then press the  button.

5 Enter your fax number using the number pad.

NOTE: 

� If you make a mistake while entering numbers, press the C (Clear) button to delete the last digit.

6 Press the  button when the number on the display is correct.

7 Select Company Name, and then press the  button.

8 Enter your name or company name using the number pad.

You can enter alphanumeric characters using the number pad, including special symbols by pressing the 1, *, 
and # buttons simultaneously.

For details on how to use the number pad to enter alphanumeric characters, see "Using the Number Pad to 
Enter Characters" on page 314.

9 Press the  button when the name on the display is correct.

To return to the top level of the System menu, press the CA (Clear All) button.

Setting the Time and Date

NOTE: 

� It may be necessary to reset the correct time and date if loss of power to the printer occurs.

To set the time and date:

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Clock Settings, and then press the  button.

5 Select Set Date & Time, and then press the  button.

6 Select the desired time zone, and then press the  button.

7 Enter the correct date using the number pad, or select the correct date using the  or  button.

NOTE: 

� If you make a mistake while entering numbers, press the C (Clear) button to delete the last digit.

8 Press the  button when the date on the display is correct.

9 Enter the correct time using the number pad, or select the correct time using the  or  button.

10 Press the  button when the time on the display is correct.

To return to the top level of the System menu, press the CA (Clear All) button.
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Changing the Clock Mode

You can set the current time using either the 12-hour or the 24-hour format.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Clock Settings, and then press the  button.

5 Select Time Format, and then press the  button.

6 Select the desired format, and then press the  button.

To return to the top level of the System menu, press the CA (Clear All) button.
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Sending a Fax

You can fax data from your printer.

This section includes:

� "Loading an Original Document" on page 225

� "Adjusting the Document Resolution" on page 227

� "Adjusting the Document Contrast" on page 227

� "Inserting a Pause" on page 227

� "Sending a Fax From Memory" on page 228

� "Sending a Fax Manually" on page 229

� "Confirming Transmissions" on page 230

� "Automatic Redialing" on page 230

 Loading an Original Document
You can use the DADF or the document glass to load an original document for faxing.

To Fax a Document Using the DADF

Using the duplex automatic document feeder (DADF), you can load up to 50 sheets of 64 gsm paper at a time.

NOTE: 

� To get the best scan quality, especially for gray scale images, use the document glass instead of the DADF.

� You cannot load the following documents in the DADF. Be sure to place them on the document glass.

1 Place the document(s) face up on the DADF with the top edge of the documents in first. Then adjust the 
document guides to the correct document size.

2 Adjust the document resolution. 

See also: 

� "Adjusting the Document Resolution" on page 227

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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To Fax a Document From the Document Glass

Using the document glass, you can load one sheet at a time.

1 Lift and open the document cover.

2 Place the document face down on the document glass and align it with the registration guide on the top left 
corner of the document glass.

3 Close the document cover.

NOTE: 

� Ensure that no document is in the DADF. If any document is detected in the DADF, it takes priority over the document on 
the document glass. 

� If you are faxing a page from a book or magazine, lift the document cover until its hinges are caught by the stopper and 
then close the document cover. If the book or magazine is thicker than 30 mm, start faxing with the document cover 
open.

4 Adjust the document resolution. 

See also: 

� "Adjusting the Document Resolution" on page 227

CAUTION:

� Do not apply excessive force to hold thick document on the document glass. It may break the glass and 

cause injuries.
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 Adjusting the Document Resolution
You can improve the quality of the fax document by adjusting the resolution, especially for the document in 
low-quality or containing the photographic image.

1 Press the  (Fax) button.

2 Select Resolution, and then press the  button.

3 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

NOTE: 

� Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

 Adjusting the Document Contrast
You can adjust the contrast of the fax document to be lighter or darker than the original.

1 Press the  (Fax) button.

2 Select Lighten/Darken, and then press the  button.

3 Select the desired setting, and then press the  button.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

 Inserting a Pause
For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must 
be entered in order for the access code to function. For example, enter the access code 9 and then press the  
(Redial/Pause) button before entering the telephone number. "-" appears on the LCD panel to indicate when a 
pause is entered.

Standard* Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or documents 
printed using a dot-matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The Super Fine mode is 
enabled only if the remote machine also supports the Super Fine resolution. See the 
note below.

Photo Suitable for documents containing photographic images.

Lighter3 Works well with dark print.

Lighter2

Lighter1

Normal* Works well with standard typed or printed documents.

Darker1 Works well with light print or faint pencil markings.

Darker2

Darker3
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 Sending a Fax From Memory

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Loading an Original Document" on page 225

2 Press the  (Fax) button.

3 Adjust the document resolution to suit your fax needs.

See also: 

� "Adjusting the Document Resolution" on page 227

� "Adjusting the Document Contrast" on page 227

4 To select a fax number, do one of the followings:

� Select Fax to, and then press the  button. Select Phone Book, and then press the  button.

� Press the One Touch Dial buttons, and go to step 6.

You need to register a speed dial number before you can use the One Touch Dial buttons. (For details, see 
"Setting Speed Dial" on page 238.)

� Select Fax to, and then press the  (Address Book) button. Select one of the followings:

� Press the  (Redial/Pause) button to redial, and go to step 6.

� Press the  (Speed Dial) button. (For details, see "Sending a Fax Using Speed Dial" on page 239.)

5 Select the desired recipient, and then press the  button to select the recipients. Press the  button to 
confirm.

6 Press the  (Start) button.

When the document is placed on the document glass, the display prompts you for another page. Select Yes to 
add more documents or No to begin sending the fax immediately, and then press the  button.

The printer starts dialing the number, and then sending the fax when the remote fax machine is ready.

NOTE: 

� By pressing the  (Stop) button, you can cancel the fax job at any time while sending the fax.

All Entries Displays a list of registered fax numbers.

Group Dial Displays a list of registered group dial numbers.

Search Local Searches for a fax number from the local Phone Book.

Search Server Searches for a fax number on the LDAP server. This item is displayed when Server 
Phone Book in the System Settings menu is set to On.
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 Sending a Fax Manually

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Loading an Original Document" on page 225

2 Press the  (Fax) button.

3 Adjust the document resolution to suit your fax needs.

See also: 

� "Adjusting the Document Resolution" on page 227

� "Adjusting the Document Contrast" on page 227

4 Select OnHook, and then press the  button.

5 Select On, and then press the  button.

6 Enter the remote fax machine's fax number using the number pad.

You can also select the recipient by using speed dial number or address book.

See also: 

� "Automatic Redialing" on page 230

NOTE: 

� You can enter a fax number using the ten key, *, and #.

� Pressing the  (Redial/Pause) button enables you to enter a pause in the fax number.

� Entering "=" in the fax number enables dial tone detection.

� Entering ":" enables you to switch dialing type from dial pulse (DP) to push button (PB).

7 If the document is loaded in the DADF, press the  (Start) button.

If the document is not loaded in the DADF, press the  (Start) button, press the  or  button until the 
desired setting appears, and then press the  button.

NOTE: 

� By pressing the  (Stop) button, you can cancel the fax job at any time while sending the fax.
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 Confirming Transmissions
When the last page of your document has been sent successfully, the printer beeps and returns to the standby 
mode.

If something goes wrong while sending your fax, an error message appears on the LCD panel.

If you receive an error message, press the  button to clear the message and try to send the document again.

You can set your printer to print a confirmation report automatically after each fax transmission.

See also: 

� "Printing a Report Page" on page 250

 Automatic Redialing
If the number you have dialed is busy or there is no answer when you send a fax, the printer will automatically redial 
the number every minute based on the number set in the redial settings.

To change the time interval between redials and the number of redial attempts, see "Available Fax Settings Options" 
on page 246.

NOTE: 

� The printer will not automatically redial a number that was busy when the number was manually entered.
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Sending a Delayed Fax

The Delayed Start mode can be used to save scanned documents for transmission at a specified time to take 
advantage of lower long distance rates.

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Loading an Original Document" on page 225

2 Press the  (Fax) button.

3 Adjust the document resolution to suit your fax needs.

See also: 

� "Adjusting the Document Resolution" on page 227

� "Adjusting the Document Contrast" on page 227

4 Select Delayed Start, and then press the  button.

5 Select On, and then press the  button.

6 Enter the start time using the number pad or select the start time using the  or  button, and then press the 
 button.

7 Select Fax to, and then press the  button.

8 Select Keypad, and then press the  button.

9 Enter the number of the remote machine using the number pad, and then press the  button.

You can also use speed or group dial numbers.

See also: 

� "Automatic Dialing" on page 238

10 Press the  (Start) button to scan data.

Once Delayed Start mode is activated, your printer stores all of the documents to be faxed into its memory and 
sends them at the specified time. After faxing in the Delayed Start mode is complete, the data in the memory is 
cleared.

NOTE: 

� If you turn off and on the printer, the stored documents are sent as soon as the printer is activated.



232 Faxing

Sending a Fax from the Driver (Direct Fax)

You can send a fax directly from the computer running a Microsoft® Windows® operating system or Mac OS® X by 
using the driver.

NOTE: 

� Only black and white faxes can be sent using Direct Fax.

� The names of the dialog boxes and the buttons may be different from those given in the following procedure depending on the 
application you are using. 

� For Windows, the fax driver is installed with the PCL 6 driver. (For details, see "Inserting the CD-ROM" on page 86.)

� For Mac OS X, to use this feature, you must install the fax driver. To install the fax driver, run the Driver CD Kit on the Mac OS 
X, and then double-click FX DocuPrint M355 df.dmg in the MacOSX folder under the Contents folder, and then follow the 
on-screen instructions to install the fax driver.

1 Open the file you want to send by fax.

2 Open the print dialog box from the application, and then select your printer name.

3 Click Preferences in Windows, or select FAX Setting in Mac OS X.

For Windows:

For Mac OS X:
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4 Specify the fax settings. For more information, see the Help of the driver.

NOTE: 

� The settings done here are only applied to a single fax job.

For Windows:

For Mac OS X:
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5 For Windows, click OK to close the Printing Preferences dialog box, and then click Print.

The Recipient Setting dialog box appears.

For Mac OS X, click Print. The Set / Check Fax Transmission dialog box appears.

For Windows:

For Mac OS X:

6 Specify the destination for the recipient in one of the following ways. For details on how to specify the 
destination, see the Help of the driver.

a Enter the name and fax number directly.

b Select a fax number from the address book.

� Look Up Address Book: Displays a list of fax numbers that are saved in the file specified for My 

Address Book file.

� Import and add file (Windows only): Allows you to select a source file such as a CSV file, WAB file, 
MAPI, or a LDAP server. (For details on LDAP server, see "Server Phone Book" on page 281.)

NOTE: 

� Enter the password in Passcode in Windows or Password in Mac OS X in the Authorization area before sending a fax 
if the Fax service is locked with a password.
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Receiving a Fax

This section includes:

� "About Receiving Modes" on page 235

� "Loading Paper for Receiving Faxes" on page 235

� "Receiving a Fax Automatically in the FAX Mode" on page 235

� "Receiving a Fax Manually in the TEL Mode" on page 235

� "Receiving a Fax Automatically in the TEL/FAX Mode or Ans/FAX Mode" on page 236

� "Receiving a Fax Manually Using an External Telephone" on page 236

� "Receiving Faxes Using the DRPD Mode" on page 236

� "Receiving Faxes in the Memory" on page 236

� "Polling Receive" on page 237

 About Receiving Modes

NOTE: 

� To use the TEL/FAX Mode or Ans/FAX Mode, connect an external telephone or answering machine to the phone connector 
( ) on the rear of your printer.

When the memory is full, you cannot receive a fax automatically. Use an external telephone to receive a fax 
manually.

See also: 

� "Receiving a Fax Manually Using an External Telephone" on page 236

 Loading Paper for Receiving Faxes
The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying. 

See also: 

� "Loading Print Media" on page 131

� "Setting Paper Sizes and Types" on page 141

 Receiving a Fax Automatically in the FAX Mode
Your printer is preset to the FAX Mode at the factory. 

If you receive a fax, the printer automatically goes into the FAX Mode after a specified period of time and receives 
the fax.

To change the interval at which the printer goes into the FAX Mode after receiving an incoming call, see "Available 
Fax Settings Options" on page 246.

 Receiving a Fax Manually in the TEL Mode
You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive 
code (see "Available Fax Settings Options" on page 246), or by setting OnHook to On (you can hear voice or fax 
tones from the remote machine) and then pressing the  (Start) button.

The printer begins receiving a fax and returns to the standby mode when the reception is completed.
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 Receiving a Fax Automatically in the TEL/FAX Mode or 

Ans/FAX Mode
To use the TEL/FAX Mode or Ans/FAX Mode, you must connect an external telephone to the phone connector ( ) 
on the rear of your printer. 

If the caller leaves a message, the answering machine stores the message as it would normally. If your printer 
detects a fax tone on the line, it automatically starts to receive a fax.

NOTE: 

� If you have set your printer to Ans/FAX Mode and your answering machine is turned off, or no answering machine is 
connected to your printer, your printer will automatically go into the FAX Mode after a predefined time.

 Receiving a Fax Manually Using an External Telephone
This feature works best when you are using an external telephone connected to the phone connector ( ) on the 
rear of your printer. You can receive a fax from someone you are talking to on the external telephone without having 
to go to the printer.

When you receive a call on the external telephone and hear fax tones, press the two-digit keys on the external 
telephone, or set OnHook to On and then press the  (Start) button.

The printer receives the document.

Press the buttons slowly in sequence. If you still hear the fax tone from the remote machine, try pressing the 
two-digit keys once again.

The remote receive code is set to Off at the factory. You can change the two-digit number to whatever you choose. 
For details on changing the code, see "Available Fax Settings Options" on page 246.

NOTE: 

� Set the dialing system of your external telephone to DTMF.

 Receiving Faxes Using the DRPD Mode
The Distinctive Ring Pattern Detection (DRPD) is a telephone company service which enables a user to use a single 
telephone line to answer several different telephone numbers. The particular number someone uses to call you on is 
identified by different ringing patterns, which consist of various combinations of long and short ringing sounds.

Before using the DRPD option, Distinctive Ring service must be installed on your telephone line by the telephone 
company. To set up DRPD, you will need another telephone line at your location, or someone available to dial your 
fax number from outside. 

To set up the DRPD:

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select DRPD Pattern, and then press the  button.

5 Select the desired pattern, and then press the  button.

6 Reboot the printer by turning the power switch off and then on again.

To receive faxes in the DRPD, you need to set the menu to DRPD. For details, see "Available Fax Settings 
Options" on page 246.

 Receiving Faxes in the Memory
Since your printer is a multi-tasking device, it can receive faxes while you are making copies or printing. If you 
receive a fax while you are copying, printing, or run out of paper or toner, your printer stores incoming faxes in the 
memory. Then, as soon as you finish copying, printing, or re-supply the toner cartridge, the printer automatically 
prints the fax.
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 Polling Receive
You can receive faxes from the remote fax machine when you want to receive it.

1 Press the  (Fax) button.

2 Select Polling Receive, and then press the  button.

3 Select On, and then press the  button.

4 Enter the number of the remote machine using the number pad, and then press the  button.

NOTE: 

� For information on how to enter the fax number of the remote machine, see "Sending a Fax From Memory" on page 228 
or "Sending a Fax Manually" on page 229. 

5 Press the  (Start) button.
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Automatic Dialing

This section includes:

� "Speed Dialing" on page 238

� "Setting Speed Dial" on page 238

� "Sending a Fax Using Speed Dial" on page 239

� "Group Dialing" on page 240

� "Setting Group Dial" on page 240

� "Editing Group Dial" on page 240

� "Sending a Fax Using Group Dialing (Multi-address Transmission)" on page 241

� "Printing a Fax Address Book List" on page 241

 Speed Dialing
You can store up to 200 frequently dialed numbers in speed dial locations (001–200).

When the speed dial job specified in the delayed fax or redial exists, you cannot change the speed dial number from 
the operator panel or CentreWare Internet Services.

 Setting Speed Dial

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Phone Book, and then press the  button.

4 Select Speed Dial, and then press the  button.

5 Select the desired speed dial number between 001 and 200, and then press the  button.

6 Select Name, and then press the  button.

7 Enter the name, and then press the  button.

8 Select Fax Number, and then press the  button.

9 Enter the number you want to store using the number pad, and then press the  button.

To insert a pause between numbers, press the  (Redial/Pause) button. "-" appears on the LCD panel.

10 Select Apply Settings, and then press the  button.

11 Select Start, and then press the  button.

To store more fax numbers, repeat steps 5 to 11.

To return to the top level of the System menu, press the CA (Clear All) button.
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 Sending a Fax Using Speed Dial

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 

� "Loading an Original Document" on page 225

2 To enter the speed dial number, do one of the followings after pressing the  (Fax) button:

� Select Fax to, and then press the  button. Select Speed Dial, and then press the  button.

� Press the  (Speed Dial) button.

3 Enter the speed dial number between 001 and 200 using the number pad, and then press the  button.

The corresponding entry's name briefly displays on the LCD panel. To confirm the name again, press the  
button.

4 Adjust the document resolution to suit your fax needs.

See also: 

� "Adjusting the Document Resolution" on page 227

� "Adjusting the Document Contrast" on page 227

5 Press the  (Start) button.

The document scans into the memory.

When the document is placed on the document glass, the display prompts you for another page. Select Yes to 
add more documents or No to begin sending the fax immediately, and then press the  button.

The fax number stored in the speed dial location is automatically dialed. The document is sent when the remote 
fax machine answers.

NOTE: 

� Using the asterisk (*) in the first digit, you can send a document to multiple locations. For example, if you enter 00*, you 
can send a document to the locations registered between 001 and 009.
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 Group Dialing
If you frequently send the same document to several destinations, you can create a group of these destinations and 
set them under a one-digit group dial location. This enables you to use a group dial number setting to send the same 
document to all the destinations in the group.

NOTE: 

� You cannot include one group dial number within another group dial number.

 Setting Group Dial

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Phone Book, and then press the  button.

4 Select Group Dial, and then press the  button.

5 Select the desired group dial number between 01 and 06, and then press the  button.

6 Select Name, and then press the  button.

7 Enter the name, and then press the  button.

8 Select Speed Dial No, and then press the  button.

9 Select the desired speed dial numbers, and then press the  button to confirm.

10 Select Apply Settings, and then press the  button.

11 Select Start, and then press the  button.

To store more group dial numbers, repeat steps 5 to 11. 

To return to the top level of the System menu, press the CA (Clear All) button.

 Editing Group Dial
You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Phone Book, and then press the  button.

4 Select Group Dial, and then press the  button.

5 Select the group dial number that you want to edit, and then press the  button.

6 To change the group dial name:

a Select Name, and then press the  button.

b Enter a new name, and then press the  button.

c Select Apply Settings, and then press the  button.

d Select Start, and then press the  button.

To change the speed dial number:

a Select Speed Dial No, and then press the  button.
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b Select the speed dial number that you want to edit, and then select or deselect the speed dial number. 
Press the  button.

c Select Apply Settings, and then press the  button.

d Select Start, and then press the  button.

To delete the group dial:

a Press the C (Clear) button.

b Select Start, and then press the  button.

NOTE: 

� When you delete the last speed dial in a group, the group itself is not deleted.

7 If you want to edit another group dial number, repeat steps 5 and 6.

To return to the top level of the System menu, press the CA (Clear All) button.

 Sending a Fax Using Group Dialing (Multi-address 

Transmission)
You can use group dialing for broadcasting or delayed transmissions.

Follow the procedure of the desired operation (For delayed transmission, see "Sending a Delayed Fax" on 
page 231).

You can use one or more group numbers in one operation. Then continue the procedure to complete the desired 
operation.

Your printer automatically scans the document loaded in the DADF or on the document glass into the memory. The 
printer dials each of the numbers included in the group.

 Printing a Fax Address Book List
You can check your automatic dial setting by printing a Fax Address Book list.

1 Press the  (System) button.

2 Select Report / List, and then press the  button.

3 Select Fax Address Book, and then press the  button.

A list of your Fax Address Book entries is printed.



242 Faxing

Address Book

You can select the registered phone numbers from the address books.

1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document" on page 225.

2 Press the  (Fax) button.

3 Select Fax to, and then press the  button.

4 To select the registered phone numbers from the address books:

a Select Phone Book or Group Dial.

b Select the desired speed dial number or group dial number.

c Press the  button.

NOTE: 

� The fax number needs to be registered before you can select Address Book.

5 Press the  (Start) button to begin sending the fax.



Faxing 243

Other Ways to Fax

This section includes:

� "Using the Secure Receiving Mode" on page 243

� "Using an Answering Machine" on page 244

� "Using a Computer Modem" on page 244

 Using the Secure Receiving Mode
You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the 
secure fax mode using the Secure Receive option to restrict printing out all of the received faxes when the printer 
is unattended. In the secure receiving mode, all incoming faxes will go in memory. When the mode turns off, any 
faxes stored will be printed.

NOTE: 

� Before operation, ensure Panel Lock is enabled.

To turn the secure receiving mode on:

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Secure Receive, and then press the  button.

5 Select SecureReceiveSet, and then press the  button.

6 Select Enable, and then press the  button.

7 Enter a four-digit password using the number pad, and then press the  button.

To return to the top level of the System menu, press the CA (Clear All) button.

When a fax is received in the secure receiving mode, your printer stores it into memory and the Active Jobs 
screen displays Secure Receive to let you know that there is a fax stored.

To print received documents:

1 Press the  (Printer) button.

2 Select Secure Receive, and then press the  button.

3 Enter the password, and then press the  button.

The faxes stored in memory are printed.

To turn the secure receiving mode off:

1 Access the SecureReceiveSet menu by following steps from 1 to 5 in "To turn the secure receiving mode 
on:" on page 243.

2 Select Disable, and then press the  button.

To return to the top level of the System menu, press the CA (Clear All) button.
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 Using an Answering Machine

You can connect a telephone answering device (TAD) directly to the rear of your printer as shown above.

� Set your printer to the Ans/FAX Mode and set Auto Ans. Ans/FAX to specify the time for the TAD.

� When the TAD picks up the call, the printer monitors and takes the line if fax tones are received and then starts 
receiving the fax.

� If the answering device is off, the printer automatically goes into the FAX Mode after the ring tone sounds for a 
predefined time.

� If you answer the call and hear fax tones, the printer will answer the fax call if you

→ Set OnHook to On (you can hear voice or fax tones from the remote machine), and then press the  (Start) 
button and hang up the receiver.

OR

→ Press the two-digit remote receive code and hang up the receiver.

 Using a Computer Modem

If you want to use your computer modem for faxing or for a dial-up internet connection, connect the computer 
modem directly to the rear of your printer with the TAD as shown above.

� Set your printer to the Ans/FAX Mode and set Auto Ans. Ans/FAX to specify the time for the TAD.

� Turn off the computer modem's Fax Receive feature.

� Do not use the computer modem if your printer is sending or receiving a fax.

� Follow the instructions provided with your computer modem and fax application to fax via the computer 
modem.

To the 
wall jack Printer

Line

Telephone Answering Device Phone

To the 
internet Computer

Phone

Printer

Telephone Answering Device

Line
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Setting Sounds

This section includes:

� "Speaker Volume" on page 245

� "Ringer Volume" on page 245

 Speaker Volume

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Line Monitor, and then press the  button.

5 Select the desired volume, and then press the  button.

6 Reboot the printer by turning the power switch off and then on.

 Ringer Volume

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Ring Tone Volume, and then press the  button.

5 Select the desired volume, and then press the  button.

6 Reboot the printer by turning the power switch off and then on.
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Specifying the Fax Settings Options

This section includes:

� "Changing the Fax Settings Options" on page 246

� "Available Fax Settings Options" on page 246

 Changing the Fax Settings Options

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select the desired menu item, and then press the  button.

5 Select the desired setting or enter the value using the number pad.

6 Press the  button to save the selection.

7 Ensure that the message This Setting Becomes Effective after Restart appears, and then press 
any button.

8 If necessary, repeat steps 4 to 6.

To return to the top level of the System menu, press the CA (Clear All) button.

 Available Fax Settings Options
You can use the following settings options for configuring the fax system:

Option Description

Ans Select TEL Mode Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external telephone and then pressing the remote receive 
code, or by setting OnHook to On (you can hear voice or fax tones from the 
remote machine) and then pressing the  (Start) button.

FAX Mode* Automatically receives faxes.

TEL/FAX Mode When the printer receives an incoming fax, the external telephone rings for 
the time specified in Auto Ans. TEL/FAX, and then the printer 
automatically receives a fax. If an incoming call is not a fax, the printer beeps 
from the internal speaker indicating that the call is a telephone call.

Ans/FAX Mode The printer can share a telephone line with an answering machine. In this 
mode, the printer will monitor the fax signal and pick up the line if there are 
fax tones.

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive 
ring service must be installed on your telephone line by the telephone 
company. After the telephone company has provided a separate number for 
faxing with a distinctive ring pattern, configure the fax setup to monitor for that 
specific ring pattern.

Auto Answer Fax Sets the interval at which the printer goes into the fax receive mode after 
receiving an incoming call. The interval can be specified within the range of 0 
to 255 seconds. The default is 0 second.

Auto Ans. TEL/FAX Sets the interval at which the printer goes into the fax receive mode after the 
external telephone receives an incoming call. The interval can be specified 
within the range of 0 to 255 seconds. The default is 6 seconds.

Auto Ans. Ans/FAX Sets the interval at which the printer goes into the fax receive mode after the 
external answering machine receives an incoming call. The interval can be 
specified within the range of 0 to 255 seconds. The default is 21 seconds.

Line Monitor Sets the volume of the line monitor, which audibly monitors a transmission 
through the internal speaker until a connection is made.
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Ring Tone Volume Sets the volume of the ring tone, which indicates that an incoming call is a 
telephone call through the internal speaker when Ans Select is set to 
TEL/FAX Mode.

Line Type You can select the default line type.

� PSTN

� PBX

Dialing Type You can select the dialing type.

� PB

� DP (10PPS)

� DP (20PPS)

Interval Timer You can specify the interval between transmission attempts within the range 
of 3 to 255 seconds. The default is 8 seconds.

Number of Redial You can specify the number of redial attempts to make when the destination 
fax number is busy, within the range of 0 to 9. If you enter 0, the printer will 
not redial.

Redial Interval Your printer can automatically redial a remote fax machine if it was busy. 
Intervals from 1–15 minutes can be entered.

Junk Fax Filter You can reject faxes sent from unwanted stations. The system only accepts 
faxes from the remote stations registered in the speed dial. This feature is 
useful for blocking any unwanted faxes.

Select Off to turn the feature off. Anybody can send you a fax.

Select On to turn the feature on.

Remote Receive You can receive a fax by pressing the remote receive code on the external 
telephone after picking up the handset of the telephone.

Remote Rcv Tone You can specify the tone when Remote Receive is set to On.

Send Header Prints the sender’s information on the header of faxes. 

Select Off to turn this feature off. 

Select On to turn this feature on.

Note that if United States is selected for the setting of Region, this option 
does not appear on the menu. The setting is fixed to On and cannot be 
changed.

For information on the region setting, see "Setting Your Region" on page 222.

Company Name Specifies the sender’s name to be printed on the header of faxes.

Your Fax Number Specifies the fax number of the printer, which will be printed on the header of 
faxes. This feature is available when you set Send Header to On. The 
number specified in Your Fax Number is used in the printer ID.

Fax Cover Page You can set whether to attach a cover page to faxes when sending faxes.

DRPD Pattern Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive 
ring service must be installed on your telephone line by the telephone 
company. After the telephone company has provided a separate number for 
faxing with a distinctive ring pattern, configure the fax setup to monitor for that 
specific ring pattern.

2-Sided Print You can set whether to make duplex print when you print faxes.

Select Off to print faxes on one side of a sheet of paper.

Select On to print faxes on both sides of a sheet of paper.

Sent Fax Fwd You can set your printer to forward incoming faxes to another fax number. 
When a fax arrives at your printer, it is stored in the memory. Then, the printer 
dials the fax number that you have specified and sends the fax.

Select Off not to forward incoming faxes.

Select Forward to forward incoming faxes without printing. If an error occurs 
during forwarding a received fax, the printer prints the fax.

Select Print & Forward to forward and print incoming faxes.

Fwd. Settings Num You enter the fax number of the destination to which incoming faxes will be 
forwarded.

Prefix Dial You can specify whether or not to set a prefix dial number.

Option Description
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� Prefix Dial

NOTE: 

� Prefix Dial supports only the environment where you send a fax to the external line number. To use Prefix Dial, you must do 
the following from the operator panel. 

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Line Type, and then press the  button.

5 Select PBX, and then press the  button.

6 Select Prefix Dial, and then press the  button.

7 Select On, and then press the  button.

8 Select Prefix Dial Num, and then press the  button.

9 Enter an up-to-five-digit prefix number from 0–9, *, and #, and then press the  button.

10 Reboot the printer by turning the power switch off and then on.

Prefix Dial Num You can set a prefix dial number of up to five digits. This number dials before 
any auto dial number is started. It is useful for accessing the Private 
Automatic Branch Exchange (PBX).

Discard Size When receiving a document as long as or longer than the paper installed in 
your printer, you can set the printer to discard any excess at the bottom of the 
page. If the received page is outside the margin you set, it will print on two 
sheets of paper at the actual size. When the document is within the margin 
and Discard Size is set to Auto Reduction, the printer reduces the 
document to fit it onto the appropriate sized paper and discard does not 
occur. If Discard Size is set to other than Auto Reduction, the data 
within the margin will be discarded.

ECM You can set whether to enable or disable the ECM (Error Correction Mode).

Extel Hook Thresh You can select the external telephone hook detection threshold for the 
condition in which a telephone line is not being used.

Modem Speed You can set the modem speed.

Display Manual Fax Recipients To set whether to display the fax number of the recipient when manually 
sending a fax.

Region You can select the region where the printer is used.

You can change this setting when:

� No jobs in operation

� No fax jobs waiting in the memory

Fax Activity You can set whether to automatically print a fax activity report after every 50 
incoming and outgoing fax communications.

Fax Transmit You can set whether to print a transmission result after a fax transmission.

Fax Broadcast You can set whether to print a transmission result after a fax broadcast to 
multiple locations.

Fax Protocol You can set whether to print the protocol monitor report after a fax 
transmission to monitor fax protocol problems.

Option Description
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Changing Setting Options

1 Press the  (System) button.

2 Select Defaults Settings, and then press the  button.

3 Select Fax Defaults, and then press the  button.

4 Select the desired menu item, and then press the  button.

5 Select the desired setting or enter the value using the number pad, and then press the  button.

To return to the top level of the System menu, press the CA (Clear All) button.
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Printing a Report Page

The following reports may be useful when you use the fax:

� Fax Address Book

This list shows all the fax numbers currently stored in the memory of your printer as speed dial numbers.

You can print this Fax Address Book list from the operator panel. (For details, see also "Printing a Fax Address 
Book List" on page 241.)

� Email Address Book

This list shows all the e-mail addresses currently stored in the memory of your printer as Email Address Book 
information.

� Fax Activity

This report shows information about the faxes you recently received or sent.

� Fax Pending

This list shows the status of pending faxes. You may print this list to confirm your changes after changing any 
settings.

Procedures:

1 Press the  (System) button.

2 Select Report / List, and then press the  button.

3 Select the report or list you want to print, and then press the  button.

The selected report or list is printed.
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9
Using the Operator Panel Menus and 

Keypad

This chapter includes:

� "Understanding the Printer Menus" on page 252

� "Panel Lock Function" on page 308

� "Limiting Access to Copy, Fax, Scan, and Print from USB Operations" on page 309

� "Changing the Language" on page 310

� "Setting the Power Saver Timer Option" on page 311

� "About the Concurrent Jobs Feature" on page 312

� "Resetting to Factory Defaults" on page 313

� "Using the Number Pad to Enter Characters" on page 314
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Understanding the Printer Menus

When your printer is connected to a network and available to a number of users, the access to the Admin Menu can 
be limited. This prevents other users from using the operator panel to inadvertently change a user default that has 
been set by the administrator. 

However, you can use your print driver to override user defaults and select settings for individual print jobs.

 Report / List
Use the Report / List menu to print various types of reports and lists.

System Settings

Purpose:

To print a list of the current user default values, the installed options, the amount of installed print memory, and the 
status of printer supplies.

Panel Settings

Purpose:

To print a detailed list of all the settings on the operator panel menus.

PCL Fonts List

Purpose:

To print a sample of the available PCL fonts.

PCL Macros List

Purpose:

To print the information on the downloaded PCL macro.

PS Fonts List

Purpose:

To print a sample of the available PS fonts.

PDF Fonts List

Purpose:

To print a sample of the available PDF fonts.

Job History

Purpose:

To print a detailed list of the print, copy, fax, or scan jobs that have been processed. This list contains the last 20 
jobs.

Error History

Purpose:

To print a detailed list of paper jams and fatal errors.
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Printer Meter

Purpose:

To print the reports for the total number of pages printed.

Demo Page

Purpose:

To print a test page.

Protocol Monitor

Purpose:

To print a detailed list of monitored protocols.

Fax Address Book

Purpose:

To print the list of all fax addresses stored as Fax Address Book information.

Email Address Book

Purpose:

To print the list of all e-mail addresses stored as Email Address Book information.

Server Address

Purpose:

To print the list of all server addresses stored as Server Address information.

Fax Activity

Purpose:

To print the report of faxes you recently received or sent.

Fax Pending

Purpose:

To print the list of status of pending faxes. 

Stored Documents

NOTE: 

� Stored Documents feature is available only when the optional 512MB memory is installed on the printer and RAM Disk under 
System Settings is enabled.

Purpose:

To print a list of all files stored for Secure Print and Sample Print in the RAM disk.
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 Meter Readings
Purpose:

To check the total number of printed pages.

Values:

*1 This item always shows 0 on your printer.

 Admin Menu
Use the Admin Menu menu to configure a variety of printer features.

Phone Book

Use the Phone Book menu to configure the speed dial and group dial settings.

� Speed Dial

Purpose:

To store up to 200 frequently dialed numbers in speed dial locations.

� Group Dial

Purpose:

To create a group of fax destinations and register it under a two-digit dial code. Up to six group dial codes can be 
registered.

PCL Settings

Use the PCL Settings menu to change printer settings that only affect jobs using the PCL emulation printer 
language.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� Paper Tray

Purpose:

To specify the default paper tray.

Values:

*1 Tray 2 is available only when the optional 250 sheet feeder is installed.

Meter 1*1 Displays the total number of color prints.

Meter 2 Displays the total number of monochrome prints.

Meter 3*1 Displays the total number of large size color prints. 

Meter 4 Displays the total number of color and monochrome prints (Meter 1 + Meter 2).

Auto*

Bypass Tray

Tray 1

Tray 2*1
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� Output Size

Purpose:

To specify the default paper size.

Values:

mm series

*1 The default for Output Size varies depending on region-specific factory.

inch series

*1 The default for Output Size varies depending on region-specific factory.

NOTE: 
� Selecting New Custom Size for the paper size prompts you to enter a custom length and width.

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")

Monarch Env. (3.9 x 7.5")

DL Env. (110 x 220 mm)

C5 Env. (162 x 229 mm)

#10 Env. (4.1 x 9.5")

New Custom Size Portrait(Y) 297 mm* Specifies the length of the 
custom size paper.127 - 355 mm

Landscape(X) 210 mm* Specifies the width of the 
custom size paper.77 - 215 mm

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Executive (7.25 x 10.5")

Monarch Env. (3.9 x 7.5")

DL Env. (110 x 220 mm)

C5 Env. (162 x 229 mm)

#10 Env. (4.1 x 9.5")

New Custom Size Portrait(Y) 11.7 inch* Specifies the length of the 
custom size paper.5.0-14.0 inches

Landscape(X) 8.3 inch* Specifies the width of the 
custom size paper.3.0-8.5 inches
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� Orientation

Purpose:

To specify how text and graphics are oriented on the page.

Values:

� 2-Sided
Purpose:

To specify whether to print on both sides of a sheet of paper.

Values:

� Font
Purpose:

To specify the default font from the fonts registered in the printer.

Values:

Portrait* Prints text and graphics parallel to the short edge of the paper.

Landscape Prints text and graphics parallel to the long edge of the paper.

2-Sided Print 1-Sided* Does not print on both sides of a sheet of paper.

2-Sided Prints on both sides of a sheet of paper.

Binding Edge Long Edge Flip* Prints on both sides of a sheet of paper to be bound by long edge.

Short Edge Flip Prints on both sides of a sheet of paper to be bound by short edge.

CG Times LetterGothic CourierPS

CG Times It LetterGothic It CourierPS Ob

CG Times Bd LetterGothic Bd CourierPS Bd

CG Times BdIt Albertus Md CourierPS BdOb

Univers Md Albertus XBd SymbolPS

Univers MdIt Clarendon Cd Palatino Roman

Univers Bd Coronet Palatino It

Univers BdIt Marigold Palatino Bd

Univers MdCd Arial Palatino BdIt

Univers MdCdIt Arial It ITCBookman Lt

Univers BdCd Arial Bd ITCBookman LtIt

Univers BdCdIt Arial BdIt ITCBookmanDm

AntiqueOlv Times New ITCBookmanDm It

AntiqueOlv It Times New It HelveticaNr

AntiqueOlv Bd Times New Bd HelveticaNr Ob

CG Omega Times New BdIt HelveticaNr Bd

CG Omega It Symbol HelveticaNrBdOb

CG Omega Bd Wingdings N C Schbk Roman

CG Omega BdIt Line Printer N C Schbk It

GaramondAntiqua Times Roman N C Schbk Bd

Garamond Krsv Times It N C Schbk BdIt

Garamond Hlb Times Bd ITC A G Go Bk

GaramondKrsvHlb Times BdIt ITC A G Go BkOb

Courier* Helvetica ITC A G Go Dm

Courier It Helvetica Ob ITC A G Go DmOb

Courier Bd Helvetica Bd ZapfC MdIt

Courier BdIt Helvetica BdOb ZapfDingbats
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� Symbol Set

Purpose:

To specify a symbol set for a specified font.

Values:

� Font Size

Purpose:

To specify the font size for scalable typographic fonts, within the range of 4.00 to 50.00. The default is 12.00.

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

NOTE: 

� The Font Size menu is only displayed for typographic fonts.

� Font Pitch

Purpose:

To specify the font pitch for scalable mono spaced fonts, within the range of 6.00 to 24.00. The default is 10.00.

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For nonscheduled mono 
spaced fonts, the pitch is displayed, but cannot be changed.

NOTE: 

� The Font Pitch menu is only displayed for fixed or mono spaced fonts.

� Form Line

Purpose:

To set the number of lines in a page.

Values:

*1 Denotes region-specific factory default values. 

The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and 
Orientation menu items. Select the correct Form Line and Orientation before changing Form Line.

See also: 

� "Orientation" on page 256

ROMAN-8* WIN L1 ISO-6

ISO L1 WIN L2 ISO-11

ISO L2 WIN L5 ISO-15

ISO L5 DESKTOP ISO-17

ISO L6 PS TEXT ISO-21

PC-8 MC TEXT ISO-60

PC-8 DN MS PUB ISO-69

PC-775 MATH-8 WIN 3.0

PC-850 PS MATH WINBALT

PC-852 PI FONT SYMBOL

PC-1004 LEGAL WINGDINGS

PC-8 TK ISO-4 DNGBTSMS

64*1 Sets the value in increments of 1.

5–128
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� Quantity

Purpose:

To set the default print quantity, within the range of 1 to 999. The default is 1. (Set the number of copies required for 
a specific job from the print driver. Values selected from the print driver always override values selected from the 
operator panel.)

� Hex Dump

Purpose:

To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in 
hexadecimal and character representation. Control codes are not executed.

Values:

� Draft Mode

Purpose:

To save toner by printing in the draft mode. The print quality is reduced when you print in the draft mode.

Values:

� Line Termination

Purpose:

To add the line termination commands.

Values:

� Ignore FormFeed

Purpose:

To specify whether to ignore blank pages that only contain Form Feed control codes.

Values:

Disable* Disables the Hex Dump feature.

Enable Enables the Hex Dump feature.

Disable* Does not print in the draft mode.

Enable Prints in the draft mode.

Off* The line termination command is not added.

CR=CR, LF=LF, FF=FF

Add-LF The LF command is added.

CR=CR-LF, LF=LF, FF=FF

Add-CR The CR command is added.

CR=CR, LF=CR-LF, FF=CR-FF

CR-XX The CR and LF commands are added.

CR=CR-LF, LF=CR-LF, FF=CR-FF

Off* Disables the Ignore FormFeed feature.

On Enables the Ignore FormFeed feature.
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� A4 Wide

Purpose:

To expand the printable area width 8 inch.

Values:

PDF Settings

Use the PDF Settings menu to change printer settings that only affect the PDF jobs.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� Quantity

Purpose:

To specify the number of copies to print.

Values:

� 2-Sided Print

Purpose:

To specify whether to print on both sides of a sheet of paper.

Values:

� Print Mode

Purpose:

To specify the print mode.

Value:

� PDF Password

Purpose:

To specify the password to print the secure PDF. 

Value:

Off* Disables A4 Wide.

On Enables A4 Wide.

1* Sets the value in increments of 1.

1–999

1-Sided* Prints on one side of a sheet of paper.

Long Edge Flip Prints on both sides of a sheet of paper to be bound by long edge. 

Short Edge Flip Prints on both sides of a sheet of paper to be bound by short edge.

Normal* For documents with normal sized characters.

High Quality For documents with small characters or thin lines, or documents 
printed using a dot-matrix printer.

High Speed Prints with the higher speed than the Normal mode, but the quality is 
less.

Enter PDF Password Enter the password to print the secure PDF.
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� Collated

Purpose:

To specify whether to sort the job.

Values:

� Output Size

Purpose:

To specify the output paper size for PDF.

Values:

*1 The default paper size is displayed.

� Layout

Purpose:

To specify the output layout.

Values:

PostScript Settings

Use the PostScript Settings menu to change printer settings that only affect jobs using the PostScript® 
emulation printer language.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� PS Error Report

Purpose:

To specify whether to print the contents of PostScript errors. The change becomes effective after the printer is turned 
off and then on again.

Values:

NOTE: 

� Instructions from the PS driver override the settings specified on the operator panel.

Off* Does not sort the job. 

On Sorts the job.

A4 (210 x 297 mm)*1

Letter (8.5 x 11")*1

Auto

Auto %*

100% (No Zoom)

Booklet

2 Pages Up

4 Pages Up

Off Discards the print job without printing an error message.

On* Prints an error message before it discards the job.
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� PS Job Time-Out

Purpose:

To specify the runtime of one PostScript job. The change becomes effective after the printer is turned off and then on 
again.

Values:

� Paper Select Mode

Purpose:

To set the way to select the paper tray for PostScript mode. The change becomes effective after the printer is turned 
off and then on again.

Values:

Network Setup

Use the Network Setup menu to change the printer settings affecting jobs sent to the printer through the network.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� Ethernet

NOTE: 

� Ethernet feature is available only when the printer is connected using the wired network.

Purpose:

To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the 
printer is turned off and then on again.

Values:

Off* Job time-out does not occur.

On 1min A PostScript error occurs if processing is not completed after the specified 
time.1-900

Auto* The tray is selected as the same setting as in the PCL mode.

Select From Tray The tray is selected in a method compatible with regular PostScript printers.

Auto* Detects the Ethernet settings automatically.

10BASE-T Half Uses 10BASE-T Half-duplex.

10BASE-T Full Uses 10BASE-T Full-duplex.

100BASE-TX Half Uses 100BASE-TX Half-duplex.

100BASE-TX Full Uses 100BASE-TX Full-duplex.

1000BASE-T Full Uses 1000BASE-T Full-duplex.
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� Wireless Status

NOTE: 

� Wireless Status feature is available only when the printer is connected using the wireless network.

Purpose:

To confirm the wireless communication status.

Values:

� Wireless Setup

NOTE: 

� Wireless Setup feature is available only when the printer is connected using the wireless network.

Purpose:

To configure the wireless network interface. The printer automatically searches and list available access points. 
Select one of the access points, and enter a pass phrase or WEP Key to complete the wireless setup. You can also 
specify and configure the wireless network manually.

Values:

Connection Displays the connection condition.

SSID Displays the name that identifies the wireless network.

Encryption Type Displays the encryption type.

Select access Select the desired access point 
from the list, or select Manual 
Setup to specify and configure 
wireless network manually.

PassPhrase Entry Displayed when the selected 
access point uses the security 
method of WPA-PSK-TKIP or 
WPA2-PSK-AES. Specify the 
pass phrase of 8 to 63 
alphanumeric characters.

WEP Key Entry Displayed when the selected 
access point uses the security 
method of WEP. Specify the 
WEP key of 10 or 26 
hexadecimal characters.

The transmit key is set to Auto.
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Manual 

Setup

Enter Network (SSID) Specify a name to identify the 
wireless network. Up to 32 
alphanumeric characters can 
be entered.

Network 

Mode

Infrastructure Select to configure the wireless 
setting through the access 
point such as a wireless router.

Encryption 

Type

No Security Specify No Security to 
configure the wireless setting 
without specifying a security 
method from Mixed mode PSK, 
WPA-PSK-TKIP, 
WPA2-PSK-AES, and WEP.

Mixed mode PSK Specify Mixed mode PSK to 
automatically select an 
available encryption method 
from WPA-PSK-TKIP or 
WPA2-PSK-AES.

PassPhrase 

Entry

Specify the pass phrase for 
Mixed mode PSK. Enter 8 to 63 
alphanumeric characters.

WPA-PSK-TKIP Select to configure the wireless 
setting with the security method 
of WPA-PSK-TKIP.

PassPhrase 

Entry

Specify the pass phrase for 
WPA-PSK-TKIP. Enter 8 to 63 
alphanumeric characters.

WPA2-PSK-AES Select to configure the wireless 
setting with the security method 
of WPA2-PSK-AES.

PassPhrase 

Entry

Specify the pass phrase for 
WPA2-PSK-AES. Enter 8 to 63 
alphanumeric characters.

WEP Select to configure the wireless 
setting with the security method 
of WEP.

WEP Key 

Entry

Specify the WEP Key to use 
through the wireless network. 
Enter 10 or 26 hexadecimal 
characters.

Transmit 

Key

Specify the transmit key from 
Auto, WEP Key1, WEP Key2, 
WEP Key3, and WEP Key4.

Ad-hoc Select to configure the wireless 
setting without the access point 
such as a wireless router.

Encryption 

Type

No Security Specify No Security to 
configure the wireless setting 
without specifying a security 
method of WEP.

WEP Select to configure the wireless 
setting with the security method 
of WEP.

WEP Key 

Entry

Specify the WEP Key to use 
through the wireless network. 
Enter 10 or 26 hexadecimal 
characters.

Transmit 

Key

Specify the transmit key from 
WEP Key1, WEP Key2, WEP 
Key3, and WEP Key4.
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� WPS Setup

NOTE: 

� WPS Setup feature is available only when the printer is connected using the wireless network.

Purpose:

To configure the wireless setting with the security method of WPS.

Values:

� Reset Wireless

NOTE: 

� Reset Wireless feature is available only when the printer is connected using the wireless network.

Purpose:

To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network 
settings are reset to their default values.

Values:

Push Button Control Cancel Cancels the wireless setting with the security method of WPS-PBC.

Start Starts the wireless setting with the security method of WPS-PBC.

PIN Code Start 

Configuration

Configures the wireless setting using the PIN code assigned 
automatically by the printer.

Print PIN Code Prints the PIN code. Confirm it when entering PIN assigned to the 
printer into your computer.

Cancel Cancels the wireless setting.

Start Starts the wireless setting.
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� TCP/IP

Purpose:

To configure TCP/IP settings. 

Values:

*1 IPsec feature is available only when IPsec is enabled on the CentreWare Internet Services.

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Uses IPv4 to set the IP address.

IPv6 Uses IPv6 to set the IP address.

IPv4 Get IP Address DHCP / AutoIP* Sets the IP address automatically. A random value in the 
range of 169.254.1.0 to 169.254.254.255 that is not 
currently in use on the network is set as the IP address. The 
subnet mask is set as 255.255.0.0.

BOOTP Sets the IP address using BOOTP.

RARP Sets the IP address using RARP. 

DHCP Sets the IP address using DHCP.

Panel Use this option when you want to set the IP address manually 
on the operator panel.

IP Address When an IP address is being set manually, the IP is allocated 
to the printer using the format nnn.nnn.nnn.nnn. Each octet 
that makes up nnn.nnn.nnn.nnn is a value in the range of 0 
to 254. 127 and any value in the range of 224 to 254 cannot 
be specified for the first octet of a gateway address. 

Subnet Mask When an IP address is being set manually, the subnet mask is 
specified using the format nnn.nnn.nnn.nnn. Each octet 
that makes up nnn.nnn.nnn.nnn is a value in the range of 0 
to 255. 255.255.255.255 cannot be specified as the 
subnet mask.

Gateway Address When an IP address is being set manually, the gateway 
address is specified using the format nnn.nnn.nnn.nnn. 
Each octet that makes up nnn.nnn.nnn.nnn is a value in 
the range of 0 to 254. 127 and any value in the range of 224 
to 254 cannot be specified for the first octet of a gateway 
address. 

IPsec*1 Disable Disables IPsec.
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� Protocols

Purpose:

To enable or disable each protocol. The change becomes effective after the printer is turned off and then on again.

Values:

*1 HTTP-SSL/TLS is available only when a certificate is created using CentreWare Internet Services. For details about creating a 

certificate, see the Help on the CentreWare Internet Services.

LPD Disable Disables the Line Printer Daemon (LPD) port.

Enable* Enables the LPD port.

Port9100 Disable Disables the Port9100 port.

Enable* Enables the Port9100 port.

FTP Disable Disables the FTP port.

Enable* Enables the FTP port.

IPP Disable Disables IPP port.

Enable* Enables IPP port.

SMB TCP/IP Disable Disables SMB TCP/IP port.

Enable* Enables SMB TCP/IP port.

SMB NetBEUI Disable Disables SMB Net BEUI port.

Enable* Enables SMB Net BEUI port.

WSD Print Disable Disables WSD Print.

Enable* Enables WSD Print.

WSD Scan Disable Disables WSD Scan.

Enable* Enables WSD Scan.

Network TWAIN Disable Disables Network TWAIN.

Enable* Enables Network TWAIN.

SNMP UDP Disable Disables the Simple Network Management Protocol (SNMP) UDP port.

Enable* Enables the SNMP UDP port.

StatusMessenger Disable Disables the Status Messenger feature.

Enable* Enables the Status Messenger feature.

InternetServices Disable Disables an access to CentreWare Internet Services embedded in the 
printer.

Enable* Enables an access to CentreWare Internet Services embedded in the 
printer.

Bonjour(mDNS) Disable Disables Bonjour® (mDNS).

Enable* Enables Bonjour (mDNS).

Telnet Disable* Disables Telnet.

Enable Enables Telnet.

Update Addr Book Disable Disables Update Address Book.

Enable* Enables Update Address Book.

HTTP-SSL/TLS*1 Disable Disables HTTP-SSL/TLS.

Enable Enables HTTP-SSL/TLS.
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� IP Filter

NOTE: 

� IP Filter feature is available only when LPD or Port9100 under Protocols is set to Enable.

Purpose:

To block data received from certain IP addresses through the wired network. You can set up to five IP addresses. 
The change becomes effective after the printer is turned off and then on again.

Values:

� IEEE 802.1x

NOTE: 

� IEEE 802.1x feature is available only when the printer is connected using LAN cable and the IEEE 802.1x authentication is 
enabled using CentreWare Internet Services. For details about setting IEEE 802.1x, see the Help on the CentreWare Internet 
Services.

Purpose:

To disable IEEE 802.1x authentication. The change becomes effective after the printer is turned off and then on 
again.

Value:

� Initialize NVM

Purpose:

To initialize wired network data stored in non-volatile memory (NVM). After executing this function and rebooting the 
printer, all wired network settings are reset to their default values.

Values:

� Adobe Protocol

Purpose:

To specify PostScript communication protocol for a parallel interface, you can configure the Adobe Protocol settings 
for the wired network. The change becomes effective after the printer is turned off and then on again.

Values:

No. n / Address (n is 1–5.) Sets the IP address for Filter n.

No. n / Mask (n is 1–5.) Sets the address mask for Filter n.

No. n / Mode (n is 1–5.) Off* Disables the IP Filter feature for Filter n.

Accept Accepts an access from the specified IP address.

Reject Rejects an access from the specified IP address.

Disable Disables IEEE 802.1x.

Cancel* Does not initialize the wired network data stored in NVM.

Start Initializes the wired network data stored in NVM.

Auto* Sets the PostScript communications protocol automatically.

Standard Sets the PostScript communications protocol to Standard.

BCP Sets the PostScript communications protocol to BCP.

TBCP Sets the PostScript communications protocol to TBCP.

Binary Sets the PostScript communications protocol to Binary.
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Fax Settings

Use the Fax Settings menu to configure the basic fax settings.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� Ans Select

Purpose:

To select the default fax receiving mode.

Values:

� Auto Answer Fax

Purpose:

To set the interval at which the printer goes into the fax receive mode after receiving an incoming call. The interval 
can be specified within the range of 0 to 255 seconds. The default is 0 second.

� Auto Ans. TEL/FAX

Purpose:

To set the interval at which the printer goes into the fax receive mode after the external telephone receives an 
incoming call. The interval can be specified within the range of 0 to 255 seconds. The default is 6 seconds.

� Auto Ans. Ans/FAX

Purpose:

To set the interval at which the printer goes into the fax receive mode after the external answering machine receives 
an incoming call. The interval can be specified within the range of 0 to 255 seconds. The default is 21 seconds.

TEL Mode Automatic fax reception is turned off. You can receive a fax by picking 
up the handset of the external phone and then pressing the remote 
receive code, or by setting OnHook to On (you can hear voice or fax 
tones from the remote machine) and then pressing (Start) button. 
For details about Manual Receive, see "Receiving a Fax Manually in 
the TEL Mode" on page 235.

FAX Mode* Automatically receives faxes.

TEL/FAX Mode When the printer receives an incoming fax, the external telephone 
rings for the time specified in Auto Ans. Tel/Fax, and then the 
printer automatically receives a fax. If an incoming call is not a fax, 
the printer beeps from the internal speaker indicating that the call is a 
telephone call.

Ans/FAX Mode The printer can share a telephone line with an answering machine. In 
this mode, the printer will monitor the fax signal and pick up the line if 
there are fax tones. If the phone communication in your region is 
serial, this mode is not supported. 

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) option, a 
distinctive ring service must be installed on your telephone line by the 
telephone company. After the telephone company has provided a 
separate number for faxing with a distinctive ring pattern, configure 
the fax setup to monitor for that specific ring pattern.
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� Line Monitor

Purpose:

To set the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a 
connection is made.

Values:

� Ring Tone Volume

Purpose:

To set the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal 
speaker when Ans Select is set to TEL/FAX Mode.

Values:

� Line Type

Purpose:

To select the default line type.

Values:

� Dialing Type

Purpose:

To select the dialing type.

Values:

� Interval Timer

Purpose:

To specify the interval between transmission attempts within the range of 3 to 255 seconds. The default is 8 
seconds.

� Number of Redial

Purpose:

To specify the number of redial attempts to make when the destination fax number is busy, within the range of 0 to 9. 
If you enter 0, the printer will not redial. The default is 3.

Off Turns off the volume of the line monitor.

Min Sets the volume of the line monitor to Min.

Middle* Sets the volume of the line monitor to Middle.

Max Sets the volume of the line monitor to Max.

Off Turns off the volume of the ring tone.

Min Sets the volume of the ring tone to Min.

Middle Sets the volume of the ring tone to Middle.

Max* Sets the volume of the ring tone to Max.

PSTN* Uses PSTN.

PBX Uses PBX.

PB* Uses tone dialing.

DP(10PPS) Sets DP (10PPS) (Dial Pulse, 10 Pulse Per Second) as the dial type. 

DP(20PPS) Sets DP (20PPS) (Dial Pulse, 20 Pulse Per Second) as the dial type. 
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� Redial Interval

Purpose:

To specify the interval between redial attempts within the range of 1 to 15 minutes. The default is 1 minute.

� Junk Fax Filter

Purpose:

To reject unwanted faxes by accepting faxes only from the fax numbers registered in the Fax Address Book.

Values:

� Remote Receive

Purpose:

To receive a fax by pressing a remote receive code on the external telephone after picking up the handset of the 
telephone.

Values:

� Remote Rcv Tone

Purpose:

To specify the tone in two digits to start Remote Receive. 

� Send Header

Purpose:

To print the information of the sender on the header of the faxes.

Values:

� Company Name

Purpose:

To set the sender name to be printed on the header on faxes.

� Your Fax Number

Purpose:

To set the fax number of the printer, which will be printed on the header of a fax message.

NOTE: 

� Ensure to specify Your Fax Number before using Junk Fax Filter.

Off* Does not reject faxes sent from unwanted numbers.

On Rejects faxes sent from unwanted numbers.

Off* Does not receive a fax by pressing a remote receive code on the 
external telephone.

On Receives a fax by pressing a remote receive code on the external 
telephone.

Off Does not print the sender's information on the header of faxes.

On* Prints the sender's information on the header of faxes.
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� Fax Cover Page

Purpose:

To set whether to attach a cover page to faxes.

Values:

� DRPD Pattern

Purpose:

To provide a separate number for faxing with a distinctive ring pattern.

Values:

� 2-Sided Print

Purpose:

To set the duplex printing for fax. 

Values:

Off* Does not attach a cover page to faxes.

On Attaches a cover page to faxes.

Pattern1–7 DRPD is a service provided by some telephone companies. DRPD 
patterns are specified by your telephone company. The patterns 
provided with your printer are shown below:

Ask your telephone company which pattern you need to select to use 
this service. For example, Pattern7 is the New Zealand FaxAbility 
distinctive ringing pattern: rings for 400 ms, stops for 800 ms, rings for 
400 ms and stops for 1400 ms. This pattern is repeated over and over 
again. This printer only responds to Distinctive Alert cadence(s) DA4 
in New Zealand.

Off* Does not perform duplex printing.

On Performs duplex printing.

Pattern1

Pattern2

Pattern3

Pattern4*

Pattern5

Pattern6

Pattern7
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� Sent Fax Fwd

Purpose:

To set whether to forward incoming faxes to a specified destination.

Values:

� Fwd. Settings Num

Purpose:

To enter the fax number of the destination to which incoming faxes will be forwarded.

� Prefix Dial

Purpose:

To select whether to set a prefix dial number.

Values:

� Prefix Dial Num

Purpose:

To set a prefix dial number of up to five digits. This number dials before any auto dial number is started. It is useful 
for accessing the Private Automatic Branch Exchange (PABX).

� Discard Size

Purpose:

To set the printer to discard images or any text at the bottom of a fax page when the entire page does not fit the 
output paper.

Values:

� ECM

Purpose:

To set whether to enable or disable the Error Correction Mode (ECM). To use the ECM, the remote machines must 
also support the ECM.

Values:

Off* Does not forward incoming faxes.

Forward Forwards incoming faxes to a specified destination. Prints incoming 
faxes if an error occurs during the transfer.

Print & Forward Prints incoming faxes and also forwards them to a specified 
destination.

Off* Does not set a prefix dial number.

On Sets a prefix dial number.

Off* Prints excess images or text at the bottom of a fax page without 
discarding it.

On Discards any excess images or text.

Auto Reduction Automatically reduces a fax page to fit it onto the appropriate paper 
size.

Off Disables the ECM.

On* Enables the ECM.
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� Extel Hook Thresh

Purpose:

To select the external telephone hook detection threshold for the condition in which a telephone line is not being 
used.

Values:

� Modem Speed

Purpose:

To adjust the fax modem speed when a fax transmission or reception error occurs. 

Values:

� Display Manual Fax Recipients

Purpose:

To set whether to display the fax number of the recipient on the sending fax screen when manually sending a fax.

Values:

� Region

Purpose:

To select the region where the printer is used.

� Fax Activity

Purpose:

To set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.

Values:

Lower Sets the external telephone hook detection threshold to Lower.

Normal* Sets the external telephone hook detection threshold to Normal.

Higher Sets the external telephone hook detection threshold to Higher.

2.4 Kbps

4.8 Kbps

9.6 Kbps

14.4 Kbps

33.6 Kbps*

Off Does not display the fax number when manually sending a fax.

On* Displays the fax number when manually sending a fax.

Auto Print* Automatically prints a fax activity report after every 50 incoming and 
outgoing fax communications.

No Auto Print Does not automatically print a fax activity report after every 50 
incoming and outgoing fax communications.
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� Fax Transmit

Purpose:

To set whether to print a transmission result after a fax transmission.

Values:

� Fax Broadcast

Purpose:

To set whether to print a broadcast result after a fax broadcast to multiple destinations.

Values:

� Fax Protocol

Purpose:

To set whether to print the protocol monitor report, which helps you identify the cause of a communication problem.

Values:

USB Settings

Use the USB Settings menu to change printer settings affecting a USB port.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� Port Status

NOTE: 

� Port Status feature is available only for the USB port on the rear of the printer.

Purpose:

To specify whether to enable the USB port. The change becomes effective after the printer is turned off and then on 
again.

Values:

Print Always Prints a transmission report after every fax transmission.

Print On Error* Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Print Always* Prints a broadcast report after every fax broadcast.

Print On Error Prints a broadcast report only when an error occurs.

Print Disable Does not print a broadcast report after a fax broadcast to multiple 
destinations.

Print Always Prints a protocol monitor report after every fax transmission.

Print On Error Prints a protocol monitor report only when an error occurs.

Print Disable* Does not print a protocol monitor report.

Disable Disables the USB port.

Enable* Enables the USB port.
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� Adobe Protocol

Purpose:

To specify PostScript communication protocol. You can configure the Adobe Protocol settings for the wired 
network. The change becomes effective after the printer is turned off and then on again.

Values:

System Settings

Use System Settings to configure a variety of printer features.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� Power Saver Timer

Purpose:

To specify the time for transition to Power Saver mode.

Values:

Select 1min (default) for Low Power Timer if your printer shares an electrical circuit with your room lights and you 
notice them flickering. Otherwise, select a high value to keep your printer available for frequent use with the 
minimum warm-up time.

The printer automatically returns to the standby mode from the Power Saver mode when it receives data from the 
computer or remote fax machine. You can also change the status of the printer to the standby mode by pressing the 

 (Energy Saver) button on the operator panel.

� Power Saver Wake Up

Purpose:

To specify whether to wake up from the Low Power or Sleep mode when OnHook is set to Off.

Values:

Auto Sets the PostScript communications protocol automatically.

Standard Sets the PostScript communications protocol to Standard.

BCP Sets the PostScript communications protocol to BCP.

TBCP* Sets the PostScript communications protocol to TBCP.

Binary Sets the PostScript communications protocol to Binary.

Low Power 

Timer

1min* Specifies the time taken by the printer to enter Low Power mode after 
it finishes a job.1–60

Sleep Timer 1min* Specifies the time taken by the printer to enter Sleep mode after it has 
entered Low Power mode.1–60

OffHook Wake Up Off* Does not wake up from the Low Power or Sleep mode when OnHook 
is set to Off.

On Wakes up from the Low Power or Sleep mode when OnHook is set to 
Off.
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� Auto Reset

Purpose:

To automatically reset the settings for Copy, Scan, or Fax to the default settings and return to the standby mode after 
you do not specify any settings for the specified time.

Values:

� Fault Time-out

Purpose:

To specify the amount of time the printer waits before canceling a job that stops abnormally. The print job is 
cancelled if the time-out time is exceeded. 

Values:

� Job Time-out

Purpose:

To specify the amount of time the printer waits for data to arrive from the computer. The print job is cancelled if the 
time-out time is exceeded.

Values:

� Clock Settings

Purpose:

To specify the date and time formats.

Values:

*1 The default for Date Format varies depending on region-specific factory default.

45sec*

1min

2min

3min

4min

Off Disables the fault time-out.

On* 60sec* Sets the amount of time the printer waits before canceling a job that 
stops abnormally.3–300

Off Disables the job time-out.

On* 30sec* Sets the time the printer waits for data to arrive from the computer.

5–300

Set Date & Time Time Zone Sets the time zone. 

Set Date Sets the date depending on the Date Format settings.

Set Time Sets the time.

Date Format yy/mm/dd Sets the date format.

mm/dd/yy

dd/mm/yy*1

Time Format 12H Sets the time in 12-hour format.

24H* Sets the time in 24-hour format.
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� Alert Tone

Purpose:

To configure settings for tones emitted by the printer during operation or when a warning message appears. 

Values:

Panel Select Tone Off* Does not emit a tone when the operator panel entry is correct.

Soft Emits a tone when the operator panel entry is correct.

Normal 

Loud

Panel Alert Tone Off* Does not emit a tone when the operator panel entry is incorrect.

Soft Emits a tone when the operator panel entry is incorrect.

Normal 

Loud

Machine Ready 

Tone

Off Does not emit a tone when the printer is ready to process a job.

Soft Emits a tone when the printer is ready to process a job.

Normal*

Loud

Copy Job Tone Off Does not emit a tone when a copy job is complete.

Soft Emits a tone when a copy job is complete.

Normal*

Loud

Non-Copy Job 

Tone

Off Does not emit a tone when a job other than a copy job is complete.

Soft Emits a tone when a job other than a copy job is complete.

Normal*

Loud

Fault Tone Off Does not emit a tone when a job ends abnormally.

Soft Emits a tone when a job ends abnormally.

Normal*

Loud

Alert Tone Off Does not emit a tone when a problem occurs.

Soft Emits a tone when a problem occurs.

Normal*

Loud

Out of Paper Off Does not emit a tone when the printer runs out of paper.

Soft Emits a tone when the printer runs out of paper.

Normal*

Loud

Low Toner Off Does not emit a tone when a toner is low.

Soft Emits a tone when a toner is low.

Normal*

Loud

Auto Clear Alert Off* Does not emit a tone 5 seconds before the printer performs auto 
clear.

Soft Emits a tone 5 seconds before the printer performs auto clear.

Normal 

Loud
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� mm / inch

Purpose:

To specify the default measurement unit displayed after the numeric value on the operator panel.

Values:

NOTE: 

� The default for mm/inch varies depending on other settings, such as Region and Document Size.

� Default Print Paper Size

Purpose:

To specify the default paper size.

Values:

NOTE: 

� The default for Default Print Paper Size varies depending on region-specific factory default.

� Auto Job History

Purpose:

To automatically print a job history report after every 20 jobs.

Values:

The job history report can also be printed using the Report / List menu.

Base Tone Off* Does not emit a tone when the operator panel display is returned to 
the default setting by scrolling the loop menu.

Soft Emits a tone when the operator panel display is returned to the 
default setting by scrolling the loop menu.Normal 

Loud

All Tones Off Disables all the alert tones.

Soft Sets the volume of all the alert tones at once.

Normal*

Loud

Millimeters(mm)* Selects millimeter as the default measurement unit.

Inches(") Selects inch as the default measurement unit.

A4 (210 x 297 mm)

Letter (8.5 x 11")

Off* Does not automatically print a job history report.

On Automatically prints a job history report.
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� Print ID

Purpose:

To specify a location where the user ID is printed. 

Values:

NOTE: 

� When you print on DL size paper, a part of the user ID may not be printed correctly.

� Print Text

Purpose:

To specify whether the printer outputs PDL data, which is not supported by the printer, as text when the printer 
receives it. Text data is printed on A4 or Letter size paper.

Values:

� Banner Sheet

NOTE: 

� Banner Sheet feature is available only when the optional 250 sheet feeder is installed on the printer.

Purpose:

To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded. 

Values:

*1 Tray 2 is available only when the optional 250 sheet feeder is installed.

Off* Does not print the user ID.

Top Left Prints the user ID on the top left of the page.

Top Right Prints the user ID on the top right of the page.

Bottom Left Prints the user ID on the bottom left of the page.

Bottom Right Prints the user ID on the bottom right of the page.

Off Does not print the received data.

On* Prints the received data as text data.

Insert Position Off* Does not print the banner sheet.

Front Inserted before the first page of every copy.

Back Inserted after the last page of every copy.

Front & Back Inserted before the first page of every copy and after the last page of 
every copy.

Specify Tray Bypass Tray The banner sheet is loaded in the bypass tray.

Tray 1* The banner sheet is loaded in the standard 250 sheet tray.

Tray 2*1 The banner sheet is loaded in the optional 250 sheet feeder.
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� RAM Disk

NOTE: 

� RAM Disk feature is available only when the optional 512MB memory is installed on the printer.

Purpose:

To allocate memory to the RAM disk file system for the Secure Print and Sample Print features. The change 
becomes effective after the printer is turned off and then on again.

Values:

NOTE: 

� Restart your printer when you change the settings for the RAM Disk menu.

� Substitute Tray

Purpose:

Specifies whether to use paper of a different size when the paper that is loaded in the specified tray does not match 
the paper size settings for the current job.

Values:

� Auditron Mode

Purpose:

To specify whether to limit the functions that can be used per user by Auditron authentication.

Values:

� No Account User Print

Purpose:

To specify whether to permit the printing of data without authentication information.

Values:

Disable Does not allocate memory to the RAM disk file system. Secure Print 
and Sample Print jobs will abort and be recorded to the job log.

Enable* 200MB* Sets the allocation of memory to the RAM disk file system in 
increments of 50 MB.50-350MB

Off* No tray size substitute accepted.

Larger Size Substitutes paper of next largest size. When there is no larger paper 
size, the printer substitutes paper of nearest size.

Nearest Size Substitutes paper of nearest size.

Use Bypass Tray Substitutes paper from the bypass tray.

Off* Does not limit functions by Auditron authentication.

On Limits functions by Auditron authentication.

Off* Does not permit non-account user to print the data.

On Permits non-account user to print the data.
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� Letterhead 2-Sided Mode

Purpose:

To specify whether to print on both sides when you use letterhead.

Values:

� Report 2-Sided Mode

Purpose:

To specify to print reports on both sides a sheet of paper.

Values:

� Low Toner Alert Msg

Purpose:

To specify whether to show the alert message when the toner is low.

Values:

� Server Address Book

Purpose:

To specify whether to search the e-mail addresses from the Address Book for the LDAP server. 

Values:

NOTE: 

� You can search the e-mail addresses only from the Address Book that is local when Server Address Book is set to Off.

� Server Phone Book

Purpose:

To specify whether to search the phone numbers from the Phone Book for the LDAP server.

Values:

NOTE: 

� You can search the phone numbers only from the local Phone Book when Server Phone Book is set to Off.

Disable* Does not print on both sides of letterhead.

Enable Prints on both sides of letterhead.

1-Sided* Prints reports on one side of a sheet of paper.

2-Sided Prints reports on both sides of a sheet of paper.

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.

Off* Does not search the e-mail addresses from the Address Book for the 
LDAP server.

On Searches the e-mail addresses from the Address Book for the LDAP 
server. 

Off* Does not search the phone numbers from the Phone Book for the 
LDAP server.

On Searches the phone numbers from the Phone Book for the LDAP 
server.
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Maintenance

Use the Maintenance menu to initialize the NV (non-volatile) memory, configure the plain paper quality adjustment 
settings, and configure the security settings.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� F/W Version

Purpose:

To confirm the current F/W version.

� Adjust PaperType

Purpose:

To specify paper density settings.

Values:

� Adjust Transfer Unit

Purpose:

To specify the transfer unit voltage adjustment for each paper type.

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage.

NOTE: 

� The print quality changes depending on the setting values you select for this item.

Values:

Plain Lightweight

Heavyweight*

Plain 0*

-5 to +10

Plain Thick 0*

-5 to +10

Lightweight Cardstock 0*

-5 to +10

Heavyweight Cardstock 0*

-5 to +10

Envelope 0*

-5 to +10

Labels 0*

-5 to +10
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� Adjust Fusing Unit

Purpose:

To adjust the fusing temperature setting for each paper type.

The default settings may not give the best output on all paper types. When the printed paper has curled, try to lower 
the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

NOTE: 

� The print quality changes depending on the setting values you select for this item.

Values:

� Adjust Density

Purpose:

To adjust density level.

Values:

Plain 0*

-3 to +3

Plain Thick 0*

-3 to +3

Lightweight Cardstock 0*

-3 to +3

Heavyweight Cardstock 0*

-3 to +3

Envelope 0*

-3 to +3

Labels 0*

-3 to +3

Darker3 Adjusts the density level darker than the original. Works well with light 
print or faint pencil markings.Darker2

Darker1

Normal* Works well with standard typed or printed documents.

Lighter1 Adjusts the density level lighter than the original. Works well with dark 
print.Lighter2

Lighter3
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� Chart

Purpose:

To print various charts that can be used for diagnosis of the printer.

Values:

� Clean Developer

Purpose:

To stir the developer in a drum cartridge.

Values:

� Clean Transfer Unit

Purpose:

To clean the transfer unit.

Values:

� Toner Refresh

Purpose:

To clean the toner in a drum cartridge (and supply new toner from toner cartridge).

NOTE: 

� Toner Refresh feature uses the toner, and shorten the life of the toner cartridge and the drum cartridge.

Values:

Pitch Chart Cancel* Does not print.

Start Prints a full halftone page. Also prints a page to check 
the pitch. A total of two pages are printed.

Full Page Solid 1-Sided Cancel* Does not print.

Start Prints a chart of the full page solid on the paper.

2-Sided Cancel* Does not print.

Start Prints a chart of the full page solid on both sides of the 
paper.

Alignment Chart Cancel* Does not print.

Start Prints a chart to check for proper alignment of the print 
image on the paper.

Cancel* Does not stir the developer in a drum cartridge.

Start Stirs the developer in a drum cartridge.

Cancel* Does not clean the transfer unit.

Start Cleans the transfer unit.

Cancel* Does not clean the toner.

Start Cleans the toner.
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� Initialize NVM

Purpose:

To initialize the non-volatile (NV) memory for system parameters, Address Book data for fax, or Address Book data 
for scan. After executing this function and rebooting the printer, the menu parameters or data, except the parameters 
for the network, are reset to their factory default values.

Values:

See also: 

� "Resetting to Factory Defaults" on page 313

� Init Print Meter

Purpose:

To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to zero.

Values:

� Reset Transfer Unit

Purpose:

To initialize the transfer unit counter.

Values:

� Reset Fusing Unit

Purpose:

To initialize the life counter of the fusing unit. After replacing the fusing unit, be sure to initialize its life counter.

Values:

� Clear Job History

Purpose:

To clear the job history of all finished jobs.

Values:

User Fax Section Cancel* Does not initialize the fax number entries in the Address Book.

Start Initializes the fax number entries in the Address Book.

User Scan 

Section

Cancel* Does not initialize the e-mail and server address entries in the 
Address Book.

Start Initializes the e-mail and server address entries in the Address Book.

System Section Cancel* Does not initialize the system parameters.

Start Initializes the system parameters.

Cancel* Does not initialize the print meter.

Start Initializes the print meter.

Cancel* Does not initialize the transfer unit counter.

Start Initializes the transfer unit counter.

Cancel* Does not initialize the fusing unit counter.

Start Initializes the fusing unit counter.

Cancel* Does not clear the job history.

Start Clears the job history.
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� Clear Storage

NOTE: 

� Clear Storage feature is available only when the optional 512MB memory is installed.

Purpose:

To clear all files stored as Secure Print and Sample Print in the RAM disk.

Values:

� Non-Genuine

Purpose:

To use toner cartridge of another manufacturer.

NOTE: 

� Using a non-Fuji Xerox toner cartridge may severely damage your printer. The warranty does not cover damages caused by 
using non-Fuji Xerox toner cartridge.

Values:

� Adjust Altitude

Purpose:

To specify the altitude of the location where the printer is installed.

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used.

NOTE: 

� An incorrect altitude adjustment setting leads to problems such as poor printing quality and incorrect indication of remaining 
toner.

Values:

� StaticMemory Ctr

Purpose:

To widen the print gap not to leave toner streak on the next page.

NOTE: 

� StaticMemory Ctr feature shortens the life of the drum cartridge.

Values:

All Clear Deletes all files stored as Secure Print and Sample Print in the RAM 
disk.

Secure Document Deletes all files stored as Secure Print in the RAM disk.

Stored Document Deletes all files stored as Sample Print in the RAM disk.

Toner Off* Does not use toner cartridge of another manufacturer.

On Uses toner cartridge of another manufacturer.

0m* Sets the altitude of the location where the printer is installed.

1000m

2000m

3000m

Off* Does not widen the print gap.

On Widens the print gap.
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� Ghost Control

Purpose:

To reduce negative ghost.

Values:

Off* Does not reduce negative ghost.

On Reduces negative ghost.
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Secure Settings

Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being 
changed accidentally.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� Panel Lock

Purpose:

To set a limited access to Admin Menu with a password, and to set or change the password. 

See also: 

� "Panel Lock Function" on page 308

Values:

*1 This item is available only when Panel Lock Set is set to Enable.

Panel Lock Set Disable* Disables password protection for Admin Menu.

Enable Enables password protection for Admin Menu.

Change Password*1 0000–9999 Sets or changes the password required to access Admin 
Menu.
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� Service Lock

NOTE: 

� Service Lock feature is available only when Panel Lock Set is set to Enable.

Purpose:

To specify whether to enable or disable each of the printer services, or to require a password to use the services.

Values:

Copy Unlocked* Enables the Copy service.

Locked Disables the Copy service.

Password Locked Enables the Copy service, but requires a password to use the 
service.

Fax Unlocked* Enables the Fax service.

Locked Disables the Fax service (the printer will not send or receive 
faxes).

Password Locked Enables the Fax services, but requires a password to send 
faxes (does not require a password to receive incoming 
faxes).

Fax Driver Enable* Enables the Fax Driver service.

Disable Disables the Fax Driver service.

Scan to PC Unlocked* Enables the Scan to PC service.

Locked Disables the Scan to PC service.

Password Locked Enables the Scan to PC service, but requires a password.

PC Scan Unlocked* Enables the PC Scan service.

Locked Disables the PC Scan service.

Password Locked Enables the PC Scan service, but requires a password.

E-mail Unlocked* Enables the E-mail service.

Locked Disables the E-mail service.

Password Locked Enables the E-mail service, but requires a password.

Scan to Network Unlocked* Enables the Scan to Network service.

Locked Disables the Scan to Network service.

Password Locked Enables the Scan to Network service, but requires a 
password.

Scan to USB Unlocked* Enables the Scan to USB service.

Locked Disables the Scan to USB service.

Password Locked Enables the Scan to USB service, but requires a password.

USB Direct Print Unlocked* Enables the USB Direct Print service.

Locked Disables the USB Direct Print service.

Password Locked Enables the USB Direct Print service, but requires a 
password.

USB Services Show When 

Inserted

Enable* Shows a USB Services screen when a USB 
storage device is inserted in to the printer.

Disable Does not show a USB Services screen when a 
USB storage device is inserted in to the printer.

Hide Until 

Inserted

Enable* Hides menus concerning USB storage device 
until an USB storage device is inserted to the 
printer.

Disable Menus concerning USB storage device are 
shown without an USB storage device inserted 
to the printer.
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� Edit E-mail From Fields

Purpose:

To specify whether to enable editing of the transmission source when you use Scan to E-mail.

Values:

� Reconfirm Recipients

NOTE: 

� If Reconfirm Recipients menu is set to Reconfirm Recipients, recipients can only be selected from the phone book 
or the address book. You cannot directly enter an address or fax number.

Purpose:

To specify whether to confirm the recipient before sending a fax or scan.

Values:

� Domain Filtering

NOTE: 

� Set the domains from SMTP Domain Filtering on the CentreWare Internet Services.

Purpose:

To specify whether to only send e-mails to specified domains.

Values:

� Software Download

Purpose:

To enable or disable download of firmware updates.

Values:

Disable Disables editing of the transmission source.

Enable* Enables editing of the transmission source.

No Confirmation* Does not display a screen to reconfirm the recipient before the job is 
actually sent.

Reconfirm Recipient Displays a screen to reconfirm the recipient before the job is actually 
sent.

Off* Disables Domain Filtering.

Allow Domains Only allows e-mails to be sent to specified domains.

Disable Disables firmware updates.

Enable* Enables firmware updates.
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� Secure Receive

NOTE: 

� Secure Receive feature is available only when Panel Lock Set is set to Enable.

Purpose:

To specify whether to require a password to receive faxes, and to set or change the password.

Values:

*1 This item is available only when SecureReceiveSet is set to Enable.

� Login Error

NOTE: 

� Login Error feature is available only when Panel Lock Set is set to Enable.

Purpose:

To specify the number of error entry attempts allowed when you log in as an administrator in the Admin Menu and 
Report / List menu.

Values:

 Defaults Settings
Use Defaults Settings menu to modify the defaults for the Copy, Scan, Fax, or Print from USB menu.

Copy Defaults

Purpose:

To modify the defaults for the Copy menu.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� ID Card Copy

Purpose:

To specify the ID Card Copy.

Values:

SecureReceiveSet Disable* Does not require a password to receive faxes.

Enable Requires a password to receive faxes.

Change Password*1 0000–9999 Sets or changes the password required to receive faxes.

Off* Does not allow an administrator to log in after one error entry attempt.

On 5 times* Sets the number of error entry attempts allowed when an 
administrator logs in.1-10

Off*

On
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� Select Tray

Purpose:

To specify the input tray.

Values:

NOTE: 

� Tray 2 is available only when the optional 250 sheet feeder is installed.

� Lighten/Darken

Purpose:

To set the default copy density level.

Values:

� 2-Sided

Purpose:

To print on both sides of a sheet of paper.

Values:

� Auto Exposure

Purpose:

To suppress the background of the original to enhance text on the copy.

Values:

Bypass Tray The paper is fed from the bypass tray.

Tray 1* The paper is fed from the standard 250 sheet tray.

Tray 2 The paper is fed from the optional 250 sheet feeder.

Darker3 Makes the copy darker than the original. Works well with light print or 
faint pencil markings.Darker2

Darker1

Normal* Works well with standard typed or printed documents. 

Lighter1 Makes the copy lighter than the original. Works well with dark print.

Lighter2

Lighter3

1→1-Sided* Prints on one side of a sheet of paper.

1→2-Sided Prints one sided originals on both sides of a sheet of paper.

2→1-Sided Prints two sided originals on one side of a sheet of paper.

2→2-Sided Prints two sided originals on both sides of a sheet of paper.

1→2 ShortEdge Prints on both sides of a sheet of paper to be bound by short edge.

2→1 ShortEdge Prints on both sides of a sheet of paper to be bound by short edge.

2→2 ShortEdge Prints on both sides of a sheet of paper to be bound by short edge.

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the 
copy.
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� Auto Expo. Level

Purpose:

To specify the default background suppression level.

Values:

� Collated

Purpose:

To sort the copy job.

Values:

� Sharpness

Purpose:

To set the default sharpness level.

Values:

Normal* Sets the background suppression level to Normal.

Higher(1) Sets the background suppression level to Higher(1).

Higher(2) Sets the background suppression level to Higher(2).

Off Does not sort the copy job. 

On Sorts the copy job. 

Auto* Automatically determines which output mode for the copy job.

Softer Makes the copy softer than the original.

Normal* Does not make the copy sharper or softer than the original. 

Sharper Makes the copy sharper than the original. 
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� Reduce/Enlarge

Purpose:

To set the default copy reduction/enlargement ratio.

Values:

mm series

inch series

NOTE: 

� You can also use the number pad to input the desired zoom ratio from 25% to 400%, or press  button to enlarge the zoom 
ratio or press  button to reduce the zoom ratio in 1% intervals.

� This item is available only when N-Up is set to Off or Manual.

� Document Size

Purpose:

To specify the default document size.

Values:

mm series

200%

141% A5 → A4

122% A5 → B5

100%*

81% B5 → A5

70% A4 → A5

50%

200%

154%

129% 8.5x11" → 8.5x14"

100%*

78% 8.5x14" → 8.5x11"

64%

50%

Auto*

A4 (210 x 297 mm)

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")
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inch series

� Document Type

Purpose:

To select the copy image quality.

Values:

� N-Up

Purpose:

To print two original pages to fit onto one sheet of paper.

Values:

� Margin Top/Bottom

Purpose:

To specify the value of the top and bottom margins.

Values:

� Margin Left/Right

Purpose:

To specify the value of the left and right margins.

Values:

Auto*

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

A4 (210 x 297 mm)

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Executive (7.25 x 10.5")

Text Suitable for documents with text.

Mixed* Suitable for documents with both text and photos/gray tones. 

Photo Suitable for documents with photos. 

Off* Does not perform N-up printing. 

Auto Automatically reduces the original pages to fit onto one sheet of 
paper. 

Manual Prints the original pages onto the one sheet of paper in the size 
specified in Reduce/Enlarge.

4 mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

0 - 50 mm/0.0 - 2.0 inch

4 mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

0 - 50 mm/0.0 - 2.0 inch
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� Margin Middle

Purpose:

To specify the value of the middle margin.

Values:

Scan Defaults

To modify the defaults for the Scan menu.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� File Format

Purpose:

To specify the file format to save the scanned image.

Values:

� Color

Purpose:

To specify whether to scan in color, black and white, or gray scale.

Values:

� Resolution

Purpose:

To specify the default scan resolution.

Values:

*1 For color scan, 400 × 400 dpi and 600 × 600 dpi are available only when the optional 512MB memory is installed on the printer.

0 mm*/0.0 inch* Specify the value in increments of 1 mm/0.1 inch.

0 - 50 mm/0.0 - 2.0 inch

PDF*

MultiPageTIFF

TIFF

JPEG 

XDW

Black & White Scans in black and white.

Grayscale Scans in grayscale.

Color* Scans in color.

200 × 200 dpi*

300 × 300 dpi

400 × 400 dpi*1

600 × 600 dpi*1
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� Document Size

Purpose:

To specify the default document size.

Values:

mm series

*1 The default for Document Size varies depending on region-specific factory default.

inch series

*1 The default for Document Size varies depending on region-specific factory default.

� 2-Sided

Purpose:

To scan both sides of a sheet of paper.

Values:

� Lighten/Darken

Purpose:

To set the default scan density level.

Values:

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Executive (7.25 x 10.5")

1-Sided* Scans one side of a document.

2-Sided Scans both sides of a document.

2-Sided Binding Short Scans both sides of a document to be bound by short edge.

Darker3 Makes the scanned image darker than the original. Works well with 
light print or faint pencil markings. Darker2

Darker1

Normal* Works well with standard typed or printed documents. 

Lighter1 Makes the scanned image lighter than the original. Works well with 
dark print.Lighter2

Lighter3
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� Sharpness

Purpose:

To set the default sharpness level.

Values:

� Contrast

Purpose:

To adjust the amount of colors to make the contrast of colors darker or lighter than the original.

Values:

� Auto Exposure

Purpose:

To suppress the background of the original to enhance text on the scanned image.

Values:

� Auto Expo. Level

Purpose:

To specify the default background suppression level.

Values:

� Margin Top/Bottom

Purpose:

To specify the value of the top and bottom margins.

Values:

Sharper Makes the scanned image sharper than the original.

Normal* Does not make the scanned image sharper or softer than the original.

Softer Makes the scanned image softer than the original.

Higher Adjusts the amount of colors to make the contrast of colors darker 
than the original.

Normal* Does not adjust the amount of colors to make the contrast of colors 
darker or lighter than the original.

Lower Adjusts the amount of colors to make the contrast of colors lighter 
than the original.

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the 
scanned image.

Normal* Sets the background suppression level to Normal.

Higher(1) Sets the background suppression level to Higher(1).

Higher(2) Sets the background suppression level to Higher(2).

2 mm*/0.1 inch* Specify the value in increments of 1 mm/0.1 inch.

0 - 50 mm/0.0 - 2.0 inch
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� Margin Left/Right

Purpose:

To specify the value of the left and right margins.

Values:

� Margin Middle

Purpose:

To specify the value of the middle margin.

Values:

� TIFF File Format

Purpose:

To specify the default TIFF file format.

Values:

� Image Compression

Purpose:

To specify the image compression level.

Values:

� Max Email Size

Purpose:

To specify the maximum size of e-mail that can be sent, within the range of 50 K bytes to 16384 K bytes. The default 
is 2048 K bytes.

Fax Defaults

Purpose:

To modify the defaults for the Fax menu.

NOTE: 

� The FAX service cannot be used unless you set up a region code under Region. If Region is not set up, a message Set 
the Region Code appears on the display.

� Values marked by an asterisk (*) are the factory default menu settings.

2 mm*/0.1 inch* Specify the value in increments of 1 mm/0.1 inch.

0 - 50 mm/0.0 - 2.0 inch

0 mm*/0.0 inch* Specify the value in increments of 1 mm/0.1 inch.

0 - 50 mm/0.0 - 2.0 inch

TIFF V6* Sets the default TIFF file format to TIFF V6.

TTN2 Sets the default Tiff file format to TTN2.

Higher Sets the image compression level to Higher.

Normal* Sets the image compression level to Normal.

Lower Sets the image compression level to Lower.
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� Resolution

Purpose:

To specify the scan resolution to improve the output quality.

Values:

NOTE: 

� Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

� 2-Sided

Purpose:

To scan both sides of a sheet of paper.

Values:

� Lighten/Darken

Purpose:

To adjust the density to make the copy lighter or darker than the original.

Values:

� Delayed Start

Purpose:

This feature enables you to set a specific time for the fax transmission to start. Once Delayed Start mode is 
activated, your printer stores all of the documents to be faxed into its memory and sends them at the specified time. 
After faxing in the Delayed Start mode is complete, the data in the memory is cleared.

Values:

NOTE: 

� A maximum of 19 delayed fax jobs can be stored in this printer.

Standard* Suitable for documents with normal sized characters. 

Fine Suitable for documents containing small characters or thin lines or 
documents printed using a dot-matrix printer. 

Super Fine Suitable for documents containing extremely fine detail. The Super 
Fine mode is enabled only if the remote machine also supports the 
Super Fine mode. See the notes below.

Photo Suitable for documents containing photographic images.

1-Sided* Scans one side of a document.

2-Sided Scans both sides of a document.

2-Sided Binding Short Scans both sides of a document to be bound by short edge.

Darker3 Works well with light print or faint pencil markings. 

Darker2

Darker1

Normal* Works well with standard typed or printed documents. 

Lighter1 Works well with dark print.

Lighter2

Lighter3

21:00*/9:00PM* Specify the fax transmission start time when sending a fax at a 
specified time.0:00 – 23:59 / 

1:00 – 12:59AM/PM
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Print from USB Defaults

To modify the defaults for the Print from USB menu.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.

� Select Tray

Purpose:

To specify the input tray.

Values:

NOTE: 

� Tray 2 is available only when the optional 250 sheet feeder is installed.

� 2-Sided

Purpose:

To print on both sides of a sheet of paper.

Values:

� Layout

Purpose:

To specify the output layout. 

Values:

� PDF Password

Purpose:

To enter the password when you print the secure PDF job.

Values:

Bypass Tray The paper is fed from the bypass tray.

Tray 1* The paper is fed from the standard 250 sheet tray.

Tray 2 The paper is fed from the optional 250 sheet feeder.

1-Sided* Prints on one side of a sheet of paper.

2-Sided Prints on both sides of a sheet of paper to be bound by long edge.

2-Sided Binding Short Prints on both sides of a sheet of paper to be bound by short edge.

1Up* Prints one page on one side of a sheet of paper.

2Up Prints two pages on one side of a sheet of paper.

4Up Prints four pages on one side of a sheet of paper.

Enter PDF Password Enter the password to print the secure PDF job.
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 Tray Settings
Use the Tray Settings menu to define the print media loaded in the bypass tray, the standard 250 sheet tray and 
the optional 250 sheet feeder.

NOTE: 

� Values marked by an asterisk (*) are the factory default menu settings.
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Bypass Tray

Purpose:

To specify the paper loaded in the bypass tray.

Values:

Paper Size

mm series

Use Driver Settings*

A4 (210 x 297 mm)

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")

Monarch Env. (3.9 x 7.5")

DL Env. (110 x 220 mm)

C5 Env. (162 x 229 mm)

#10 Env. (4.1 x 9.5")

New Custom Size Portrait(Y) 297 mm* Specifies the 
length of the 
custom size paper.

127 - 355 mm

Landscape(X) 210 mm* Specifies the width 
of the custom size 
paper.

77 - 215 mm

inch series Use Driver Settings*

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

A4 (210 x 297 mm)

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Executive (7.25 x 10.5")

Monarch Env. (3.9 x 7.5")

DL Env. (110 x 220 mm)

C5 Env. (162 x 229 mm)

#10 Env. (4.1 x 9.5")

New Custom Size Portrait(Y) 11.7 inch* Specifies the 
length of the 
custom size paper.

5.0-14.0 inches

Landscape(X) 8.3 inch* Specifies the width 
of the custom size 
paper.

3.0-8.5 inches

Paper Type Plain*

Plain Thick

Lightweight Cardstock

Heavyweight Cardstock

Envelope

Labels

Letterhead

Hole Punched

Colored

Other Type
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NOTE: 

� When MPT mode is set to Driver Specified, Paper Size, Paper Type, and Display Screen are not available.

� For more information on supported paper sizes, see also "Usable Print Media" on page 125.

Tray 1

Purpose:

To specify the paper loaded in the standard 250 sheet tray. 

Values:

MPT mode Panel Specified Configures the paper size and type on the operator panel.

Driver Specified* Configures the paper size and type on the print driver.

Display Screen Off Does not display a popup menu that prompts to set Paper 
Type and Paper Size when paper is loaded in the bypass tray.

On* Displays a popup menu that prompts to set Paper Type and 
Paper Size when paper is loaded in the bypass tray.

Paper Size

mm series

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")

New Custom Size Portrait(Y) 297 mm* Specifies the 
length of the 
custom size paper.

210-355 mm

Landscape(X) 210 mm* Specifies the width 
of the custom size 
paper.

140-215 mm

inch series Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Executive (7.25 x 10.5")

New Custom Size Portrait(Y) 11.7 inches* Specifies the 
length of the 
custom size paper.

8.3-14.0 inches

Landscape(X) 8.3 inches* Specifies the width 
of the custom size 
paper.

5.5-8.5 inches

Paper Type Plain*

Plain Thick

Lightweight Cardstock

Heavyweight Cardstock

Labels

Letterhead

Hole Punched

Colored

Other Type
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*1 The default for Paper Size varies depending on region-specific factory default.

NOTE: 

� For more information on supported paper sizes, see also "Usable Print Media" on page 125.

Display Screen Off Does not display a popup menu that prompts to set Paper 
Type and Paper Size when paper is loaded in the standard 
250 sheet tray.

On* Displays a popup menu that prompts to set Paper Type and 
Paper Size when paper is loaded in the standard 250 sheet 
tray.
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Tray 2

NOTE: 

� Tray 2 is available only when the optional 250 sheet feeder is installed.

Purpose:

To specify the paper loaded in the optional 250 sheet feeder.

*1 The default for Paper Size varies depending on region-specific factory default.

NOTE: 

� For more information on supported paper sizes, see also "Usable Print Media" on page 125.

Paper Size

mm series

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

Executive (7.25 x 10.5")

New Custom Size Portrait(Y) 297 mm* Specifies the length of the 
custom size paper.210-355 mm

Landscape(X) 210 mm Specifies the width of the 
custom size paper.140-215 mm

inch series Letter (8.5 x 11")

Folio (8.5 x 13")

Legal (8.5 x 14")

A4 (210 x 297 mm)*1

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Executive (7.25 x 10.5")

New Custom Size Portrait(Y) 11.7 inches* Specifies the length of the 
custom size paper.8.3-14.0 inches

Landscape(X) 8.3 inches* Specifies the width of the 
custom size paper.5.5-8.5 inches

Paper Type Plain*

Plain Thick

Lightweight Cardstock

Heavyweight Cardstock

Labels

Letterhead

Hole Punched

Colored

Other Type

Display Screen Off Does not display a popup menu that prompts to 
set Paper Type and Paper Size when paper is 
loaded in the optional 250 sheet feeder.

On* Displays a popup menu that prompts to set 
Paper Type and Paper Size when paper is 
loaded in the optional 250 sheet feeder.
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Tray Priority

Purpose:

To set the priority order of the paper trays for automatic tray selection. If paper trays loaded with the same paper size 
and type exists, the paper tray is selected according to this priority order.

Values:

NOTE: 

� Tray 2 and 3rd Priority are available only when the optional 250 sheet feeder is installed.

� The paper tray selected for 1st Priority is not displayed in 2nd Priority, and the paper trays selected for 1st 
Priority and 2nd Priority are not displayed in 3rd Priority.

 Panel Language
Purpose:

To determine the language of the text on the LCD panel.

Values:

1st Priority Bypass Tray* Sets the bypass tray as the first priority.

Tray 1 Sets the standard 250 sheet tray as the first 
priority.

Tray 2 Sets the optional 250 sheet feeder as the first 
priority.

2nd Priority Bypass Tray Sets the bypass tray as the second priority.

Tray 1* Sets the standard 250 sheet tray as the 
second priority.

Tray 2 Sets the optional 250 sheet feeder as the 
second priority.

3rd Priority Bypass Tray Sets the bypass tray as the third priority.

Tray 1 Sets the standard 250 sheet tray as the third 
priority.

Tray 2* Sets the optional 250 sheet feeder as the 
third priority.

English

Simplified Chinese

Traditional Chinese

Korean
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Panel Lock Function

This feature prevents unauthorized users from changing settings made by the administrator. However, you can 
select settings for individual print jobs using the print driver.

This section includes:

� "Enabling the Panel Lock" on page 308

� "Disabling the Panel Lock" on page 308

NOTE: 

� Disabling the operator panel menus does not prevent access to the Secure Print, Sample Print and Tray Settings 
menus.

 Enabling the Panel Lock

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Panel Lock, and then press the  button.

5 Select Panel Lock Set, and then press the  button.

6 Select Enable, and then press the  button.

7 Enter the new password, and then press the  button.

8 Re-enter the password to confirm the password that you entered, and then press the  button.

NOTE: 

� The factory-default panel password is 0000.

� Be sure to remember the password. The procedure described below allows you to reset the password, but the settings for 
Address Book are cleared.

� Turn off the printer. Then, while holding the  (System) button, turn on the printer.

� If you change the password while Panel Lock Set is Enable, perform steps 1 to 2. Enter the current password, and then 
press the  button. Perform steps 3 to 4. Select Change Password, and then press the  button. Enter the current 
password, and then press the  button. Perform steps 7 and 8. This will change the password.

 Disabling the Panel Lock

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Enter the password, and then press the  button.

4 Select Secure Settings, and then press the  button.

5 Select Panel Lock, and then press the  button.

6 Select Panel Lock Set, and then press the  button.

7 Select Disable, and then press the  button.

8 Enter the current password, and then press the  button.
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Limiting Access to Copy, Fax, Scan, and Print from 
USB Operations

Enabling the Copy Lock, Fax Lock, Scan Lock, and Print from USB Lock options limits access to copy, fax, scan, and 
print from USB operations by requiring a password to be entered before copying, scanning, faxing, or printing.

Taking Fax Lock as an example, the following procedure explains how to enable or disable the option. Use the same 
procedure to enable or disable Copy Lock, Scan Lock, or Print from USB Lock.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Panel Lock, and then press the  button twice.

5 Select Enable, and then press the  button.

6 Enter the password using the number pad and then press the  button.

7 Re-enter the password, and then press the  button.

NOTE: 

� The default password is 0000.

8 Press the  (Back) button twice.

9 Select Service Lock, and then press the  button.

10 Select Fax, and then press the  button.

11 Select one of the following option, and then press the  button.

� Unlocked

� Locked

� Password Locked
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Changing the Language

To change language used on the operator panel:

1 Press the  (System) button.

2 Select Panel Language and then press the  button.

3 Select the desired language, and then press the  button.
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Setting the Power Saver Timer Option

You can set the power saver timer for the printer. The printer switches to the Power Saver mode after the specified 
time.

To set the power saver timer:

NOTE: 

� If the Panel Lock Set is set to Enable, you need to enter the four digit password to enter the Admin Menu.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Power Saver Timer, and then press the  button.

5 Select Low Power Timer or Sleep Timer, and then press the  button.

6 Press the  or  button or enter the desired value using the number pad, and then press the  button.

You can select from 1–60 minutes for Low Power Timer or 1–60 minutes for Sleep Timer.

7 To return to the previous screen, press the  (Back) button.
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About the Concurrent Jobs Feature

This feature enables you to start a concurrent job while a fax job is running. This is done by temporally displaying the 
Main Home screen and switching to a different function that can be run concurrently such as copy or scan.

1 While the printer is receiving a fax, press the  (System) button.

2 Press the  (Copy) or  (Scan) button.

3 After setting the copy or scan options, press the  (Start) button.

For details about Copy or Scan menu, see "Copying" on page 163 or "Scanning" on page 179.
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Resetting to Factory Defaults

After executing this function and rebooting the printer, the address book or all the menu parameters, except the 
parameters for the network, are reset to their default values.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance, and then press the  button.

4 Select Initialize NVM, and then press the  button.

5 Select the desired setting, and then press the  button.

6 Select Start, and then press the  button.

The printer restarts automatically to apply the settings.
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Using the Number Pad to Enter Characters

As you perform various tasks, you may need to enter names and numbers. For example, when you set up your 
printer, you enter your name or your company name and telephone number. When you store speed or group dial 
numbers, you may also need to enter the corresponding names.

When prompted to enter a letter, press the appropriate button repeatedly until the correct letter appears on the 
display.

For example, to enter the letter O, press the 6 button repeatedly.

� Each time you press the 6 button, the display shows a different letter, m, n, o, M, N, O and finally 6.

� To enter additional letters, repeat the first step.

� Press the  button when you are finished.

 Keypad Letters and Numbers

 Changing Numbers or Names
If you make a mistake while entering a number or name, press the C (Clear) button to delete the last digit or 
character. Then enter the correct number or character.

Key Assigned Numbers, Letters or Characters

1 @ : . / 1

2 a  b  c  A  B  C  2

3 d  e  f  D  E  F  3

4 g  h  i G  H  I  4

5 j  k  l  J  K  L  5

6 m  n  o  M  N  O  6

7 p  q  r  s  P  Q  R  S  7

8 t  u  v  T  U  V  8

9 w  x  y  z  W  X  Y  Z  9

0 0

* - _ ~ *

# @ . (space) \ _ ! " # $ % & ' ~ ^ | ' ; : ? + - * / = ( ) [ ] { } < >
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10
Troubleshooting

This chapter includes:

� "Clearing Jams" on page 316

� "Basic Printer Problems" on page 340

� "Display Problems" on page 341

� "Printing Problems" on page 342

� "Print Quality Problems" on page 344

� "Noise" on page 357

� "Copy Problem" on page 358

� "Copy Quality Problems" on page 359

� "Fax Problems" on page 360

� "Scanning Problems" on page 362

� "Problems With Installed Optional Accessories" on page 364

� "Scan Driver/Printer Utility Problems" on page 365

� "Other Problems" on page 366

� "Understanding Printer Messages" on page 367

� "Contacting Service" on page 372

� "Getting Help" on page 373

� "Non-Genuine Mode" on page 374
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Clearing Jams

This section includes:

� "Avoiding Jams" on page 316

� "Identifying the Location of Paper Jams" on page 317

� "Clearing Paper Jams From the DADF" on page 318

� "Clearing Paper Jams From the Bypass Tray" on page 320

� "Clearing Paper Jams From the Standard 250 Sheet Tray" on page 323

� "Clearing Paper Jams From the Fusing Unit" on page 326

� "Clearing Paper Jams From the Duplexer" on page 330

� "Clearing Paper Jams From the Regi Roll" on page 331

� "Clearing Paper Jams From the Optional 250 Sheet Feeder" on page 334

� "Jam Problems" on page 336

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 

� "About Print Media" on page 122

� "Supported Print Media" on page 125

NOTE: 

� Before buying large quantities of any print media, it is recommended that you try a sample first.

 Avoiding Jams
� Use only recommended print media.

� See "Loading Print Media in the Standard 250 Sheet Tray and the Optional 250 Sheet Feeder" on page 132 
and "Loading Print Media in the Bypass Tray" on page 135 to load print media properly.

� Do not overload the print media sources. Ensure that the print media stack height does not exceed the 
maximum height indicated by the load-line in the tray.

� Do not load wrinkled, creased, damp, or curled print media.

� Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at 
a time through the bypass tray.

� Do not use print media that you have cut or trimmed.

� Do not mix print media sizes, weights, or types in the same print media source.

� Ensure that the recommended print side is face up when you load the print media.

� Keep print media stored in an acceptable environment.

� Do not remove the feeding tray during a print job.

� Push the tray in firmly after loading.

� Ensure that all cables that connect to the printer are correctly attached.

� Overtightening the guides may cause jams.

� Wipe the feed roller in the tray or bypass tray with a cloth moistened with water if jams caused by misfeeding 
paper occur frequently.

See also: 

� "About Print Media" on page 122 

� "Supported Print Media" on page 125

� "Print Media Storage Guidelines" on page 123



Troubleshooting 317

 Identifying the Location of Paper Jams

IMPORTANT: 

� Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

WARNING:

� If you cannot remove the paper jam by doing the procedures in the manual, do not try to forcibly remove the jam. 

Doing so may cause injuries. Contact your local Fuji Xerox representative.

WARNING:

� Fusing Unit Safety

Do not remove the Fusing Unit. If you cannot remove the paper jam by doing the procedures in the manual, do not 

try to forcibly remove the jam. Doing so may cause injuries. Contact your local Fuji Xerox representative.

CAUTION:

� Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped around the fusing 

unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the product immediately and contact 

your local Fuji Xerox representative.

1 Duplex Automatic Document Feeder (DADF)

2 Fusing Unit

3 Regi Roll

4 Duplexer

5 Optional 250 Sheet Feeder

6 Standard 250 Sheet Tray

7 Bypass Tray

1

4

5

7

6

2

3
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 Clearing Paper Jams From the DADF
When a document jams while it passes through the DADF, remove the jam in the following procedure.

NOTE: 

� To prevent document jams, use the document glass for thick, thin, or mixed documents.

1 Remove the remaining documents from the DADF.

If the document is jammed in the paper feed area:

a Open the DADF cover.

[

b Lift the release lever 90 degrees and remove the jammed document by carefully pulling the document in 
the direction of the arrow shown in the following illustration.

If you find it difficult to pull the document:

c Remove the DADF feed roller assembly and remove the document by gently pulling the document in the 
direction of the arrow shown in the following illustration.



Troubleshooting 319

d Insert the DADF feed roller assembly and press down the release lever.

If the document is jammed in the paper exit area:

a Remove the jammed document from the document output tray.

b Close the DADF cover, and then load the documents back into the DADF.

NOTE: 

� Ensure that you adjust the document guides before printing a Legal-size document.

2 If you cannot remove the jammed document from the document output tray or cannot find any jammed 
document there, open the document cover.

3 Remove the document from the white sheet by carefully pulling it to the right.

4 Close the document cover, and then load the documents back into the DADF.

5 Press the  (Start) button.
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 Clearing Paper Jams From the Bypass Tray

IMPORTANT: 

� Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

� To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Remove the remaining documents from the bypass tray.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 250 sheet tray from the printer about 200 mm.
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4 Hold the standard 250 sheet tray with both hands, and remove it from the printer.

5 Pull the rear door handle to open the rear door.

6 Remove the jammed paper.
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7 Insert the standard 250 sheet tray into the printer, and push until it stops.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

8 Insert the bypass tray into the printer, push until it stops, and close the cover.

9 Close the rear door, and press the  button.
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 Clearing Paper Jams From the Standard 250 Sheet Tray

IMPORTANT: 

� Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

� To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the bypass tray cover.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 250 sheet tray from the printer about 200 mm.
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4 Hold the standard 250 sheet tray with both hands, and remove it from the printer.

5 Pull the rear door handle to open the rear door.

6 Remove the jammed paper.
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7 Insert the standard 250 sheet tray into the printer, and push until it stops.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

8 Insert the bypass tray into the printer, push until it stops, and close the cover.

9 Close the rear door, and press the  button.
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 Clearing Paper Jams From the Fusing Unit

IMPORTANT: 

� Ensure nothing touches or scratches the surface (black-colored film) of the transfer unit. Scratches, dirt, or oil from your hands 
on the film of the transfer unit may reduce print quality.

� Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

� To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the bypass tray cover, or remove the remaining documents from the bypass tray.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 250 sheet tray from the printer about 200 mm.
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4 Hold the standard 250 sheet tray with both hands, and remove it from the printer.

5 Pull the rear door handle to open the rear door.

6 Lift the levers on both sides of the fusing unit.

IMPORTANT: 

� The fusing unit is hot. Do not touch it, doing so may cause burns.
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7 If the document is jammed under the fusing unit, remove the jammed document from under the fusing unit.

If the document is jammed above the fusing unit:

a Hold and lower the right side of the tab to open the inner part.

b Remove the jammed document from above the fusing unit.

c Replace the inner part.
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8 Insert the standard 250 sheet tray into the printer, and push until it stops.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

9 Insert the bypass tray into the printer, push until it stops, and close the cover.

10 Press down the levers on both sides of the fusing unit, and then close the rear door.



330 Troubleshooting

 Clearing Paper Jams From the Duplexer 

IMPORTANT: 

� Ensure nothing touches or scratches the surface (black-colored film) of the transfer unit. Scratches, dirt, or oil from your hands 
on the film of the transfer unit may reduce print quality.

� Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

� To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the rear door handle to open the rear door.

2 Remove the jammed paper from the duplexer.

3 Close the rear door.



Troubleshooting 331

 Clearing Paper Jams From the Regi Roll

IMPORTANT: 

� Ensure nothing touches or scratches the surface (black-colored film) of the transfer unit. Scratches, dirt, or oil from your hands 
on the film of the transfer unit may reduce print quality.

� Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

� To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the bypass tray cover, or remove the remaining documents from the bypass tray.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 250 sheet tray from the printer about 200 mm.
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4 Hold the standard 250 sheet tray with both hands, and remove it from the printer.

5 Pull the rear door handle to open the rear door.

6 Remove the jammed paper from the regi roll.

7 Insert the standard 250 sheet tray into the printer, and push until it stops.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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8 Insert the bypass tray into the printer, push until it stops, and close the cover.

9 Close the rear door.
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 Clearing Paper Jams From the Optional 250 Sheet Feeder

NOTE: 

� To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the optional 250 sheet feeder from the printer about 200 mm.

2 Hold the optional 250 sheet feeder with both hands, and remove it from the printer.

3 Pull the rear door handle to open the rear door.
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4 Remove the jammed paper.

5 Insert the optional 250 sheet feeder into the printer, and push until it stops.

IMPORTANT: 

� Do not use excessive force on the feeder. Doing so could damage the feeder or the inside of the printer.

6 Close the rear door, and press the  button.
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 Jam Problems
This section includes:

� "Standard 250 Sheet Tray/Optional 250 Sheet Feeder Misfeed Jam" on page 336

� "Bypass Tray Misfeed Jam" on page 337

� "Regi Jam (Exit Sensor On JAM)" on page 338

� "Exit Jam (Exit Sensor Off JAM)" on page 338

� "Standard 250 Sheet Tray/Optional 250 Sheet Feeder Multi-feed Jam" on page 339

� "Bypass Tray Multi-feed Jam" on page 339

Standard 250 Sheet Tray/Optional 250 Sheet Feeder Misfeed Jam

Problem Action

Print media misfeeds occur in the 
standard 250 sheet tray or the 
optional 250 sheet feeder.

Ensure that the standard 250 sheet tray or the optional 250 sheet feeder is properly 
inserted.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 

� "Usable Print Media" on page 125

If not, use the print media recommended for the printer.

If the problem persists, ensure that the print media is not curled.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the standard 250 sheet tray or the 
optional 250 sheet feeder with a cloth moistened with water.

Wipe the feed roller in the standard 250 sheet tray or the optional 250 sheet feeder 
with a cloth moistened with water.

See also: 

� "Cleaning Inside the Printer" on page 378

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Bypass Tray Misfeed Jam

Problem Action

Print media misfeeds occur in the 
bypass tray.

Ensure that the bypass tray is properly inserted.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 

� "Usable Print Media" on page 125

If not, use the print media recommended for the printer.

If the problem persists when using cardstock paper, set Print Peeling Prevention 

Mode to On on the Advanced tab of the PCL 6 driver. For more information, refer to 
the Help provided for the PCL 6 driver.

If the problem persists, ensure that the print media is not damp.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the bypass tray with a cloth moistened 
with water.

Wipe the feed roller in the bypass tray with a cloth moistened with water.

See also: 

� "Cleaning Inside the Printer" on page 378

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Regi Jam (Exit Sensor On JAM)

Exit Jam (Exit Sensor Off JAM)

Problem Action

Regi jam (Exit Sensor On JAM) 
occurs.

Ensure that the drum cartridge is installed correctly.

If the problem persists, replace the drum cartridge if you have a spare cartridge as 
instructed in "Replacing the Drum Cartridge" on page 385.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

If the problem persists, ensure that the fusing unit is installed correctly.

Ensure that the fusing unit is installed correctly.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit and Retard Roll" on page 390.

Replace the fusing unit.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the problem persists, ensure that the transfer unit is installed correctly.

Ensure that the transfer unit is installed correctly.

If the problem persists, replace the transfer unit and the retard roll as instructed in 
"Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390.

Replace the transfer unit and the retard roll.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

Exit jam (Exit Sensor Off JAM) 
occurs.

Ensure that the fusing unit is installed correctly.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit and Retard Roll" on page 390.

Replace the fusing unit.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Standard 250 Sheet Tray/Optional 250 Sheet Feeder Multi-feed Jam

Bypass Tray Multi-feed Jam

Problem Action

Print media multiple feeds occur 
in the standard 250 sheet tray or 
optional 250 sheet feeder.

Ensure that the tray or feeder is properly inserted.

If using coated paper, load coated paper one sheet at a time.

If using other type of print media, use print media that is not damp.

Load coated paper one sheet at a time.

If the problem persists, fan the print media.

Use print media that is not damp.

If the problem persists, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the tray or feeder where the multifeed 
occurred with a cloth moistened with water.

Wipe the feed roller in the tray or feeder where the multifeed occurred with a cloth 
moistened with water.

See also: 

� "Cleaning Inside the Printer" on page 378

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

Print media multiple feeds occur 
in the bypass tray.

Ensure that the media type you are using.

If using coated paper, load coated paper one sheet at a time.

If using other type of print media, use print media that is not damp.

Load coated paper one sheet at a time.

If the problem persists, fan the print media.

Use print media that is not damp.

If the problem persists, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the tray where the multifeed occurred 
with a cloth moistened with water.

Wipe the feed roller in the tray where the multifeed occurred with a cloth moistened 
with water.

See also: 

� "Cleaning Inside the Printer" on page 378

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Basic Printer Problems

Some printer problems can be easily resolved. If a problem occurs with your printer, check each of the following:

� The power cord is connected to the printer, and to a properly grounded electrical outlet.

� The printer is turned on.

� The electrical outlet is not turned off at any switch or breaker.

� Other electrical equipment plugged into the outlet is working.

� All options are properly installed.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn 
on the printer. This often fixes the problem.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

NOTE: 

� If error messages are displayed on the LCD panel screen or on your computer screen, follow the on-screen instructions to 
resolve the printer problems. For details about error messages and error codes, see "Understanding Printer Messages" on 
page 367.
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Display Problems

Problem Action

Menu settings changed from the 
operator panel have no effect.

Settings in the software program, the print driver, or the printer utilities have 
precedence over the settings made on the operator panel.
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Printing Problems

NOTE: 

� If Panel Lock Set is set to Enable, you need to enter the four digit password to enter the Admin Menu menu.

Problem Action

Job did not print or incorrect 
characters printed.

Ensure that the top menu appears on the LCD panel before you send a job to print. 
Press the  (System) button to return to the top menu.

Ensure that the print media is loaded in the printer. Press the  (System) button to 
return to the top menu.

Verify that the printer is using the correct page description language (PDL).

Verify that you are using the correct print driver.

Ensure that the correct USB cable, Ethernet cable or wireless printer adapter is 
securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the printer's interface from the Admin Menu menu.

Determine the host interface you are using. Print a Panel Settings page to verify that 
the current interface settings are correct.

Print media misfeeds or multiple 
feeds occur.

Ensure that the print media you are using meets the specifications for your printer.

See also: 

� "Usable Print Media" on page 125

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the width and length guides of the print media sources are adjusted 
correctly.

Ensure that the standard 250 sheet tray, the optional 250 sheet feeder, or the bypass 
tray is securely inserted.

Do not overload the standard 250 sheet tray, the optional 250 sheet feeder, or the 
bypass tray.

Do not force print media into the bypass tray when you load it; otherwise, it may skew 
or buckle.

Ensure that the print media is not curled.

Face the recommended print side up.

See also: 

� "Loading Print Media" on page 131

Turn the print media over or around and try printing again to see if feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading the print media.

Load print media only when the standard 250 sheet tray, the optional 250 sheet 
feeder, or the bypass tray is empty.

Wipe the feed roller in the standard 250 sheet tray, the optional 250 sheet feeder, or 
the bypass tray with a cloth moistened with water.

See also: 

� "Cleaning Inside the Printer" on page 378

The envelope is creased after 
printed.

Make sure that the envelope is loaded in the bypass tray as instructed in "Loading 
Envelope in the Bypass Tray" on page 139.

Page breaks in unexpected 
places.

Increase the value for the Timeout on the operator panel or CentreWare Internet 
Services. 
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Print media does not stack neatly 
in the output tray.

Turn the print media stack over in the standard 250 sheet tray or the bypass tray.

Cannot print from the standard 
250 sheet tray or the optional 250 
sheet feeder because the print 
media in the tray or feeder is 
curled.

Load the print media into the bypass tray.

Problem Action
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Print Quality Problems

This section includes:

� "The Output Is Too Light" on page 345

� "Toner Smears or Print Comes Off" on page 346

� "Random Spots/Blurred Images" on page 347

� "The Entire Output Is Blank" on page 348

� "Streaks Appear on the Output" on page 349

� "Vertical Blanks" on page 350

� "Mottle" on page 350

� "Ghosting" on page 351

� "Light-Induced Fatigue" on page 351

� "Fog" on page 352

� "Bead-Carry-Out (BCO)" on page 352

� "Jagged Characters" on page 353

� "Banding" on page 353

� "Auger Mark" on page 354

� "Wrinkled/Stained Paper" on page 354

� "Damage on the Leading Edge of Paper" on page 355

� "The Top and Side Margins Are Incorrect" on page 355

� "Protrudent/Bumpy Paper" on page 356

� "Images Are Skewed" on page 356

NOTE: 

� In this section, some procedures use the operator panel, CentreWare Internet Services or PCL 6 driver.

See also: 

� "Understanding the Printer Menus" on page 252

� "CentreWare Internet Services" on page 69
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 The Output Is Too Light

Problem Action

The output is too light. The toner cartridge may be low or need to be replaced. Confirm the amount of toner 
in the toner cartridge.

1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridge as necessary.

If the problem persists, disable Toner Saver in the print driver.

Disable Toner Saver in the print driver. The following procedure uses the PCL 6 
driver as an example.

1 On the Image Options tab, ensure that Off is selected in the Toner Saver 
drop-down menu.

If the problem persists, try changing the Paper Type setting in the print driver.

The print media surface may be uneven. Try changing the Paper Type setting in the 
print driver. For example, change the plain paper to heavyweight using a PCL 6 
driver.

1 On the Paper/Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 

� "Usable Print Media" on page 125

If not, use the print media recommended for the printer.

If the problem persists, ensure the transfer unit is correctly installed.

Ensure the transfer unit is correctly installed.

See also:  
� "Installing a Transfer Unit" on page 393

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Adjust the density level.

1 Check the density level in the Adjust Density menu.

2 Select Darker level.

See also:  
� "Adjust Density" on page 283

If the problem persists, clean the toner in a drum cartridge.

Clean the toner in a drum cartridge.

1 On the operator panel, press the  (System) button and select Admin Menu → 
Maintenance → Toner Refresh.

2 Select Start, and then press the  button.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Toner Smears or Print Comes Off

Problem Action

Toner smears or print comes off. The print media surface may be uneven. Try changing the Paper Type setting in the 
print driver. For example, change the plain paper to heavyweight using a PCL 6 
driver.

1 On the Paper/Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 

� "Usable Print Media" on page 125

If not, use the print media recommended for the printer.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

1 Replace the drum cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

2 After you replace the drum cartridge, test print your document again.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit and Retard Roll" on page 390.

Replace the fusing unit.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the problem persists, replace the transfer unit and the retard roll as instructed in 
"Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390.

Replace the transfer unit and the retard roll.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Random Spots/Blurred Images

Problem Action

The printed result has random 
spots or is blurred.

Ensure that the toner cartridge are installed correctly. 

See also: 

� "Installing a Toner Cartridge" on page 384

If the problem persists, ensure that the drum cartridge is installed correctly.

Ensure that the drum cartridge is installed correctly.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, clean the chute above the regi roll inside the rear of the printer 
with a dry cloth.

Clean the chute above the regi roll inside the rear of the printer with a dry cloth.

See also: 

� "Rear View" on page 43

If the problem persists, lower the transfer unit voltage.

Lower the transfer unit voltage.

1 Check the transfer unit voltage in the Adjust Transfer Unit menu.

2 Decrease the voltage.

See also: 

� "Adjust Transfer Unit" on page 282

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 The Entire Output Is Blank

Problem Action

The entire output is blank. The toner cartridge may be low or need to be replaced. Confirm the amount of toner 
in the toner cartridge.

1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridge as necessary.

If the problem persists, disable Toner Saver in the print driver.

Disable Toner Saver in the print driver. The following procedure uses the PCL 6 
driver as an example.

1 On the Image Options tab, ensure that Off is selected in the Toner Saver 
drop-down menu.

If the problem persists, try changing the Paper Type setting in the print driver.

The print media surface may be uneven. Try changing the Paper Type setting in the 
print driver. For example, change the plain paper to heavyweight using the PCL 6 
driver.

1 On the Paper/Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 

� "Usable Print Media" on page 125

If not, use the print media recommended for the printer.

If the problem persists, ensure the transfer unit is correctly installed.

Ensure the transfer unit is correctly installed.

See also: 

� "Installing a Transfer Unit" on page 393

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Streaks Appear on the Output

Problem Action

Streaks appear on the output. The toner cartridge may be low or need to be replaced. Confirm the amount of toner 
in the toner cartridge.

1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridge as necessary.

If the problem persists, stir the developer in a drum cartridge.

Stir the developer in a drum cartridge.

1 On the operator panel, press the  (System) button and select Admin Menu → 
Maintenance → Clean Developer.

2 Select Start, and then press the .button.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Vertical Blanks

 Mottle

Problem Action

The printed result has vertical 
blanks.

Clean the rear side of the drum cartridge with a dry cloth.

See also: 

� "Replacing the Drum Cartridge" on page 385

If the problem persists, ensure the light path is not covered.

Ensure the light path is not covered.

1 Remove the drum cartridge, and keep it in the dark place.

See also: 

� "Replacing the Drum Cartridge" on page 385

2 Check the light path, and then remove the shielding.

3 Re-install the drum cartridge.

See also: 

� "Installing a Drum Cartridge" on page 388

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The printed result has mottled 
appearance.

Verify that the print media recommended for the printer is being used.

If you use non-recommended print media, use the print media recommended for the 
printer.

If the problem persists, raise the transfer unit voltage.

Raise the transfer unit voltage.

1 Check the transfer unit voltage in the Adjust Transfer Unit menu.

2 Increase the voltage.

See also: 

� "Adjust Transfer Unit" on page 282

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Ghosting

 Light-Induced Fatigue

Problem Action

The printed result has ghosting. If the type of the ghosting is positive ghost:

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

If the type of the ghosting is negative ghost:

Verify that the print media recommended for the printer is being used.

If you are using non-recommended print media, use the print media recommended 
for the printer.

See also: 

� "Ghost Control" on page 287

If the problem is solved, adjust the transfer bias.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Adjust the transfer bias.

1 On the operator panel, press the  (System) button and select Admin Menu → 
Maintenance → Adjust Transfer Unit.

2 Adjust the setting for the type of print media being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The printed result has 
light-induced fatigue pattern.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Fog

 Bead-Carry-Out (BCO)

Problem Action

The printed result is foggy. Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

Bead-Carry-Out (BCO) is 
happening.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Jagged Characters

 Banding

Problem Action

The printed result has jagged 
characters.

Enable Bitmap Smoothing in the print driver. The following procedure uses the PCL 
6 driver as an example.

1 On the Advanced tab, set Bitmap Smoothing under Image Options to On.

If the problem persists, check whether or not the downloaded font you are using is 
recommended.

If using a downloaded font, ensure that the font is recommended for the printer, 
operating system, and the application being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The printed result has banding. Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Replace the fusing unit if you have a spare unit.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the cause of the problem is not located, contact the Fuji Xerox local representative 
office or an authorised dealer.

Replace the transfer unit and the retard roll.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the cause of the problem is not located, contact the Fuji Xerox local representative 
office or an authorised dealer.
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 Auger Mark

 Wrinkled/Stained Paper

Problem Action

The printed result has auger 
mark.

Stir the developer in a drum cartridge.

1 On the operator panel, press the  (System) button and select Admin Menu → 
Maintenance → Clean Developer.

2 Select Start, and then press the .button.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

� "Installing a Drum Cartridge" on page 388

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

See also: 

� "Usable Print Media" on page 125

� "About Print Media" on page 122

If not, use the print media recommended for the printer.

If the problem with printing on an envelope persists, check the wrinkle of the 
envelope.

If the problem with printing on a print media other than envelopes persists, contact 
the Fuji Xerox local representative office or an authorised dealer.

Envelopes may get wrinkled depending on their paper type and condition.

Check whether the wrinkle of the four edges of the envelope is within 30 mm.

If the wrinkle of the four edges of the envelope is within 30 mm, this type of wrinkle is 
considered normal. Your printer is not at fault.

If not, load the envelopes in the bypass tray properly.

Load the envelopes in the bypass tray properly.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Damage on the Leading Edge of Paper

 The Top and Side Margins Are Incorrect

Problem Action

The output is damaged on its 
leading edge.

When using the bypass tray, reverse the paper and then try again. 

If the problem persists, change the paper with another one and then try again.

When using the standard 250 sheet tray or optional 250 sheet feeder, change the 
paper and then try again.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Change the paper with another one and then try again.

If the problem persists, use the standard 250 sheet tray or optional 250 sheet feeder 
in place of the bypass tray.

Use the standard 250 sheet tray or optional 250 sheet feeder in place of the bypass 
tray.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The top and side margins are 
incorrect.

Ensure that the margins are set correctly on the application being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Protrudent/Bumpy Paper

 Images Are Skewed

Problem Action

Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.

1 Load one sheet of paper in the bypass tray, and then print a solid image all over 
paper.

2 Load the printed sheet with the side to be printed on facing down, and then print a 
blank sheet of paper.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The printed result are skewed. Adjust the paper guides properly.

If the problem persists, install the transfer unit according to an appropriate procedure.

Install the transfer unit according to an appropriate procedure.

See also: 

� "Installing a Transfer Unit" on page 393

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Noise

Problem Action

The printed result has the noise. Replace the transfer unit and the retard roll.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the problem persists, replace the drum cartridge.

Replace the fusing unit.

See also: 

� "Replacing the Fusing Unit, Transfer Unit and Retard Roll" on page 390

If the problem persists, replace the toner cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 

� "Replacing the Drum Cartridge" on page 385

If the problem persists, replace the toner cartridge.

Replace the toner cartridge.

See also: 

� "Replacing the Toner Cartridge" on page 382

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Copy Problem

Problem Action

A document loaded in the DADF 
cannot be copied.

Ensure that the DADF cover is firmly closed.

Ensure that the release lever is properly positioned.

Vertical blanks or streaks appear 
on the output when scanned 
using the DADF.

Clean the DADF glass.
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Copy Quality Problems

NOTE: 

� If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorised dealer.

Problem Action

There are lines or streaks in 
copies made from the DADF.

There is debris on the DADF glass. When scanning, the paper from the DADF passes 
over the debris creating lines or streaks. 

Clean the DADF glass with a lint free cloth.

See also: 

� "Cleaning the Scanner" on page 376

There are spots in copies taken 
from the document glass.

There is debris on the document glass. When scanning, the debris creates a spot on 
the image.

Clean the document glass with a lint free cloth.

See also: 

� "Cleaning the Scanner" on page 376

The reverse side of the original is 
showing on the copy.

Use the Lighten/Darken option on the Copy menu.

For information on making the image lighter, see "Lighten/Darken" on page 171.

Light colors are washed out or 
white on the copy.

On the Copy menu, disable Auto Exposure.

For information on turning Auto Exposure on and off, see "Auto Exposure" on 
page 172.

Image is too light or dark. Use the Lighten/Darken option on the Copy menu.

For information on making the image lighter or darker, see "Lighten/Darken" on 
page 171.
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Fax Problems

Problem Action

The printer is not working, there 
is no display and the buttons are 
not working.

Unplug the power cord and plug it in again.

Ensure that there is power to the electrical receptacle.

No dial tone sounds. Check that the phone line is connected properly. 

See also: 

� "Connecting the Telephone Line" on page 220

Check that the phone socket in the wall is working by plugging in another phone.

The numbers stored in the 
memory do not dial correctly.

Ensure that the numbers are stored in the memory correctly.

Print an Address Book list.

The document does not feed into 
the printer.

Ensure that the document is not wrinkled and you are putting it in correctly. Check 
that the document is of the right size, not too thick or thin.

Ensure that the DADF cover is firmly closed.

Faxes are not received 
automatically.

Check that the phone line is connected properly. 

See also: 

� "Connecting the Telephone Line" on page 220

The Fax mode should be selected.

Ensure that there is paper in the paper tray.

Check to see if the display shows Memory Full.

If the time interval specified for the following features is too long, change the time 
interval shorter such as 30 seconds.

� Auto Answer Fax

� Auto Ans. TEL/FAX

� Auto Ans. Ans/FAX

The printer does not send faxes. Sending should show up on the display.

Check the other fax machine you are sending to, to see if it can receive your fax.

Check the Dialing Type for PB, DP(10PPS) or DP(20PPS).

Ensure that the document is loaded in the DADF or on the document glass.

The incoming fax has blank 
spaces or is received in poor 
quality.

Check your printer by making a copy.

The toner cartridge may be empty. Replace the toner cartridge.

See also: 

� "Replacing the Toner Cartridge" on page 382

A noisy phone line can cause line errors. Set the fax modem speed to a slower 
speed.

The fax machine sending you the fax may be faulty.

Some of the words on an 
incoming fax are stretched.

The fax machine sending you the fax had a temporary document jam.

There are lines on the documents 
you send.

Check the surface of the document glass and DADF glass for marks and clean it.

See also: 

� "Cleaning the Scanner" on page 376

The printer dials a number, but 
the connection with another fax 
machine fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming 
calls. Speak with the other machine operator and ask her/him to sort out the problem.

Documents are not stored in the 
memory.

There may not be enough memory to store the document. If the display shows a 
Memory Full message, delete any documents you no longer need from the 
memory and then restore the document, or wait for the job in progress (e.g., a fax 
transmission or reception) to complete.
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Blank areas appear at the bottom 
of each page or on other pages, 
with a small strip of text at the 
top.

You may have chosen the wrong paper settings in the user option setting.

See also: 

� "Supported Print Media" on page 125

The printer will not send or 
receive faxes.

Ensure that the region code is set correctly under  (System) → Admin Menu → 
Fax Settings → Region.

Check the Dialing Type for PB, DP(10PPS) or DP(20PPS).

Check that the cables are connected properly.

If the telephone line cord is connected to the printer via any device such as an 
answering machine and a computer, remove the device and directly connect the 
telephone line cord to the printer.

An error often occurs during a fax 
transmission or reception.

Reduce the modem speed under  (System) → Admin Menu → Fax Settings 
→ Modem Speed.

The printer receive faxes, but it 
does not print.

Check the toner level.

Ensure that there is paper in the paper tray.

Ensure that Sent Fax Fwd is set to Off.

Ensure that Junk Fax Filter is set to Off.

Ensure that SecureReceiveSet is set to disabled.

Execute Initialize NVM.
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Scanning Problems

Problem Action

The scanner does not work. Ensure that you place the document to be scanned facing down from the document 
glass, or facing up in the DADF.

There may not be enough available memory to hold the document you want to scan. 
Try the Preview function to see if that works. Try lowering the scan resolution rate.

Check that the USB cable, Ethernet cable or wireless printer adapter is connected 
properly.

Ensure that the USB cable, Ethernet cable or wireless printer adapter is not defective. 
Switch the cable or adapter with a known good cable or adapter. If necessary, replace 
the cable or adapter.

If using the network TWAIN (WIA) driver, check that the Ethernet cable or wireless 
printer adapter is connected properly and the IP address of the printer is set correctly. 
To check the IP address, see "Verifying the IP Settings" on page 84.

Check that the scanner is configured correctly. Check the application you want to use 
to make certain that the scanner job is being sent to the correct port.

Ensure that the scanner sharing feature is disabled when you use Mac OS® X before 
you scan documents via an ICA compatible application such as Image Capture. The 
printer does not support the scanner sharing feature of Mac OS X. Select a printer 
which is directly connected to the computer via USB or wired / wireless LAN and scan 
documents.

The printer scans very slowly. Graphics are scanned more slowly than text when you use the Scan to E-mail or 
Scan to Network feature.

Communication speed becomes slow in scan mode because of the large amount of 
memory required to analyze and reproduce the scanned image.

Scanning images at a high resolution takes more time than scanning at a low 
resolution.

Document misfeeds or multiple 
feeds occur in the DADF.

Check whether the DADF feed roller assembly is installed properly.

Ensure the document’s paper type meets the specifications for the printer.

See also: 

� "Duplex Automatic Document Feeder (DADF) Guidelines" on page 124

Check whether the document is properly loaded in the DADF.

Ensure that the document guides are adjusted properly.

Ensure that the number of document sheets do not exceed the maximum capacity of 
the DADF.

Ensure that the document is not curled.

Fan the document well before loading it in the DADF.

Vertical stripes appear on the 
output when scanned using the 
DADF.

Clean the DADF glass.

See also: 

� "Cleaning the Scanner" on page 376

A smear appears at the same 
location on the output when 
scanned using the document 
glass.

Clean the document glass.

See also: 

� "Cleaning the Scanner" on page 376

Images are skewed. Ensure that the document is loaded straight in the DADF or on the document glass.

Diagonal lines appear jagged 
when scanned using the DADF.

If the document uses thick media, try scanning it from the document glass.
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Message appears on your 
computer screen:

� Device can’t be set to the 

H/W mode you want.

� Port is being used by 

another program.

� Port is Disabled.

� Scanner is busy receiving or 

printing data. When the 

current job is completed, try 

again.

� Invalid handle.

� Scanning has failed.

There may be a copying or printing job in progress. When the current job is complete, 
try the job again.

The selected port is currently being used. Restart your computer and try again.

The cable may be improperly connected or the power may be off.

The scan driver is not installed or an operating environment is not set up properly.

Ensure that the port is properly connected and the power is turned on. Then restart 
your computer.

Check that the USB cable, Ethernet cable or wireless printer adapter is connected 
properly.

The printer does not properly 
transfer scan data to a specified 
destination via the Scan to Email 
or Network Scan feature.

Check if the following settings have been set correctly on the CentreWare Internet 
Services.

Network Scan

Check the following settings under Address Book → Computer/Server Address 

Book → Edit Network Scan Address:

� Server Address

� Login Name

� Login Password

� Share Name (Displays only when Server Type is set to SMB)

� Server Path

Scan to Email

Check the following setting under Address Book → Email Address Book:

� Address

Cannot scan using WIA on a 
Microsoft® Windows Server® 
2003 computer.

Enable WIA on the computer.

To enable WIA:

1 Click Start, point to Administrative Tools, and then click Services.

2 Right-click Windows Image Acquisition (WIA), and then click Start.

Cannot scan using TWAIN or 
WIA on a Windows Server 2008 
or Windows Server 2008 R2 
computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:

1 Click Start, point to Administrative Tools, and then click Server Manager.

2 Under Features Summary, click Add Features.

3 Select the Desktop Experience check box, click Next, and then click Install.

4 Restart the computer.
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Problems With Installed Optional Accessories

If an option does not operate correctly following installation or stops working:

� Turn off the printer, wait for 10 seconds, and then turn on the printer. If this does not fix the problem, unplug the printer, and 
check the connection between the option and the printer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

� Ensure the option is selected in the print driver you are using.

� Print the System Settings page to see if the option is listed in the Printer Options list. If the option is not listed, re-install it.

See also: 

� "Report / List" on page 252

The following table lists printer's option and corrective action for related problem. If the suggested corrective action 
does not correct the problem, contact customer support.

Problem Action

The optional 250 sheet feeder 
does not work correctly.

Ensure that the optional 250 sheet feeder is correctly installed on the printer. 
Re-install the optional 250 sheet feeder. 

See also: 

� "Removing the Optional 250 Sheet Feeder" on page 408

� "Installing the Optional 250 Sheet Feeder" on page 52

If the problem persists, contact customer support.

Ensure that the print media is loaded correctly.

See also: 

� "Loading Print Media in the Standard 250 Sheet Tray and the Optional 250 Sheet 
Feeder" on page 132

If the problem persists, contact customer support.

The optional 512MB memory 
does not work correctly.

Ensure that the optional 512MB memory is securely connected to the memory 
connector.

If the problem persists, contact customer support.

The optional wireless printer 
adapter does not work correctly.

Ensure that the optional wireless printer adapter is securely inserted to the correct 
slot.
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Scan Driver/Printer Utility Problems

Problem Action

Unable to retrieve the Address 
Book data from the printer on the 
Address Book Editor.

Check that the USB cable, Ethernet cable or wireless printer adapter is connected 
properly.

Ensure that the printer is turned on.

Ensure that the scan driver is installed on your computer. (The Address Book Editor 
retrieves the Address Book data via the scan driver when the printer is connected 
using a USB cable.)

The TWAIN driver cannot 
connect to the printer.

Check that the USB cable, Ethernet cable or wireless printer adapter is connected 
properly.

If using the network connection, check that IP address of the printer is set correctly. 
To check the IP address, see "Scanning Using the TWAIN Driver" on page 184.

Check whether the printer is on. If the printer is on, reboot it by turning the power 
switch off and then on again.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

If a scan application is running, close the application once, restart the application, and 
then try scanning again.

The scan driver has not been 
registered on your computer and 
cannot be accessed from 
Express Scan Manager. 

Install the scan driver. If the scan driver is installed, uninstalled it and then re-install it. 
After the installation of the scan driver is completed, re-install the Express Scan 
Manager.

Failed to scan your document on 
the printer via Express Scan 
Manager.

Ensure that your computer and the printer is properly connected with the USB cable.

Check whether the printer is on. If the printer is on, reboot it by turning the power 
switch off and then on again.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

If a scan application is running, close the application once, restart the application, and 
then try scanning again.

Network connection cannot be used. Connect with the USB cable.

Uninstall Express Scan Manager on your computer and then re-install it.

Failed to create an image file via 
Express Scan Manager.

Ensure there is sufficient space in your hard disk.

Uninstall Express Scan Manager on your computer and then re-install it.

Failed to initialize Express Scan 
Manager.

Uninstall Express Scan Manager on your computer and then re-install it.

Failed to execute Express Scan 
Manager.

Uninstall Express Scan Manager on your computer and then re-install it.

An unexpected error occurred on 
Express Scan Manager.

Uninstall Express Scan Manager on your computer and then re-install it.
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Other Problems

Problem Action

Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in winter. This also 
occurs when the printer is operating in a location where relative humidity reaches 
85% or more. Adjust the humidity or relocate the printer to an appropriate 
environment.
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Understanding Printer Messages

The printer LCD panel displays messages describing the current state of the printer and indicates possible printer 
problems you must resolve. This section describes messages, their meanings, and how to clear the messages.

When you contact customer support about an error, have the error codes and messages ready.

IMPORTANT: 

� When an error code is displayed, the print data remaining on the printer and the information accumulated in the memory of the 
printer are not secured.

� When you turn off the printer to recover, note that the data in the memory are cleared when the printer is turned off.

NOTE: 

� An error code is listed in an error message.

� For error messages that are not listed in this chapter, refer to instructions in each error messages.

Error-Code What You Can Do

005-110 Open the DADF cover and remove the jammed paper from the DADF.

005-121

005-124

010-317 Turn off the printer and wait for 40 minutes. Open the rear door and make sure that the fusing unit is 
fully installed, and turn on the printer.

010-397 Turn off the printer. Confirm that the fusing unit is correctly installed, and turn on the printer.

016-404 Contact your system administrator.

016-405

016-500 Turn off the printer, and turn it on again.

016-501

016-502

016-503 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
SMTP server and DNS server are set correctly on CentreWare Internet Services.

016-504 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
POP3 server and DNS server are set correctly on CentreWare Internet Services.

016-505 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
user name and password used for POP3 server are set correctly on CentreWare Internet Services.

016-506 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
SMTP server or POP server is set on CentreWare Internet Services.

016-507 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
user name and password used for SMTP server are set correctly on CentreWare Internet Services.

016-520 Contact your system administrator.

016-521

016-522

016-523

016-524

016-527

016-718 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. The file 
size exceeds the maximum for the printer to process. Print the file from your computer.

016-720 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. The file 
format is not supported by the USB storage device. Print the file from your computer.

016-737 Turn off the printer, and turn it on again.

016-741

016-744
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016-750 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. 

016-753

016-755

016-757

016-758

016-759

016-764 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Contact 
SMTP server administrator.016-765

016-766

016-767 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
e-mail address, and try scanning again.016-768

016-786 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
the network cable is connected properly. If there is no problem with the network cable, contact server 
administrator.

016-790

016-791 Press the  button, or wait for the time set in Fault Time-out for the printer to recover.

016-799 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. 

016-930 The device is not supported. Remove it from the USB port.

016-931 The USB hub is not supported. Remove it from the USB port.

016-985 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Retry 
scanning by lowering the resolution setting or changing the file format of the scanned image.016-986

026-720 Press the  button, or wait for the time set in Fault Time-out for the printer to recover.

Check your USB storage device:

� If the file size or the number of files exceeds the limit of your USB storage device.

� If your USB storage device is write-protected.

026-721

027-446 Change IP address to avoid duplication. Turn off the printer, and turn it on again.

027-452

031-521 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Confirm 
login-able computer with your system administrator.

031-522 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
login name (domain name and user name) and password are correct.

031-523 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check the 
share name you specified.

031-524 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check the 
number of users who use the server at the same time is not exceeding the upper limit.

031-525 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
the specified user can read and write file at the storage location.

031-526 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
DNS connection, or check if forwarding destination server is registered with DNS.

031-527 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Set DNS 
address, or set forwarding destination server address as IP address.

031-528 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
the printer can communicate via network with the forwarding destination SMB server. For example, 
check the following:

� Connection of a network cable

� TCP/IP setting

� Communication with Port 137 (UDP), 138 (UDP), and 139 (TCP).

For communication beyond the subnet, contact your system administrator.

031-529 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
password is correct.

031-530 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
storage location is correct. Storage location you specified is DFS setting, and check if it is linked to 
other server. Specify directly linked server, share name, and storage location.

031-531 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
access right of the folder you specified.
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031-532 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Change 
file name and forwarding destination folder, or move or delete file in forwarding destination folder. 

031-533 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check the 
following:

� If the file name you specified is not used by other users.

� If file or folder that has the same name as the one you specified already exists.

031-534

031-535 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
other user is not operating file in storage location you specified. 031-536

031-537 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
storage location has free space.

031-539 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
server name is correct.

031-540 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
domain name is correct.

031-541 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
login name (user name) is correct.

031-542 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Wait for a 
while and try the same operation again. Contact customer support if this failure is repeated.

031-543 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
login permitted time with your system administrator.

031-544 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check the 
password valid period with your system administrator.

031-545 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
necessity of password change with your system administrator.

031-546 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
user invalid setting with your system administrator.

031-547 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
user lock-out status with your system administrator.

031-548 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
user valid period with your system administrator.

031-549 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. On server 
security settings, check access permission of null password user.

031-550 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
append access right to the file. Check if server supports the SMB append command.031-551

031-552 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Set other 
than "Cancel" for processing in the case of file name duplication, or change/delete file name the same 
as the one specified in sending destination folder.

031-574 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
DNS connection, or check if name of forwarding destination server is registered with DNS.

031-575 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Set DNS 
address, or set forwarding destination server address as IP address.

031-576 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
the printer communicates with forwarding destination FTP server. For example, check connection of 
network cable and if the IP address of the server is correct.

031-578 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
login name (user name) and password are correct. 

031-579 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
storage location is correct.

031-580 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
server access right.

031-581 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Change 
file name and forwarding destination folder, or move or delete file in forwarding destination folder.

031-582 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
the file name you specified can be created in storage location. Check if storage location has free space.

031-584 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
the folder name you specified can be created in storage location. Check if the folder that has the same 
name as the one you specified already exists.
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031-585 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
server access rights.031-587

031-588 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
storage location has free space.

031-590 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Set other 
than "Cancel" for processing in the case of file name duplication, or change/delete file name the same 
as the one specified in sending destination folder.

031-594 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Set other 
than "Cancel" for processing in the case of file name duplication, or change/delete file name the same 
as the one specified in sending destination folder.

031-595

031-598 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
append access right to the file and if server supports the FTP append command.

031-599 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check 
rename access right to the file. Check if server supports the FTP rename command.

033-513 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Try the 
following:

� Print the received fax, or wait for a while until sending a fax is completed.

� Print the fax job stored using the Secure Receive feature.

NOTE: 

� For more information on the Secure Receive feature, see "Using the Secure Receiving Mode" on 
page 243.

033-762 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. The printer 
rejects faxes sent from unwanted numbers.

See also: 

� "Junk Fax Filter" on page 270

033-788 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Try the 
following:

� Remove the received fax, or wait for a while until sending a fax is completed.

� Print the fax job stored using the Secure Receive feature.

NOTE: 

� For more information on the Secure Receive feature, see "Using the Secure Receiving Mode" on 
page 243.

034-515 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Try the 
following:

� Try the same operation.

� Check the printer or remote machine if the memory is full. 

034-791 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
the telephone line cord is connected properly. If the line connection is correct, check the following:

� If tone/pulse setting is correct.

NOTE: 

� For more information on tone/pulse setting, see "Dialing Type" on page 269.

If tone/pulse setting is correct, check the following:

� If the remote machine can receive a fax.

035-701 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check the 
following:

� status of the remote machine

� tone/pulse setting

NOTE: 

� For more information on tone/pulse setting, see "Dialing Type" on page 269.

035-702 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Try the 
same operation.
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035-708 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Try the 
following:

� Try the same operation.

� Reduce the modem speed.

NOTE: 

� For more information on modem speed, see "Modem Speed" on page 273.

035-717 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Reduce 
the modem speed.

NOTE: 

� For more information on modem speed, see "Modem Speed" on page 273.

035-718 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check the 
status of the remote machine.

035-720 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check the 
features of the remote machine.

035-781 Press the  button, or wait for the time set in Fault Time-out for the printer to recover. Check if 
the remote machine is busy. 

042-700 Wait for a while until the printer cools down.

077-300 Close the front cover.

093-922 Remove and shake the toner cartridge.

093-925 Turn off the printer. Confirm the toner cartridge is correctly installed, and turn on the printer.

093-926 Open the front cover. Remove the unsupported toner cartridge, and install a supported cartridge.

093-973 Open the front cover, and make sure that the toner cartridge is fully installed.

116-316 Turn off the printer. Remove the optional 512MB memory from the slot, and then reattach it firmly. Turn 
on the printer. Contact customer support if this failure is repeated.

116-317 Turn off the printer, and turn it on again.

116-320 Remove the unsupported optional memory module.

117-361 Turn off the printer, and turn it on again. Contact customer support if this failure is repeated.
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Contacting Service

When you call for printer service, be prepared to describe the problem you are experiencing or the error message on 
the LCD panel.

You need to know the model type and service tag of your printer. See the label located on the rear of your printer.
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Getting Help

This section includes:

� "LCD Panel Messages" on page 373

� "SimpleMonitor Alerts" on page 373

� "Obtaining the Product Information" on page 373

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.

 LCD Panel Messages
The LCD panel provides you with information and troubleshooting help. When an error or warning condition occurs, 
the LCD panel displays a message informing you of the problem. 

See also: 

� "Understanding Printer Messages" on page 367

 SimpleMonitor Alerts
The SimpleMonitor is a tool that is included on the Driver CD Kit. It automatically checks the printer status when you 
send a print job. If the printer is unable to print your job, the SimpleMonitor automatically displays an alert on your 
computer screen to let you know that the printer needs attention.

 Obtaining the Product Information

Obtaining the Latest Print Driver

The latest print driver can be obtained by downloading it from our web site.

The following procedure uses the PCL 6 driver as an example.

NOTE: 

� The communication fee shall be borne by users. 

1 In your print driver's Printing Preferences dialog box, click the Advanced tab and then click About.

2 Click Fuji Xerox Web Site.

Your web browser launches and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 

� You can browse our web site also on the Driver CD Kit included with the printer. To access the web site, click Fuji Xerox Web 

Site on the installation startup window of the CD-ROM.

� The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/

� For the latest information about the print driver features, refer to the Help provided for the print driver.

Updating the Printer's Firmware

Our web site also provides a tool that allows you to update the printer's firmware (software embedded within the 
printer) from your computer.

The latest firmware and updating tool can be downloaded from the following URL.

Follow the instructions on the web site and download the correct firmware update.

http://www.fujixeroxprinters.com/

NOTE: 

� The communication fee shall be borne by users.

http://www.fujixeroxprinters.com/
http://www.fujixeroxprinters.com/
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Non-Genuine Mode

When toner within a toner cartridge is empty, the Replace Toner Cartridge message appears.

When you want to use the printer in Non-Genuine mode, program the mode and replace the toner cartridge.

IMPORTANT: 

� If you use the printer in the Non-Genuine mode, the performance of the printer may not be at its optimum. And any problems 
that may arise from the use of the Non-Genuine mode are not covered by our quality guarantee. The continuous use of the 
Non-Genuine mode can also cause the printer to break down, and any repair charges for such break down will be incurred by 
users.

NOTE: 

� Before starting the operation described below, confirm that Ready is displayed on the LCD panel.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance, and then press the  button.

4 Select Non-Genuine, and then press the  button.

5 Select Toner, and then press the  button.

6 Select On, and then press the  button.

The printer switches to the Non-Genuine mode.
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11
Maintenance

This chapter includes:

� "Cleaning the Printer" on page 376

� "Replacing Consumables" on page 381

� "Ordering Supplies" on page 396

� "Storing Print Media" on page 397

� "Storing Consumables" on page 398

� "Managing the Printer" on page 399

� "Conserving Supplies" on page 402

� "Checking Page Counts" on page 403

� "Moving the Printer" on page 404

� "Removing Options" on page 406
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Cleaning the Printer

This section describes how to clean the printer in order to maintain it in good condition and print clean printouts all 
the time.

This section includes:

� "Cleaning the Scanner" on page 376

� "Cleaning the DADF Feed Roller" on page 378

� "Cleaning Inside the Printer" on page 378

 Cleaning the Scanner
Keep the scanner clean to ensure the best possible copies. Clean the scanner at the start of each day and during 
the day, as needed.

1 Slightly dampen a soft lint-free cloth or paper towel with water.

2 Open the document cover.

WARNING:

� When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning materials may 

result in poor performance of the product. Never use aerosol cleaners to avoid catching fire and explosion.

CAUTION:

� When cleaning this product, always switch off and unplug it. Access to a live machine interior may cause electric 

shock.
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3 Wipe the surface of the document glass and duplex automatic document Feeder (DADF) glass until they are 
clean and dry.

4 Wipe the underside of the white document cover and white sheet until they are clean and dry.

5 Close the document cover.

1 White Sheet

NOTE: 

� Handle with care.

2 White Document Cover

3 Document Glass

4 DADF Glass

1

2

3

4



378 Maintenance

 Cleaning the DADF Feed Roller
Keep the DADF feed roller clean to ensure the best possible copies. Clean the DADF feed roller regularly.

1 Open the DADF cover.

2 Wipe the DADF feed roller with a dry soft lint-free cloth or paper towel until it is clean.

If the DADF feed roller gets soiled with ink stains, paper from the DADF may also be soiled. In this case, slightly 
dampen a soft lint-free cloth or paper towel with a neutral detergent or water, and then remove the 
contamination from the DADF feed roller until it is clean and dry.

 Cleaning Inside the Printer
Clean the feed roller inside the printer if print media does not feed correctly.

1 Turn off the printer and disconnect the power cord.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.
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2 Gently pull open the bypass tray cover.

[

3 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

4 Pull the tray out of the printer about 200 mm.

5 Hold the tray with both hands, and remove it from the printer.
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6 Wipe the feed roller inside the printer with a cloth moistened with water.

7 Insert the standard 250 sheet tray into the printer, and push until it stops.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

8 Insert the bypass tray into the printer, push until it stops, and close the cover.

Bypass Tray Feed Roller

Standard 250 Sheet Tray 
Feed Roller
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Replacing Consumables

This section describes how to replace consumables.

The following consumables are supplied as the replaceable items.

� Toner cartridge

� Drum cartridge

� Fusing unit

� Transfer unit

� Retard roll

WARNING:

� Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills.

It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 

volume of toner, contact your local Fuji Xerox representative.

� Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 

cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 

its disposal.

CAUTION:

� Keep a drum cartridge and a toner cartridge out of the reach of children. If a child accidentally 

swallows toner, spit it out, rinse mouth with water, drink water and consult a physician immediately.

� When replacing a drum cartridge and a toner cartridge, be careful not to spill the toner. In case of any 

toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.

� If toner spills onto your skin or clothing, wash it off with soap and water. 

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 

irritation is gone. Consult a physician if necessary. 

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 

physician immediately.
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 Replacing the Toner Cartridge
Fuji Xerox toner cartridge is available only through Fuji Xerox. 

It is recommended that you use Fuji Xerox toner cartridge for your printer. Fuji Xerox does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Fuji Xerox.

This section includes:

� "Overview" on page 382

� "Removing the Toner Cartridge" on page 383

� "Installing a Toner Cartridge" on page 384

Overview

When a toner cartridge reaches its usable life-span, the following messages appear on the LCD panel.

*1: This warning appears only when Fuji Xerox toner cartridge is used (Non-Genuine mode is set to off).

*2: When a high capacity toner cartridge is set, the remaining page yield is approx. 2,500 pages. The remaining page yield differs 

depending on printing conditions, contents of the documents, and frequency of turning on/off the printer. For more information, see 

IMPORTANT of "Consumables" on page 396.

IMPORTANT: 

� When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner cartridge to catch 
any toner that may spill.

� Do not reuse old toner cartridge once you remove it from the printer. Doing so can impair print quality.

� Do not shake or pound the used toner cartridge. The remaining toner may spill.

� We recommend you to use up the toner cartridge within one year after removing it from the packaging.

Message Remaining Page Yield Printer Status and Action

Replace Toner Soon

Life Almost Over*1

1,000 pages*2 The toner cartridge has become low. Prepare a new 
one.

Out of Toner

Replace 

Toner Cartridge

- The toner cartridge has become empty. Replace the 
old toner cartridge with a new one.
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Removing the Toner Cartridge

1 Put your fingers in the hole on the front cover, and then pull it down to open.

2 Grasp the toner cartridge lock lever, and then raise it upward to unlock.

3 Grasp the handle on the toner cartridge, and then pull it out.

IMPORTANT: 

� Do not shake the toner cartridge as it may cause toner spills. 
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Installing a Toner Cartridge

1 Unpack a new toner cartridge.

NOTE: 

� Handle the toner cartridge carefully to avoid spilling of the toner.

2 Shake the new toner cartridge five or six times to distribute the toner evenly.

3 Make sure that the two tabs of the toner cartridge align with the grooves on the printer, and then insert it into the 
printer until it clicks.

4 Grasp the toner cartridge lock lever, and then pull it down until it stops.

5 Close the front cover.
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 Replacing the Drum Cartridge
This section describes how to replace the drum cartridge.

IMPORTANT: 

� Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

This section includes:

� "Removing the Drum Cartridge" on page 386

� "Installing a Drum Cartridge" on page 388

Overview

When a drum cartridge reaches its usable life-span, the following messages appear on the LCD panel.

Message Remaining Page Yield Printer Status and Action

Order Drum Cartridge 10,000 pages The drum cartridge is near the end of its life. Prepare a 
new one.

Drum Cartridge Life 

Over

Replace Drum Cartridge

- The drum cartridge has reached the end of its life. 
Replace the old drum cartridge with a new one.
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Removing the Drum Cartridge

1 Put your fingers in the hole on the front cover, and then pull it down to open.

2 Grasp the toner cartridge lock lever, and then raise it upward to unlock.

3 Grasp the handle on the toner cartridge, and then pull it out.

IMPORTANT: 

� Do not shake the toner cartridge as it may cause toner spills.

� Keep the removed toner cartridge on a level surface.

4 Grasp the handle on the front of the drum cartridge, and then pull it out halfway with one hand.
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5 Grasp the handle on the top of the drum cartridge with the other hand, and then pull it out completely.
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Installing a Drum Cartridge

1 Unpack a new drum cartridge.

2 Insert the drum cartridge into the cartridge slot, and then push until it stops.

NOTE: 

� The protective cover of the drum comes off while inserting the drum cartridge into the cartridge slot. You do not need to 
remove it in advance.

3 Make sure that the two tabs of the toner cartridge align with the grooves on the printer, and then insert it into the 
printer until it clicks.

4 Grasp the toner cartridge lock lever, and then pull it down until it stops.
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5 Close the front cover.



390 Maintenance

 Replacing the Fusing Unit, Transfer Unit and Retard Roll
You need to replace three parts (fusing unit, transfer unit and retard roll) at a time. Both the transfer unit and the 
retard roll for replacement come with a new fusing unit.

Fuji Xerox fusing unit, transfer unit, and retard roll are available only through Fuji Xerox. To order by phone, see also 
"Online Services" on page 415.

It is recommended that you use Fuji Xerox fusing unit, transfer unit, and retard roll for your printer. Fuji Xerox does 
not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Fuji 
Xerox.

This section includes:

� "Removing the Fusing Unit" on page 391

� "Installing a Fusing Unit" on page 392

� "Removing the Transfer Unit" on page 392

� "Installing a Transfer Unit" on page 393

� "Removing the Retard Roll in the Standard 250 Sheet Tray" on page 394

� "Installing a Retard Roll in the Standard 250 Sheet Tray" on page 395

� "Resetting the Counter of the Fusing Unit" on page 395

Overview

When a fusing unit or transfer unit reaches its usable life-span, the following messages appear on the LCD panel.

CAUTION:

� Fusing Unit Safety

When removing the Fusing Unit, always switch off first and wait for 40 minutes until it cools off.

Message Remaining Page Yield Printer Status and Action

Replace Fusing Unit 

Soon

Life Almost Over

10,000 pages The fusing unit is near the end of its life. Prepare a 
new one.

Replace the fusing unit as well as the transfer unit at 
the same time.

Replace Fusing Unit - The fusing unit has reached the end of its life. Replace 
the old fusing unit with a new one.

Replace Transfer

Unit

- The transfer unit has reached the end of its life. 
Replace the old transfer unit with a new one.
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Removing the Fusing Unit

1 Turn off the printer, and wait for 40 minutes.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

2 Pull the rear door handle on the rear of the printer to open the rear door.

3 Raise the two gray levers on the both sides of the fusing unit to unlock.

4 Grasp the grips on both sides of the fusing unit placing thumb on the knurling, and then pull out the unit.
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Installing a Fusing Unit

1 Unpack a new fusing unit.

2 Remove the packing material from the fusing unit.

3 Insert the fusing unit into the printer until it clicks.

NOTE: 

� Hold both sides of the fusing unit with your hands.

� Make sure that the fusing unit is firmly set in the slots and cannot be moved easily.

4 Lower the two gray levers to lock the fusing unit.

NOTE: 

� After replacing the fusing unit, initialize its life counter. For details, see "Resetting the Counter of the Fusing Unit" on 
page 395.

Removing the Transfer Unit

1 Push the tabs on both sides of the transfer unit inward, and then lift it out of the printer.
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Installing a Transfer Unit

1 Unpack a new transfer unit.

2 Hold the transfer unit by its both ends.

3 Push the both ends of the transfer unit inward, put it on the duplexer, and then rotate the transfer unit forward.

4 Make sure that the arrow marks on the transfer unit and the printer face each other, and then press the two tabs 
on transfer unit inward to lock.

5 Close the rear door.
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Removing the Retard Roll in the Standard 250 Sheet Tray

1 Hold the standard 250 sheet tray with both hands, and remove it from the printer.

NOTE: 

� Ensure that you remove all the paper from the standard 250 sheet tray before removing the retard roll.

2 Slightly pressing down the lock lever on the standard 250 sheet tray to the right with one hand, raise the retard 
roll with the other hand.

3 Slide the retard roll to the left to remove it from the standard 250 sheet tray.
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Installing a Retard Roll in the Standard 250 Sheet Tray

1 Unpack a new retard roll.

2 Slide the two axles of the retard roll into the holes on the standard 250 sheet tray.

3 Press down the retard roll until it snaps.

4 Load paper in the standard 250 sheet tray, and then insert the standard 250 sheet tray into the printer and push 
until it stops.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

Resetting the Counter of the Fusing Unit

After replacing the fusing unit, use the operator panel to reset the counter of the fusing unit.

1 Press the  (System) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance, and then press the  button.

4 Select Reset Fusing Unit, and then press the  button.

5 Select Yes, and then press the  button.
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Ordering Supplies

This section includes:

� "Consumables" on page 396

� "When to Order Supplies" on page 396

� "Recycling Supplies" on page 396

Certain consumables and routine maintenance items need to be ordered occasionally. Each supply includes 
installation instructions on the box.

 Consumables

IMPORTANT: 

� Use of consumables/periodical replacement parts not recommended by Fuji Xerox can impair machine quality and 
performance. Use only consumables/periodical replacement parts recommended by Fuji Xerox.

IMPORTANT: 

� Average standard pages. Declared yield in accordance with ISO/IEC 19752. These values are estimates and vary depending 
on conditions such as the content being printed, paper size, paper type, the printer's operating environment, initializing 
process done when you turn on or off the printer, and adjustments to maintain print quality.

� The life of the fusing unit is affected greatly by the length of time the printer is turned on. If you set a longer time until entering 
the Power Saver mode, the power on time of the printer is increased, and the fusing unit may need to be replaced sooner. For 
details, contact the Fuji Xerox local representative.

 When to Order Supplies
The LCD panel displays a warning when the supply nears its replacement time. Verify that you have replacements 
on hand. It is important to order these supplies when the messages first appear to avoid interruptions to your 
printing. The LCD panel displays an error message when the supply must be replaced.

For details on error messages about replacing the toner cartridge, drum cartridge, fusing unit, or transfer unit, see 
"Replacing Consumables" on page 381.

To order supplies, contact the Fuji Xerox local representative office or an authorised dealer.

IMPORTANT: 

� This printer is designed to provide the most stable performance and print quality when used with the recommended 
consumables. Not using consumables recommended for this machine degrades the performance and printing quality of the 
printer. You could also incur charges if the machine breaks down. To receive customer support and achieve the optimum 
performance of the printer, be sure to use recommended consumables.

 Recycling Supplies
� For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner cartridges and 

drums (photoreceptors) to make recycle parts, recycle materials or energy recovery.

� Proper disposal is required for toner cartridges and drums (photoreceptors) no longer needed. Do not open 
toner cartridges and drums (photoreceptors). Return them to your local Fuji Xerox representative.

Product Name Product Code Printable number of pages

Toner Cartridge 355 (Standard Capacity) CT201937 4,000 pages

Toner Cartridge 355 (High Capacity) CT201938 10,000 pages

Drum Cartridge 355 CT350973 100,000 pages

Maintenance KIT 110V EL300843 100,000 pages

Maintenance KIT 220V EL300844 100,000 pages
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Storing Print Media

To avoid potential paper feeding problems and uneven print quality, there are several things you can do:

� To achieve the best possible print quality, store print media in an environment where the temperature is 
approximately 70 °F/21 °C and the relative humidity is 40%.

� Store cartons of print media on a pallet or shelf, rather than directly on the floor.

� If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface 
so the edges do not buckle or curl.

� Do not place anything on top of the print media packages.
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Storing Consumables

Store consumables in their original packaging until you need to use them. Do not store consumables in:

� Temperatures greater than 104 °F/40 °C.

� An environment with extreme changes in humidity or temperature.

� Direct sunlight.

� Dusty places.

� A car for a long period of time.

� An environment where corrosive gases are present.

� A humid environment.
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Managing the Printer

This section includes:

� "Checking or Managing the Printer with CentreWare Internet Services" on page 399

� "Checking Printer Status with SimpleMonitor (Windows Only)" on page 399

� "Checking Printer Status Through E-mail" on page 400

 Checking or Managing the Printer with CentreWare 

Internet Services
When the printer is installed in a TCP/IP environment, you can use CentreWare Internet Services to check the 
printer status, the remaining volume of consumables, and the paper loaded in this printer. You can also use 
CentreWare Internet Services to configure printer settings.

NOTE: 

� When using the printer as a local printer, you cannot use CentreWare Internet Services. For details about checking the status 
of a local printer, refer to "Checking Printer Status with SimpleMonitor (Windows Only)" on page 399.

Starting CentreWare Internet Services

Use the following procedure to start CentreWare Internet Services.

1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.

The CentreWare Internet Services screen appears.

� Using Online Help

For details regarding the items that can be set in each CentreWare Internet Services screen, click the Help button to 
display the online Help.

 Checking Printer Status with SimpleMonitor (Windows 

Only)
SimpleMonitor is a tool that is installed with your Fuji Xerox print driver. It automatically checks the printer status 
when you send a print job. SimpleMonitor can also check the status of the tray and remaining amount of 
consumables, such as the toner cartridge.

Starting SimpleMonitor

Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Select Printer.

If the SimpleMonitor icon is not displayed on the taskbar, open SimpleMonitor from the Start menu:

The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate SimpleMonitor.

The Select Printer window appears.

2 Click the name of the desired printer from the list.

3 The Status Monitor window appears.

For details about the functions of SimpleMonitor, refer to the online Help.
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 Checking Printer Status Through E-mail
When connected in a network environment where sending and receiving of e-mail is possible, the printer can send 
an e-mail report to specified e-mail addresses containing the following information:

� The network settings and the printer status

� The error status which has occurred on the printer

Setting the E-mail Environment

Activate CentreWare Internet Services. On the Properties tab, configure the following settings according to your 
e-mail environment. After configuring the settings on each screen, always click Apply and then turn off/on the printer 
to reboot. For details about each item, refer to the online help for CentreWare Internet Services.

Item Item to be configured Description

Status Messenger Recipient's E-mail 
Address

Set the e-mail address to which notices about 
changes in printer status or errors are sent.

Notification Items Set the contents of the notices to send in the e-mail.

Port Status StatusMessenger Select Enabled.

Protocol Settings > 

E-mail

Machine's E-mail 
Address, 

SMTP Server Address, 

SMTP Server Port 
Number, 

E-mail Send 
Authentication, 

Login Name, 

Password, 

SMTP Server Connection 
Status, 

POP3 Server Address, 

POP3 Server Port 
Number, 

Login Name, 

Password, 

POP3 Server Check 
Interval, 

APOP Settings, 

POP3 Server Connection 
Status

Select appropriate settings for sending and 
receiving e-mail.

Permitted E-mail Address When setting the permission for checking 
information and changing the settings for an e-mail 
address, enter the e-mail address that is permitted 
to receive the e-mail. If no address is entered here, 
the printer receives e-mails from all users.

StatusMessenger 
Password

When setting the password for access to the printer 
(both read only and read/write), enter the password 
in the Password field.
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Checking the Printer Status with E-mail

This section describes cautions when sending e-mail to the printer to check the printer status.

� You can specify any title for the e-mail when checking the printer status or changing the printer settings.

� Use the commands described in the next section to create the text of the e-mail.

� Commands That Can Be Used in E-mail Text

Use each command according to the following rules:

� Prefix all commands with “#”, and specify the #Password command at the top of the e-mail.

� Command lines without “#” are ignored.

� Write one command on each line and separate each command and parameter with a space or a tab.

When the same command is written two or more times in one e-mail, the second and subsequent commands are 
ignored.

� Example of Commands

� When the read only password is “ronly”, and to check the printer status:

#Password ronly

#Status

#NetworkInfo

Command Parameter Description

#Password Password Use this command at the top of the e-mail when a 
password for read only is set. You can omit this 
command when the password is not set.

#NetworkInfo Set this when you want to check information on the 
network settings list.

#Status Set this when you want to check the printer status.
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Conserving Supplies

You can change several settings in your print driver to conserve toner cartridge and paper.

The following descriptions use the Windows PCL 6 driver as an example.

Supply Setting Function

Toner cartridge Toner Saver in the Image 

Options tab
This check box allows the users to select a print mode 
that uses less toner. The image quality will be lower 
when this feature is used.

Print media Pages Per Sheet (N-Up) 
in the Layout/Watermark 
tab

The printer prints two or more pages on one side of a 
sheet. Values for Pages Per Sheet (N-Up) are 1-Up, 
2-Up, 4-Up, 8-Up, 16-Up, 32-Up. Combined with the 
duplex setting, Pages Per Sheet (N-Up) allows you to 
print up to 64 pages on one sheet of paper. (32 images 
on the front and 32 on the back)
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Checking Page Counts

The total number of printed pages can be checked at the operator panel. Four meters are available: Meter 1, 
Meter 2, Meter 3, and Meter 4.

The Meter Readings counts the number of pages printed properly. Single side print (including Pages Per Sheet 
(N-Up)) is counted as one job, and 2-sided print (including Pages Per Sheet (N-Up)) is counted as two. During 
2-sided printing, if an error occurs after one side is printed properly, it is counted as one.

When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of the 
application. In this case, the blank page is counted as one page.

For information about the individual meter, see "Meter Readings" on page 254.

Use the following procedure to check a meter:

1 Press the  (System) button.

2 Select Meter Readings, and then press the  button.

3 Select the desired meter to check the number of pages.
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Moving the Printer

This section describes how to move the printer.

IMPORTANT: 

� Two people are required to move the printer.

� To prevent you from dropping the printer and getting backache or injuries, lift the printer by firmly gripping the recessed areas 
on both sides of the printer. Never lift the printer by gripping any other areas.

NOTE: 

� If the optional 250 sheet feeder has been installed, uninstall the optional 250 sheet feeder before moving the printer. If the 
optional 250 sheet feeder is not fixed securely to the printer, it may fall to the ground and cause injuries. For details on how to 
uninstall the optional 250 sheet feeder, see "Removing the Optional 250 Sheet Feeder" on page 408.

1 Turn off the printer and disconnect the power cord, interface cable, and any other cables.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

2 Remove any paper in the document output tray and slide the document stopper inside the DADF.

3 Remove any paper in the output tray and slide the output tray extension inside the printer.
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4 Lift the printer and move it gently.

IMPORTANT: 

� When lifting the machine, make sure to follow the precautions stated in "Machine Installation" on page 18.

NOTE: 

� If you move the printer over a long distance, remove the toner cartridge from the printer to prevent toner from 
spilling, and pack the printer inside a box.
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Removing Options

If the printer location needs to be changed or the printer and print media handling options need to be shipped to a 
new location, all print media handling options must be removed from the printer. For shipping, pack the printer and 
print media handling options securely to avoid damage.

This section includes:

� "Removing the Optional 512MB Memory" on page 406

� "Removing the Optional 250 Sheet Feeder" on page 408

� "Removing the Optional Wireless Printer Adapter" on page 411

 Removing the Optional 512MB Memory

IMPORTANT: 

� When you remove the optional 512MB memory, be sure to turn off the printer, unplug the power cord, and disconnect all 
cables from the rear of the printer before starting these tasks.

1 Turn off the printer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 

� Loosen the screw. You do not need to remove the screw.
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3 Slide the control board cover towards the rear of the printer to remove the cover.

4 Push the clips on both sides of the slot outward to raise the 512MB memory.

5 Hold the 512MB memory and pull it straight out.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.
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7 Turn the screw clockwise.

8 Turn on the printer.

 Removing the Optional 250 Sheet Feeder

IMPORTANT: 

� When you remove the optional 250 sheet feeder (Tray2), be sure to turn off the printer, unplug the power cord, and disconnect 
all cables from the back of the printer before starting these tasks.

1 Turn off the printer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

2 Disconnect the power cord from the power connector on the rear of the printer.
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3 Gently pull open the bypass tray cover.

4 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

5 Pull the standard 250 sheet tray out of the printer about 200 mm. Hold the standard 250 sheet tray with both 
hands, and remove it from the printer.

6 Remove the two screws joining the printer and the optional 250 sheet feeder by unscrewing them with a coin or 
similar object.

NOTE: 

� The screw hole is located in 70 mm recess from the front of the printer.
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7 Gently lift the printer off the optional 250 sheet feeder, and place it on a level surface.

IMPORTANT: 

� When lifting the machine, make sure to follow the precautions stated in "Machine Installation" on page 18.

8 Insert the standard 250 sheet tray into the printer, and push until it stops.

IMPORTANT: 

� Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

9 Insert the bypass tray into the printer, push until it stops, and close the cover.

10 Reconnect all cables into the rear of the printer and turn on the printer.
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 Removing the Optional Wireless Printer Adapter

IMPORTANT: 

� If you remove the optional wireless printer adapter, be sure to turn off the printer, unplug the power cord, and disconnect all 
cables from the rear of the printer before removing the adapter.

1 Turn off the printer.

IMPORTANT: 

� Note that the data in the memory are cleared when the printer is turned off.

2 Disconnect the power cord from the power connector on the rear of the printer.

3 Turn the screw on the control board cover counterclockwise.

4 Slide the control board cover towards the rear of the printer and remove the cover.
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5 Remove the wireless printer adapter from the printer by releasing the adapter's hook while pushing the wireless 
printer adapter towards the front of the printer.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.

7 Turn the screw clockwise.

8 Reconnect all cables into the rear of the printer and turn on the printer.
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12
Contacting Fuji Xerox
This chapter includes:

� "Technical Support" on page 414

� "Online Services" on page 415
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Technical Support

Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product diagnostics, 
information contained on the Web, and email support. If unsuccessful, to obtain service under product warranty the 
Customer must notify Fuji Xerox Telephone Support or its authorized service representative of the defect before the 
expiration of the warranty period. Customer will provide appropriate assistance to Telephone Support personnel to 
resolve issues, such as restoration of the operating system, software program and drivers to their default 
configuration and settings, verification of functionality of Fuji Xerox supplied products, replacement of customer 
replaceable units, clearing paper misfeeds and cleaning the unit and other prescribed routine and preventative 
maintenance.

If the Customer’s product contains features that enable Fuji Xerox or its authorised service representative to 
diagnose and repair problems with the product remotely, Fuji Xerox may request that the Customer allow such 
remote access to the product.
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Online Services

You can find detail Product and Consumable warranty information and activate your warranty by registering your 
details on our website at http://www.fujixerox.com/support/docuprint/

Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your printer 
problems. It is an easy-to-use, searchable online help. To find out more, please visit our online support at 
http://www.fujixerox.com/support/docuprint/

http://www.fujixerox.com/support/docuprint/
http://www.fujixerox.com/support/docuprint/
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Numerics

2-Sided .............. 172, 256, 292, 297, 300, 301
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512MB memory ..........................................47
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Adjust Altitude ..........................................286
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Adjust Fusing Unit ....................................283
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Adjusting scanning options ......................214
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Auditron ....................................................157

Auditron Mode ..........................................280
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Auto Expo. Level ..............................293, 298

Auto Exposure ......................... 172, 292, 298

Auto Job History .......................................278

Auto Reset ...............................................276

Automatic dialing ......................................238

Automatic redialing ..................................230

Available fax settings options ...................246

Avoiding jam ............................................316
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Back button ............................................... 46

Banner Sheet .......................................... 279

Basic printer problems ............................ 340

Black-and-white

Selecting for scanning .................... 214

Bonjour (mDNS) ...................................... 266

Booklet print ............................................ 150

BOOTP .................................................... 265

Bypass Tray ............................................ 303

Bypass tray ........................................42, 317

C

Canceling a print job ............................... 143

From operator panel ....................... 143

From your computer ....................... 143

Capacity .................................................... 39

CentreWare Internet Services ............69, 201

Managing printer ............................. 399

Online help for ................................ 399

Starting ........................................... 399

Changing numbers or names .................. 314

Changing the clock mode ........................ 224

Changing the fax settings options ........... 246

Changing the scan settings for 
an individual job .................................. 216

Chart ....................................................... 284

Checking page counts ............................. 403

Checking printed pages

How to check the meter .................. 403

Checking status of print data ................... 158

Chute ......................................................... 43

Clean Developer ..................................... 284

Clean Transfer Unit ................................. 284

Cleaning inside the printer ...................... 378

Cleaning the DADF feed roller ................ 378

Cleaning the scanner .............................. 376

Clear All button .......................................... 45

Clear button ............................................... 46
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Clear Job History .....................................285

Clear Storage ...........................................286

Clearing paper jam ...................................316

From bypass tray .............................320

From DADF .....................................318

From duplexer .................................330

From fusing unit ...............................326

From optional 250 sheet feeder ......334
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